Information You Need To Note

Use this page to note down your ARCS PIN and User Permit numbers. The PIN is a 4-digit number, eg 1234, found on the sheet headed **Important Documentation** inside your Navmaster package.

Make a note here of your ARCS Licence number, eg 12345A, found on the UK Hydrographic Office sheet headed **“Schedule A”** delivered with your first batch of ARCS charts. You’ll need to quote this number when you buy more ARCS charts.

Please also remember to take good care of your security key (sometimes called a dongle), which protects the copyright chart data against illegal copying. As a licensed ARCS developer, PC Maritime is not permitted to issue replacement security keys without charge for the full replacement value of software and charts. Make sure that your security key is fully insured against risk of theft or loss.

| My ARCS PIN number is: | _ _ _ _ |
| My ARCS Licence Number is: | _ _ _ _ _ _ |
| My ARCS User Permit is: | _ _ _ _ _ _ _ _ _ _ |
| My C-Map eToken # is: | _ _ _ _ _ _ _ _ |
| (if you are operating a multi-user licence, note the eToken # for each workstation here) | _ _ _ _ _ _ |
| My ENC User Permit # is: | _ _ _ _ _ _ _ _ _ _ |

Navmaster Version Information

| Software | Navmaster ECDIS v7.0.0.X  |
| ENC security | C-Map SDK v4.2.1.18 with IHO  |
| Environmental models | Presentation Library v3.4.0.0  |
| Magnetic Variation | S-63 IHO Data Protection Scheme Edition 1.1  |
| | Proudman Oceanographic Laboratory Hydrodynamic Model version 1.22  |
| Magnetic Variation | IGRF-10 geomagnetic field model (valid to 31 December 2014)  |
The IHO Standards that relate to Navmaster ECDIS are listed below:

<table>
<thead>
<tr>
<th>IHO ECDIS Standards</th>
<th>Current Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECDIS Display and Presentation</td>
<td>S-52 PresLib Edition 3.4</td>
</tr>
<tr>
<td>Raster Navigational Chart (RNC)</td>
<td>S-61 Edition 1.0</td>
</tr>
<tr>
<td>ENC Data Protection</td>
<td>S-63 Edition 1.1</td>
</tr>
<tr>
<td>IHO Test Data Sets for ECDIS</td>
<td>S-64 Edition 1.1</td>
</tr>
</tbody>
</table>
## Navmaster Setup Record

<table>
<thead>
<tr>
<th>Vessel Name</th>
<th>Dimensions (Vessel \ Setup \ General)</th>
<th>Conning Position Offsets</th>
<th>Primary Position Fixing System Offsets</th>
<th>Secondary Position Fixing System Offsets</th>
<th>ARPA Offset</th>
<th>AIS Offset</th>
<th>COM port settings</th>
<th>Baud rate settings</th>
<th>Monitor</th>
<th>ARCS Licence #</th>
<th>Dongle ID</th>
<th>Screen size</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Length</td>
<td>Length</td>
<td>Length</td>
<td>Length</td>
<td>Length</td>
<td>Length</td>
<td></td>
<td></td>
<td></td>
<td>ARCS Pin #</td>
<td>System</td>
<td>Width:</td>
</tr>
<tr>
<td></td>
<td>Beam</td>
<td>Beam</td>
<td>Beam</td>
<td>Beam</td>
<td>Beam</td>
<td>Beam</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>eToken #</td>
<td>Height:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### COM port settings
- **(Navigator\Setup)**
  - Primary position fixing system transmit: COM
  - Secondary position fixing system: COM
  - Gyro: COM
  - Speed: COM
  - Depth: COM
  - Wind: COM

- **(Target\AIS\Setup\Configuration)**
  - AIS transmit: COM

- **(Target\ARPA\Setup\Configuration)**
  - ARPA: COM

### Baud rate settings
- **(Tools\Setup\Port Settings)**
  - COM: baud
  - COM: baud
  - COM: baud
  - COM: baud

### Monitor
- Setup and calibration: COM

### ARCS Licence #
- ARCS Pin #

### Dongle ID
- System: eToken #

### Screen size
- Width: 
- Height:
NAVMASTER USER GUIDE 1
Information You Need To Note 2
Navmaster Version Information 2
Navmaster Setup Record 4

CONTENTS 5

WELCOME TO NAVMASTER 11
Chart Formats Supported By Navmaster 12
About This Guide 12
User Guide Conventions 13

INSTALLATION AND SETUP 15
Workspace 15
Installing Customised Passage Plans 16
Installing Proudman Tidal Areas 16
Setup Mode 16
Recording Screen Size 17
ECDIS Monitor Calibration 18
ECDIS Backup configuration 19
Setting a Consistent Common Reference Point (CCRP) 20
How to Enter Vessel Data 21
Setting Up the Interface to Instruments 22
NMEA Warnings and Alarms 25
NMEA Sentences 26
Alarm Management 32
Remote Diagnostics 33
Command Line Parameters 34

GETTING STARTED 36
Starting Navmaster 36
Working With Windows Dialog Boxes 36
Property Inspection 36
The Navmaster Window 37
What’s In the Main Window? 38
Toolbars 39
Side Panels 42
Getting Help 49
To Close Navmaster 49

OPERATING NAVMASTER 50
How to Use Navmaster 50
How Navmaster Handles Time 50
Windows in Navmaster 50
Opening Electronic Charts 51
Navmaster Databases 51
Importing and Exporting Routes and Waypoints 53
Backing up Chartpoint, Route and Log databases 60
Using the Recent File List 61
To Change the Folder Location for Charts and Databases 61
To Open A Database from another Location 62
To Save A Database to A New Location 63
Maintaining Databases 64
Print and Print Preview 64

INSTALLING ARCS AND UPDATES 68
ARCS Licence Number 68
Chart Permits 68
To Delete All Charts 68
Installing ARCS or Seafarer Charts 68
ARCS Navigator or Seafarer Update Service 71
ARCS Skipper and Seafarer Charts 74
ARCS \ Seafarer Chart or Update Installation Failures 80
ARCS \ Seafarer Chart Management Information 81

INSTALLING AND UPDATING ENCS 83
Installing Encrypted ENC Charts 83
Updating Encrypted ENCs 87
To Update an Existing Licence or Add New Cell Permits 87
Maintenance 88
To Install ENC (S-57) Compiler License 89
Installing Unencrypted ENC Charts and Updates 90
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing CM-ENC Charts and/or Jeppesen Primar Service</td>
<td>91</td>
</tr>
<tr>
<td>Installing CM-ENC Updates</td>
<td>95</td>
</tr>
<tr>
<td>ENC Chart or Update Installation Failures</td>
<td>97</td>
</tr>
<tr>
<td>ENC Chart Management Information</td>
<td>97</td>
</tr>
<tr>
<td>The C-Map Cartographic Service</td>
<td>98</td>
</tr>
<tr>
<td><strong>INSTALLING C-MAP CM93/3 CHARTS AND UPDATES</strong></td>
<td>102</td>
</tr>
<tr>
<td>Installing CM-93/3 Charts</td>
<td>102</td>
</tr>
<tr>
<td>CM-93/3 Chart Management Information</td>
<td>109</td>
</tr>
<tr>
<td>The C-Map Cartographic Service</td>
<td>110</td>
</tr>
<tr>
<td><strong>ELECTRONIC CHARTS</strong></td>
<td>113</td>
</tr>
<tr>
<td>ECDIS Chart 1</td>
<td>113</td>
</tr>
<tr>
<td>Scalebar, North Up Symbol And Scale Factor</td>
<td>114</td>
</tr>
<tr>
<td>Chart Options</td>
<td>115</td>
</tr>
<tr>
<td>Chart Setup</td>
<td>117</td>
</tr>
<tr>
<td>Selecting Charts</td>
<td>119</td>
</tr>
<tr>
<td>Safety Contours</td>
<td>120</td>
</tr>
<tr>
<td>Vector Chart Options</td>
<td>123</td>
</tr>
<tr>
<td>Presentation Parameters</td>
<td>123</td>
</tr>
<tr>
<td>Zooming Charts</td>
<td>126</td>
</tr>
<tr>
<td>Moving Around Charts</td>
<td>127</td>
</tr>
<tr>
<td>The Right Mouse Menu on Charts</td>
<td>127</td>
</tr>
<tr>
<td>Other Chart Commands</td>
<td>128</td>
</tr>
<tr>
<td>Additional Chart Database</td>
<td>129</td>
</tr>
<tr>
<td>Manual Chart Updates</td>
<td>130</td>
</tr>
<tr>
<td>The Chart Information Panel</td>
<td>136</td>
</tr>
<tr>
<td>Chart Information on the Title Bar</td>
<td>140</td>
</tr>
<tr>
<td>Chart Notes and Diagrams (ARCS)</td>
<td>140</td>
</tr>
<tr>
<td>Temporary and Preliminary Notices to Mariners (ARCS)</td>
<td>140</td>
</tr>
<tr>
<td>The Blank Chart</td>
<td>140</td>
</tr>
<tr>
<td><strong>CHARTPOINTS</strong></td>
<td>142</td>
</tr>
<tr>
<td>Creating and Editing Chartpoints</td>
<td>142</td>
</tr>
<tr>
<td>Selecting a Chartpoint</td>
<td>143</td>
</tr>
<tr>
<td>GoTo Chartpoint</td>
<td>143</td>
</tr>
<tr>
<td>To Move A Chartpoint</td>
<td>144</td>
</tr>
<tr>
<td>To Delete A Chartpoint</td>
<td>144</td>
</tr>
</tbody>
</table>
Navmaster is an advanced Electronic Chart Display and Information System (ECDIS). Its core function is to provide a continuous display of vessel position plotted onto official electronic charts.

The minimum input required for ECDIS operation is position, heading and speed log,

Navmaster manages all your navigation data simply and effectively, storing them in databases for you to use again. Its passage-planning features are unmatched by any other system.

And above all, Navmaster has a simple, logical user interface which will be familiar to anyone who has used a Windows software program.
Chart Formats Supported By Navmaster

Navmaster supports two raster chart formats:

- ARCS - a Raster Nautical Chart (RNC) produced by the UK Hydrographic Office.
- Seafarer - a Raster Nautical Chart (RNC) produced by the Hydrographic Service, Royal Australian Navy.

The two chart types are identical in format and the procedures for installing and using them are the same.

Navmaster supports three vector chart formats

- ENC – the official vector chart format required for ECDIS
- CM-ENCs – official vector charts in SENC format
- CM-93/3 - a private vector chart produced by C-Map Norway in the same format as ENC.

All your charts are grouped to work together almost seamlessly. In effect, the smallest scale chart (covering the largest area) acts as a "Master" chart and more detailed charts as sub-charts.

About This Guide

This user guide assumes that:

- You have a working knowledge of navigation and are capable of producing a safe navigation plan using traditional methods.
- You understand and can use the Windows XP operating system.
# User Guide Conventions

## Mouse operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Press and release the primary mouse button. The primary mouse button is the button you use most often. For most people, this is the left mouse button.</td>
</tr>
<tr>
<td>Right-click</td>
<td>Press and release the secondary mouse button. The secondary mouse button is the button you use least often. For most people, this is the right mouse button.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Press and release the primary mouse button twice.</td>
</tr>
<tr>
<td>Drag</td>
<td>Move the mouse while you hold down the primary mouse button.</td>
</tr>
<tr>
<td>Release</td>
<td>Remove your finger from a mouse button.</td>
</tr>
<tr>
<td>Scroll</td>
<td>Scroll bars along the right and bottom sides of a view move the view up and down and left and right within the window. To use a scrollbar, either click and hold one of the arrow buttons or drag the scroll bar slider.</td>
</tr>
</tbody>
</table>

## Keyboard

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Press the &lt;Tab&gt; key to move from one box to the next.</td>
</tr>
<tr>
<td>&lt;X&gt;</td>
<td>Indicates a letter or word on the keyboard. Using the keyboard to carry out commands often involves pressing keys together or in succession.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;A&gt;</td>
<td>(Or any two keys joined by a plus sign) Press and hold down the &lt;Ctrl&gt; key followed by the &lt;A&gt; key.</td>
</tr>
</tbody>
</table>

## Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel button</td>
<td>Click this button in a dialogue box to close the box without applying the settings.</td>
</tr>
<tr>
<td>Check box</td>
<td>Click it to turn an option on and off. When the option is selected, the box contains a check mark; when the option is not selected, the box is blank.</td>
</tr>
<tr>
<td>Slider</td>
<td>Drag the slider to move along a range of settings. With</td>
</tr>
</tbody>
</table>
most sliders, moving to the left or down reduces an effect or value; moving to the right or up increases it.

**Spin control**
The buttons with upward and downward pointing arrows at the right hand side of number boxes. Press and hold a button to increase or decrease a number rapidly.

*Windows Controls*

For ease of use, particularly at sea, spin-type controls are automatically expanded when you hover your mouse over them.
Workspace

The Workspace is where setup information (e.g., com ports, vessel dimensions) and options for Navmaster are stored. It is automatically updated when you exit Navmaster.

Choose Workspace from the File menu and select Save to update your Workspace after, for example, installation or when new settings have been applied. At this point you can enter a comment to identify the circumstances under which the Workspace was updated.

Workspace Restore and Maintenance.

Workspace Maintenance allows you to restore Navmaster settings to a previously saved Workspace with the settings saved at that time. This is useful if, for example, your settings have become corrupted or have been changed in error and you want to go back to the settings previously applicable. To do this:

1. log into Setup Mode and choose Workspace \ Maintenance from the File menu.

2. Dates when workspaces were saved will be outlined by a red box. Select the date and the workspace you want to restore from the list to the right and click Restore.
3. Select any unwanted saved Workspaces and click **Delete** to remove them.

**Installing Customised Passage Plans**

Some customers have customised passage plan reports. Each report is protected by a code number, which you will find on your PC Maritime CD.

1. Run the PC Maritime CD and click on the **Applications** button

2. On the next screen click the button marked **Passage Plan Reports** and a list of company names will appear

3. Click on your company name to start the installation process

4. Enter the access code to install the customised report files.

**Installing Proudman Tidal Areas**

To install one or more Proudman tidal areas:

1. Insert the PC Maritime CD into your CD-ROM drive.

2. Click on the **Programs** button.

3. Click on the **Proudman Tidal Stream** button.

4. Select the area(s) you have purchased, enter the installation code found on the PC Maritime CD and click **Install**.

**Setup Mode**

Variable parameters are placed under each main menu, divided between **Setup** for parameters that are set during installation and infrequently
changed and *Options* for parameters that are changed during normal operation.

**Setup** menus are unavailable during normal operation to prevent accidental or unauthorised access. You must enter a password to gain access. The password is case sensitive and must consist of at least 5 characters.

The default password is Navmaster (case sensitive)

**To Enter Setup Mode**

1. Choose **Setup** from the **File** menu and select **Log in**
2. Enter the password and click **OK**
3. A message is displayed momentarily to indicate whether the password has been accepted or rejected.

After the password has been accepted **Setup** menus become available.

**To Exit Setup Mode**

Choose **Setup** from the **File** menu and select **Log Out**.

**To Change Password**

1. Choose **Setup** from the **File** menu and select **Change Password**.
2. Enter and confirm the new password and click **OK**.

*If you have forgotten your password …*

Delete Support.sys from C:\Program Files \ Navmaster (only exists if the default password has been changed).

**Recording Screen Size**

For symbols to be drawn at their correct size the size of your display must be correctly entered.
Choose **Setup** from the **Tools** menu and select the **System** tab. Enter height and width in millimetres. Save your **Workspace**.

Navmaster will display a message “*Warning, workspace unsaved (screen size may not be set)*” until this action has been carried out.

If you are using a calibrated display (see next section) the screen size is automatically applied and cannot be changed by the user.

**ECDIS Monitor Calibration**

ECDIS flat panel displays are calibrated against the PC’s graphics card so that day, dusk and night colours conform exactly to those required by the IHO ECDIS Presentation Library. The calibration takes place over a serial link between the computer and the display and is applied when shifting between day, dusk and night palettes. The following dialog is only visible if initialisation files are installed for the monitor in question (ColourControl subdirectory and associated files).

When the appropriate calibration files are present, choose **Setup** from the **Tools** menu and select the **Monitor** tab to set the following.

- **Control Port** to select the com port used for the calibration
- **Connection Status** shows whether the connection is active. Click **Test** for visual confirmation that the connection is working (the backlight values are changed momentarily).
• **Backlight intensity** to adjust the day, dusk and night backlight. *The default values are established during calibration and should not be changed unless, due to the age of the monitor, the backlight is not performing at its initial intensity.* Click **Set Default** to set each value back to its default.

*Note: Be aware that use of a brightness or contrast control may inhibit visibility of information, particularly when using the night colour tables.*

**Calibration Screens** provide a set of screens for colour tests.

**ECDIS Backup configuration**

Where dual Navmaster ECDIS systems are in operation with one system configured as Primary and the other as Backup the currently loaded route database can be transferred to the other ECDIS via the Transfer DB button on the route side panel.

This requires a Command Line Parameter in the target field of the Navmaster icon as follows (this is normally pre-configured):

2. On the Windows Desktop, right click on the Navmaster Icon, select **Properties** and then the **Shortcut** tab.
3. Place your cursor at the end of the target field (after the quote mark), enter a space and type *DedicatedECDIS*. If more than one Command Line Parameter is present, separate each one with a space.
4. Click **OK** to close the dialog and restart Navmaster.

The ECDIS should be connected by a RJ45 Ethernet cable (If two units are connected directly, a crossover cable is necessary). IP addresses should be configured as follows:

1. In Navmaster ECDIS log out of the Navmaster user account and into the NavAdmin user account.
2. From **Control Panel**, select **Network Connections**, right click on **Local Area Connection** and select **Properties**.
3. In the **General** tab, set the IP address to:
4. 192.168.0.1 for the Primary system
5. 192.168.0.2 for the Secondary system

In each case the Subnet Mask should be set to 255.255.255.0

To override auto assignment, the following Command Line Parameter can be added to the Navmaster Icon target field to force a unit to Primary:

| Primary | To force a system to be the primary ECDIS |

Should there be a lot of PCs connected to a network the following parameter will restrict the search to a range of IP addresses.

| IPRange:xxx.xxx.xxx,x,x | Where xxx.xxx.xxx defines the first 3 segments of the IP address to search for, and ,x,x defines the range to search within, eg 192.168.0.1,5 would search for addresses in the range 192.168.0.1 to 5. Note the placement of commas and full stops; they are critical for this command line to work. |

### Setting a Consistent Common Reference Point (CCRP)

A CCRP is defined as “a location on own ship, to which all horizontal measurements such as target range, bearing, relative course, relative speed, closest point of approach (CPA) or time to closest point of approach (TCPA) are referenced, typically the conning position of the bridge.”

In Navmaster the CCRP is the conning position which is set as described under How to enter vessel data below.

The following items are drawn at the CCRP:

- own ship symbol and past track
- own ship’s heading line and velocity vector
- tracked target symbols and range and bearing to AIS target symbols (AIS targets are plotted at the given latitude and longitude)
- the radar image overlay
- range and bearing, vessel to cursor
- ship-centred VRMs, EBLs and PIXs
- MOB R&B
How to Enter Vessel Data

Vessel dimensions and antenna positions

Log into Setup Mode and choose Setup \ General from the Vessel menu to:

- Enter the vessel’s name. This is included on passage plan reports.
- Enter length and beam. This is used to draw a scaled outline of your vessel. Gyro or compass input is required for the vessel outline to be drawn.
- Set the conning position location and the antenna location for the primary and secondary position fixing systems and ARPA.

**Note:** Failure to set these parameters correctly will cause the Own Vessel scaled outline to be drawn incorrectly and for AIS, ARPA targets and other range and bearing measurements to be inaccurately placed relative to own ship.

**TO ENTER SHIP’S DIMENSIONS**

1. Enter **Length** and **Beam**.
2. Click **Apply** after each entry.
**TO ENTER CONNING POSITION AND LOCATION OF ANTENNAS**

1. Select the item to change from the drop down list.

2. In the **Length** field, enter a positive number to set antenna position forward from amidships, or a negative number to set antenna position aft from amidships.

3. In the **Beam** field, enter a positive number to set antenna position to starboard of the centreline or negative to set antenna position to port of the centreline.

4. Click **Apply** after each entry.

**Deviation**

Choose **Setup** from the **Vessel** menu and select the **Deviation** tab to enter a deviation table for the vessel. This is used in passage plan reports that have a deviation field.

**Setting Up the Interface to Instruments**

Please note that all equipment supplied with Navmaster ECDIS conforms to International Standard **IEC60945** for **Maritime navigation and**
radiocommunication equipment and systems. Only interface cards and other equipment that have been approved in accordance with IEC60945 may be used in connection with **Navmaster ECDIS**.

**Allocating COM ports**

Log into **Setup Mode**. To enable Navmaster to read data from each instrument:

1. Determine the COM port number used by the instrument.

2. Choose the menu item listed in the table for each instrument type.

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Location of COM port setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary position fixing system</td>
<td>Navigator \ Setup \ Position \ Primary tab \ Receive</td>
</tr>
<tr>
<td>Secondary position fixing system</td>
<td>Navigator \ Setup \ Position \ Secondary tab \ Receive</td>
</tr>
<tr>
<td>Depth</td>
<td>Navigator \ Setup \ Depth \ Receive</td>
</tr>
<tr>
<td>Gyro</td>
<td>Navigator \ Setup \ Gyro \ Receive</td>
</tr>
<tr>
<td>Speed</td>
<td>Navigator \ Setup \ Speed \ Receive</td>
</tr>
<tr>
<td>Wind</td>
<td>Navigator \ Setup \ Wind \ Receive</td>
</tr>
<tr>
<td>AIS</td>
<td>Target \ Setup \ AIS \ General \ Configuration \ Receive</td>
</tr>
<tr>
<td>ARPA</td>
<td>Target \ Setup \ ARPA \ General \ Configuration \ Receive</td>
</tr>
</tbody>
</table>

3. Set the COM port used by the instrument in the **Receive** box and click **OK**.

4. If a new sentence is not received after the valid duration interval set, the sentence is considered invalid. Set **Valid Duration** for **Sentences** between 1 and 60 (default 15s) for sentences to be valid for a time that suits you.

5. If data, for example position which often arrives in several different sentences, is not received after the **Valid Duration** interval set, it is considered invalid. Set **Valid Duration** for **Data** between 1 and 30 (default 5s) for data to be valid for a time that suits you.
6. To upload to GPS or AIS, set the COM port in the Transmit box and click OK. Normally this will be the same COM port used to receive data from the instrument.

7. Save your settings - see workspace.

Setting the Baud rate

Most instruments output data at 4800 baud, the standard NMEA rate. AIS outputs data at a higher rate (38400 baud) and for this reason should normally be allocated a separate COM port (this may not apply if an external data combiner is used for all instruments).

To set baud rate for any COM port:

1. Choose Setup from the Tools menu and select the COM port from the drop down list.
2. Change the baud rate to the required level
3. Click OK.
4. Save your settings - see Workspace.

To verify data input

Once an instrument is connected, the COM port allocated and the baud rate set, check data input as follows.

1. Choose NMEA Window from the Navigator menu, select the COM port you wish to view, and click Receive to view data received or
Transmit to view data transmitted. Repeat if you wish to view more than one COM port at a time.

2. If you open more than one NMEA window, choose Tile vertically or horizontally from the Window menu so that you can identify the instruments allocated to each COM port and view the data streams.

3. When data is streaming in, you can freeze the display by dragging the vertical slide bar on the right hand side of the window upwards. You can then verify that the required NMEA sentences are being received from each instrument.

NMEA Warnings and Alarms

Checks are carried out on every NMEA sentence for:
1. **Checksum**: to detect if the data has been altered or corrupted during transmission. The NMEA standard requires that a checksum is sent with every sentence however sentences that are sent without a checksum will be accepted provided that there are no other validity issues.

2. **Status flags**: which are provided by some but not all sentences. For example the status of the GLL sentence (Latitude and Longitude) is set to invalid if its mode indicator is DR or Simulator. To allow for circumstances where you might wish to use data sent with an invalid flag, this check can be temporarily deactivated – see [Ignore Warning Flags](#) below.

3. **Invalid or null data or incorrect data in the context of the sentence.**

To assist troubleshooting, appropriate messages are posted to the Navigation section of **System Messages**. Where possible, the source of the message is shown together with the state that has caused the message or alarm.

If an Alarm is generated, such as for loss of position, then the following window will appear. The alarm will sound until acknowledged.

### NMEA Sentences

*Note: the minimum inputs required for ECDIS mode are position, gyro heading, and speed log.*
Choose **Setup** from the **Navigator** menu, select the NMEA tab and then **Sentences**. Select a device from the drop down list at the top of the dialog to show the Talker ID and Sentences used by the device.

![NMEA Setup Dialog](image)

**NMEA Talker ID**

The Talker ID is a prefix attached to all NMEA sentences to identify its origin. In the sample below, HE is Gyro (north seeking), RA is radar and GP is GPS.

```
$HEDI,276.5,I
$HEDI,276.5,I
$HRITM,17.4,66,356.84,T,15.81,218.76,I,0.42,22.13,N,,T,,67
$HRITM,17.4,66,356.84,T,15.81,218.76,I,0.42,22.13,N,,T,,67
$GPGLL,5130.525,N,00208.799,E,205858.4
$GPGLL,5130.525,N,00208.799,E,205858.4
$GPZDA,284.1,286.11.9,N,22.0,K
$GPZDA,284.1,286.11.9,N,22.0,K
$GPZDA,205858.27,11.2001,-1.0
$GPZDA,205858.27,11.2001,-1.0
```

The standard Talker IDs are included in the receive list for each device and are listed below. Any data not prefixed by one of the talker IDs in each device’s list is ignored. However there are circumstances where NMEA data that you wish to use is prefixed by a non-standard Talker ID.

To add a Talker ID for any device:

1. Select the device for which you wish to
add a Talker ID from the drop down list.

2. Click the New button to the right of Receive

3. A text entry box appears. Enter the new Talker ID (eg RA under Gyro).

4. Click OK or Apply and save your Workspace.

To remove a Talker ID, select it and click the Delete button.

To set the list of Talker IDs back to the original set, click the Default button.

By default any data sent by Navmaster as a talker is prefixed with EI, the Talker ID for ECDIS. To change, enter an appropriate ID in the Transmit field, click OK or Apply and save your Workspace.

**NMEA Sentence list**

For each device, a list of applicable sentences is provided. Tick or clear the box alongside any sentence to activate or deactivate.

Click the Tick button to activate all sentences or the Cross button to deactivate all sentences.

Tick Ignore warning flags to ignore any warnings generated by a sentence. *Note: this setting is provided to overcome a short-term situation or problem and is not saved to the workspace.*

The following lists the NMEA sentences supported by Navmaster with default Talker IDs for each device. Sentences prefixed with an asterisk are required for normal operation.

**AIS NMEA sentences**

<table>
<thead>
<tr>
<th>Pref’d</th>
<th>Sentence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>ALR: Set alarm state</td>
<td>Local alarm condition and status</td>
</tr>
</tbody>
</table>
### AIS TALKER IDS

<table>
<thead>
<tr>
<th>Sentence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OSD: Own Ship Data</strong></td>
<td>Heading, course, speed, set and drift summary. Can be used as source for heading data by adding the radar Talker ID to the list recognised by Gyro – see NMEA Talker IDs</td>
</tr>
<tr>
<td><strong>TLB: Target Label</strong></td>
<td>Common target labels for tracked targets.</td>
</tr>
<tr>
<td><strong>TLL: Target Latitude and Longitude</strong></td>
<td>Target number, name, position and time tag.</td>
</tr>
<tr>
<td><strong>TTM: Tracked Target Message</strong></td>
<td>Data associated with a tracked target relative to own ship’s position.</td>
</tr>
<tr>
<td><strong>RSD: Radar System Data</strong></td>
<td>Radar display setting data. Includes range and bearing to radar cursor.</td>
</tr>
</tbody>
</table>

Either TLL or TTM (preferred) is required in order to display a target position. RSD enables the radar cursor to be superimposed on the chart.

### ARPA TALKER IDS

<table>
<thead>
<tr>
<th>Sentence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DBT: Depth Below Transducer</strong></td>
<td>Water depth referenced to the transducer</td>
</tr>
<tr>
<td><strong>DPT – Depth</strong></td>
<td>Water depth relative to the transducer and offset of the measuring transducer</td>
</tr>
</tbody>
</table>

### Depth NMEA sentences

### DEPTH TALKER IDS
**Gyro NMEA sentences**

<table>
<thead>
<tr>
<th>Pref’d</th>
<th>Sentence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>HDG  Heading – Deviation &amp; Variation</td>
<td>Heading (magnetic sensor reading), which if corrected for deviation, will produce Magnetic heading, which if offset by variation will produce True heading.</td>
</tr>
<tr>
<td></td>
<td>HDM: Heading – Magnetic</td>
<td>Actual vessel heading in degrees Magnetic (if this sentence is the only source of heading available, Navmaster will derive a true heading by adding variation from the IGRF model – see <a href="http://www.ngdc.noaa.gov/IAGA/vmod/igrfhw.html">http://www.ngdc.noaa.gov/IAGA/vmod/igrfhw.html</a> for the limitations of this model)</td>
</tr>
<tr>
<td></td>
<td>HDT: Heading – True</td>
<td>Actual vessel heading in degrees True produced by any device or system producing true heading.</td>
</tr>
<tr>
<td></td>
<td>THS: True Heading and Status</td>
<td>Actual vessel heading in degrees True produced by any device or system producing true heading.</td>
</tr>
<tr>
<td></td>
<td>VHW: Water Speed and Heading</td>
<td>The compass heading to which the vessel points and the speed of the vessel relative to the water.</td>
</tr>
<tr>
<td></td>
<td>OSD: Own Ship Data</td>
<td>Heading, course, speed, set and drift summary from ARPA.</td>
</tr>
</tbody>
</table>

**GYRO TALKER IDS**

Receive HC, HN, VD, HE, II, VM Transmit None

**Primary and Secondary Position Systems (normally GPS) NMEA Sentences**

<table>
<thead>
<tr>
<th>Pref’d</th>
<th>Sentence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BOD: Bearing – Origin to Destination</td>
<td>Bearing angle of the line, calculated at the origin waypoint, extending to the destination waypoint from the origin waypoint for the active navigation leg of the journey.</td>
</tr>
<tr>
<td></td>
<td>BWR: Bearing and Distance to Waypoint</td>
<td>Time (UTC) and distance and bearing (rhumb line) to, and location of, a specified waypoint from present position.</td>
</tr>
<tr>
<td><strong>DTM:</strong> Datum Reference</td>
<td>Local geodetic datum and datum offsets from a reference datum.</td>
<td></td>
</tr>
<tr>
<td><strong>GGA:</strong> Global Positioning System Fix Data.</td>
<td>Time, position and fix related data for a GPS receiver</td>
<td></td>
</tr>
<tr>
<td><strong>GNS:</strong> GNSS Fix Data</td>
<td>Fix data for single or combined satellite navigation systems (GPS, GLONASS, GNSS)</td>
<td></td>
</tr>
<tr>
<td><strong>GLL:</strong> Geographic Position – Latitude/Longitude</td>
<td>Latitude and Longitude of vessel position, time of position fix and status</td>
<td></td>
</tr>
<tr>
<td><strong>GLP:</strong> Loran-C Position</td>
<td>Present position and time</td>
<td></td>
</tr>
<tr>
<td><strong>RMA:</strong> Recommended Minimum Specific Loran-C data</td>
<td>Position course and speed data provided by a Loran-C receiver</td>
<td></td>
</tr>
<tr>
<td><strong>RMB:</strong> Recommended Minimum Navigation Information</td>
<td>Navigation data from present position to a destination waypoint provided by Loran-C, GNSS, navigation computer or other integrated navigation system</td>
<td></td>
</tr>
<tr>
<td><strong>RMC:</strong> Recommended Minimum Specific GNSS Data</td>
<td>Time, date, position, course and speed data provided by a GNSS navigation receiver.</td>
<td></td>
</tr>
<tr>
<td><strong>RTE:</strong> Routes Output</td>
<td>Waypoint identifiers, listed in order with starting waypoint first, for the identified route</td>
<td></td>
</tr>
<tr>
<td><strong>VTG:</strong> Course Over Ground and Ground Speed</td>
<td>The actual course and speed relative to the ground.</td>
<td></td>
</tr>
<tr>
<td><strong>WPL:</strong> Waypoint Location Input and Output</td>
<td>Latitude and Longitude of a specified waypoint</td>
<td></td>
</tr>
<tr>
<td><strong>XTE:</strong> Cross-Track Error – Measured</td>
<td>Magnitude of the position error perpendicular to the intended track line and the direction to steer to return to the intended track.</td>
<td></td>
</tr>
<tr>
<td><strong>ZDA:</strong> Time and Date</td>
<td>UTC, day, month, year and local time zone</td>
<td></td>
</tr>
<tr>
<td><strong>ZTG:</strong> UTC &amp; Time to Destination Waypoint</td>
<td>UTC and predicted time to go to destination waypoint</td>
<td></td>
</tr>
</tbody>
</table>

**GPS TALKER IDS**

Receive: GN, GL, GP, II  Transmit: None

**Speed NMEA sentences**

<table>
<thead>
<tr>
<th>Pref’d Sentence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>VBW:</strong> Dual Ground/Water Speed</td>
<td>Water referenced and ground referenced speed data</td>
</tr>
</tbody>
</table>
**VHW: Water Speed and Heading**

The compass heading to which the vessel points and the speed of the vessel relative to the water (via ARPA).

**OSD: Own Ship Data**

Heading, course, speed, set and drift summary from ARPA.

---

**SPEED TALKER IDS**

Receive: VD, VW, SN, VM, II  
Transmit: None

**Wind NMEA sentences**

<table>
<thead>
<tr>
<th>Pref’d</th>
<th>Sentence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MWD: Wind Direction &amp; Speed</td>
<td>The direction from which the wind blow’s, with respect to north, and the speed of the wind</td>
</tr>
<tr>
<td></td>
<td>MWV: Wind Speed and Angle</td>
<td>Apparent or true</td>
</tr>
</tbody>
</table>

**WIND TALKER IDS**

Receive: WI, II  
Transmit: None

---

**Alarm Management**

**ARPA and AIS Target Alarms**

Choose **Setup** from the **Target** menu and select the **Alarm** tab for an alarm to sound for AIS or ARPA targets based on:

- Target Range
- CPA \ TCPA

Uncheck these options if you do not want an alarm to sound.
Remote Diagnostics

Remote Diagnostics is a service available to customers with Technical Support Contracts. If you wish to take advantage of this service and do not have a Technical Support Contract please contact PC Maritime.

Navmaster stores user configurations in a workspace, which is stored in the Windows Registry. Workspaces can be emailed to PC Maritime to enable us to replicate your system settings for technical support.

If you are having difficulty establishing correct connection with marine instruments (GPS, Gyro, ARPA etc) you can record the data being received. By emailing a file to PC Maritime we can replay the data received from your equipment and help you identify and correct any problems.

To Email Your Workspace To PC Maritime.

1. From Navmaster choose Workspace from the File menu, click Export and choose the destination folder.

2. This will save a file called Registry x.txt (where x is a number incremented by 1 every time you export).

3. Email Registry x.txt to your contact at PC Maritime or support@pcmaritime.co.uk.

To Email A NMEA Data File To PC Maritime.

Log into Setup Mode.

1. From Navmaster choose Setup from the Navigator menu and select the NMEA tab.

2. Click the browse button to the right of the Export file field.

3. This opens a standard dialog as shown below
a. Select a location for the file (we suggest My Documents for ease of access).

b. Type a file name (we suggest your name or the name of your vessel followed by Data Test).

c. Click Open.

4. Check the Process check box and click Apply.

5. Allow five or ten minutes for sufficient data to be captured and then uncheck the Process box.

6. Email the data file with C:\My Documents\Registry x.txt to your contact at PC Maritime or to support@pcmaritime.co.uk

Note: You may wish to zip the files up before emailing. This will reduce their size substantially.

**Command Line Parameters**

Navmaster can accept a number of command line parameters for special situations. Using these parameters you can specify, for example, a specific com port to search for or error logging for troubleshooting.

To apply a Command Line Parameter:

2. On the Windows Desktop, right click on the Navmaster Icon, select \textbf{Properties} and then the \textbf{Shortcut} tab.

3. Place your cursor at the end of the \textbf{Target} field (after the quote mark and any existing command line entries), enter a space and type the command line (eg logerrors as shown above). To add more than one Command Line Parameter, separate each one with a space.

4. Click \textbf{OK} to close the dialog and restart Navmaster.

Ascertain whether applying a command line has resolved the problem and contact PC Maritime for further support if necessary. When you are finished, close Navmaster and remove the command line from the end of the \textbf{Target} field if appropriate.

The following Command Line Parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AddComPort</td>
<td>For use where Navmaster does not automatically recognise a com port. Use this parameter followed by a colon and space with the com port numbers you wish to be recognised. For example: addcomport: 6,7,8</td>
</tr>
<tr>
<td>Clean</td>
<td>Removes any temporary files left over after a system crash. Remove on completion.</td>
</tr>
<tr>
<td>DedicatedECDIS</td>
<td>Enables automatic route transfer between connected ECDIS</td>
</tr>
<tr>
<td>DongleUpdate</td>
<td>Use this parameter, followed by the update string to apply changes to the Navmaster ECDIS dongle, which does not have the option to update dongles from the Help menu, or for other versions where the dongle has expired. Eg DongleUpdate:204F64EE930177 Remove on completion.</td>
</tr>
<tr>
<td>Logerrors</td>
<td>Generates a file, Errorlog.txt, located in C:\Program Files\Navmaster containing error reporting. Normally only used under the instructions of PC Maritime’s technical support team.</td>
</tr>
<tr>
<td>Noworkspace</td>
<td>This parameter forces Navmaster to start with default settings.</td>
</tr>
</tbody>
</table>
Starting Navmaster.

Navmaster automatically starts when the ECDIS is turned on.

Working With Windows Dialog Boxes

Dialog boxes contain tabs, areas, entry boxes, drop-down lists, and various other types of check boxes and buttons. Dialog boxes containing large numbers of options are often organised into tabbed areas, which are selected by clicking the tab’s title to bring it forward.

After making selections in a dialog box, pressing the OK button causes the changes to take effect after the dialog box closes. Nearly all dialog boxes feature an Apply button that causes the changes to take effect before exiting the dialog box. This way you can preview your changes before actually committing to them. Clicking the Cancel button causes the dialog box to disappear without any changes taking effect.

Property Inspection

Objects drawn on the chart have properties such as name or position. The Properties command, which appears if you right click on the object on the chart, lets you inspect those properties and, in some cases, configure the object.
The Navmaster Window

When you start Navmaster the display will look similar to the one below.

Figure 1 Navmaster Window in Position Monitoring mode

When you are in Chartpoint, Route or Route Management mode, extra toolbars are added as shown below.

Figure 2 Toolbar layout in Planning Mode
What’s In the Main Window?

Title Bar

The title bar displays the program control icon, the application or active image title, and minimise, maximise and close buttons.

Menu Bar

The menu bar displays the menu headings.

<table>
<thead>
<tr>
<th>File</th>
<th>Contains: standard menu commands for file management; printing and workspace; importing and exporting route and Chartpoint information; backup, opening charts; and opening and saving Chartpoint and route databases.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Provides standard menu commands.</td>
</tr>
<tr>
<td>View</td>
<td>Provides menu commands to select modes of operation, turn on or off the toolbars, side panel and status bar.</td>
</tr>
<tr>
<td>Chart</td>
<td>Provides menu commands to change the chart display, install chart permits and updates, set the location of charts and updates, GoTo a specified position, add and manage manual chart updates and set chart related options.</td>
</tr>
<tr>
<td>Navigator</td>
<td>Provides menu commands to: set position source and DR parameters; apply a position offset, GoTo vessel; set position monitoring options; make log entries; access diagnostic windows to display data inputs; upload routes and waypoints to GPS, and set position and navigation related options.</td>
</tr>
<tr>
<td>Target</td>
<td>Provides menu commands related to AIS and ARPA and set related options.</td>
</tr>
<tr>
<td>Chartpoint</td>
<td>Provides menu commands related to Chartpoints.</td>
</tr>
<tr>
<td>Route</td>
<td>Provides menu commands related to Routes.</td>
</tr>
<tr>
<td>Vessel</td>
<td>Provides menu commands to enter vessel data and</td>
</tr>
</tbody>
</table>
manage vessel related alarms and warnings; a deviation
   table; to set vessel related overlays and to set track related
   parameters.

| Tools       | Provides menu commands to display tidal atlas; work with
             | Voyage Data Recording (if purchased); work with Mariner
             | Overlays; datum transformations, calculator, on-screen
             | keyboard and set workspace and tidal atlas options. |

| Window      | Provides standard menu commands to manipulate
             | windows. |

| Help        | Provides Help, access to the ECDIS symbol chart; online
             | updating and information on getting technical support. |

Any menu items that are “greyed out” are either unavailable in the current
mode or not available in your version of Navmaster.

**Status bar**

The following information is permanently displayed on the Status Bar.

| System messages | Click to review system messages. This area
                  | flashes when a new message is received. |

**Toolbars**

The toolbars provide buttons that access the frequently used commands in
the menus. If a command is unavailable, its button appears greyed-out.

Toolbars are laid out as shown in The Navmaster Window.

**Standard Toolbar**
Chart Toolbar

Manual Updates Toolbar

Display Toolbar

Voyage Toolbar

AIS Toolbar
ARPA Toolbar

- Hide
- Ack
- GoTo
- Toggle

targets alarm
target
radar cursor

Radar Overlay Toolbar

- ON/OFF
- Hide
- Options

overlay

Mariner Overlays

- Edit
- Hide
- Point
- Line
- Polyline
- Polygon
- Box
- Circle
- Range
- Text
- Info
- Caution

Mariner Tools

- Activate
- Hide all
- Add VRM
- Add EBL
- Add PI
- Add LOP
- MOB
- Add Tidal Stream Vector
- Add Position Line
- Add Position Mark
- Add event Marker

Vector Chart Toolbar

- Display mode
- Standard display
- Presentation parameters
- Safety contours
- Scale selector
- Range selector
**Chartpoint Toolbar**

The Chartpoint and route toolbars are only available in Chartpoint and Route mode as shown in The Navmaster Window. They contain scroll buttons to enable you to select the first, previous, next, or last item in the database or route.

The camera buttons allow you to view any pictures you have attached to the Chartpoint or route.

You can select a Chartpoint, route or route waypoint by name by clicking on the down arrow to the right of the Chartpoint or route name box.

**Route Toolbar (selects the route for editing only)**

**Side Panels**

Each of Navmaster’s main functional areas: monitoring position, storing Chartpoints, and creating and calculating routes, has a side panel. You switch between each function by pressing a button on the display toolbar or by pressing the F12 key.

The side panel can be toggled on or off by clicking on the display toolbar.

By default the side panel is docked at the edge of the window. It can also be undocked and left “floating” anywhere on the display, to allow more space for chart display.
To dock the side panel:

- Double-click the title bar of the floating side panel. It will either dock at the last place it was docked or select a default location.

To undock, do one of the following:

- Double click on the “handle” at the top of the side panel.
- Click and hold the handle and drag to the desired location.

**Position Monitoring Side Panel.**

The Position Monitoring Side Panel repeats position from your sensors, (GPS, speed log and gyro) provides information on any datum shift that has been applied and displays the active route name, active leg and ETA at the destination waypoint calculated from current speed over ground (SOG). Tabs provide further information:

- **NMEA**: repeats information from electronic instruments.
- **to Wpt**: provides calculated information from current position to the next waypoint in the route.
- **ETD**: provides a means of setting departure time for passage plan calculation and route annotation.
- **Wpt ETAs**: provides ETA’s at route waypoints
- **Wind**: repeats information from wind instruments.
- **Devices**: displays the *Primary* position source, *Secondary* position source (if connected) and *Dead reckoning*. A green dot indicates the positioning systems that are active. The difference between positions (in metres) is shown.
- **Satellite**: repeats information on the quality and status of GPS satellites (if the NMEA GGA sentence is received).

- **Route Warnings**: displays a list of warnings generated against the monitored route.

- **Chart Warnings**: displays a list of warnings generated against monitored position.

You can select the active route from the drop down list to the right of the route name box. The **Lock** check box activates or deactivates route locking so that route legs automatically increment as you pass waypoints. *(Note: if the correct leg is not selected it may be because Lock was checked before or during a period when position input became active. In this event uncheck and recheck the Lock box and the correct leg will be selected).*

**Chartpoint Side Panel**

The Chartpoint side panel enables you to add, delete or edit Chartpoints. Chartpoints are stored in a database; you can create any number of Chartpoint databases containing any number of Chartpoints.

The panel provides information about the current Chartpoint. Each field within the panel can be edited.
The Route side panel enables you to create new routes, edit existing routes and copy or reverse routes. Routes are stored in a route database; you can create any number of route databases containing any number of routes.

Five tabs provide further information:
- **General** enables you to enter and display a textual note relating to the route.
- **Waypoints** lists the waypoints in the route and provides a means to select waypoints for amendment or deletion or to locate a new waypoint. **Plan** gives the ability to calculate a passage plan based on the route that you can print or view on screen;
- **Warnings** allows you to view any chart generated warnings applicable to the selected route and **Charts** lists the installed charts that cover the route.

The button displays a horizontal panel that enables you to enter planned speed, off track limits and radius and rate of turn per leg and view planned times and distances.
Route Management Side Panel

This side panel enables you to:

- Select the active route
- Select the route to edit
- Select any route for multiple display
Target Tracking

This side panel provides information on ARPA and AIS targets.
**Information**

This side panel provides information on the selected chart, any cautions and access to Temporary and Permanent Notices to Mariners (ARCS), text notes, picture and general files (ENCs & CM-93/3), and any categories that are removed from the Standard Display (ENCs & CM-93/3).
Getting Help

ToolTip and Status Bar

To see the name of a button on the toolbar, place the cursor over it. A short description of the item also appears on the status bar.

Help

Choose Help Topics (includes Troubleshooting Flow Charts) from the Help menu to access online help. If online help is unavailable, this User Guide will open in Adobe Acrobat.

System Information

Choose System Information from the Help menu to view:

- Operating system information including system resource usage and memory availability.
- Library information
- Files in use to view the names of the open charts, Chartpoint, Route and Log databases.

To Close Navmaster

Choose Exit from the File menu.
How to Use Navmaster

The recommended sequence to follow when using Navmaster is:

1. Create a route
2. Calculate a plan
3. Monitor and plot your position

Each of these operations is fully described in later chapters.

How Navmaster Handles Time

Navmaster takes time from your operating system so it is important that your computer clock and zonetime are set correctly. Although all times are displayed in local time (e.g., in logs and in dialogs), internally Navmaster converts times to GMT. This enables calculations from, for example, the Proudman tidal model to be calculated correctly.

Windows in Navmaster

Navmaster is a multi-window application. Charts, the log, waypoint lists etc all have their own window and can be tiled, cascaded or kept in the background to suit the job in hand.

This gives you complete flexibility to organise your chart views to suit the tasks in hand. For example you can open new chart windows for the following:

- To look ahead by displaying the vessel position on a smaller scale chart than the Position Monitoring chart.
- To view the approaches or harbour charts for your destination
- To plan new routes or Chartpoints

Whilst you are carrying out any of the above you can still view the Position Monitoring window.
You can choose how chart windows are displayed from the Window menu. They can be cascaded, tiled or individually sized.

You can toggle between each open window by pressing <CTRL>+<TAB> or <CTRL>+<F6> or by selecting from the list of open windows at the foot of the Window menu.

### Opening Electronic Charts

When you start Navmaster, a Position Monitoring window is opened automatically if position data is available. Otherwise the chart display area is blank. Refer to Selecting Charts for further details.

### Navmaster Databases

In Navmaster, databases are used to store Chartpoints, Routes and Logs. File operation is very similar to any Windows application.

**Note:** A database contains any number of Chartpoints, routes or logs. You do not need to “save” a new database every time you create a Chartpoint, route or log. Normally you would only have additional databases if you wanted to maintain your routes and Chartpoints in separate areas, eg, one for the Caribbean, and another for the Mediterranean. We recommend that you regularly back up Chartpoint and Route databases. See Backing up Chartpoint, Route and Log databases on page 60 below.
Managing databases

CREATING A NEW CHARTPOINT, ROUTE OR LOG DATABASE

1. Choose New from the File menu or click on the toolbar. The New dialogue box opens.

2. Select the Chartpoint, Route or Log tab and double click on the Database symbol.

3. Type a name in the File name field and click Save.

SAVING A CHARTPOINT, ROUTE OR LOG DATABASE

Choose Save, Save as or Save all from the File menu. When you choose Save, you must select Chartpoint, Route or Log as required. When you choose Save all, all open databases will be saved.
Opening a database or replacing a chart in the current window

To open an existing file:

1. Choose **Open** from the **File** menu or click on the toolbar. Select the Chart, Chartpoint, Route or Log symbol depending on the type of item you wish to open.

2. Double click on any of the items listed.

3. An **Open** dialogue box will appear.

4. Select the file required from the Name column

5. Click **Open**. (A chart opened through this dialogue will replace the chart in the current chart window.)

Importing and Exporting Routes and Waypoints

Procedures are provided to import or export route and waypoint data from / to comma separated value (csv) or text (txt) file formats and to import \ export routes to and from the Admiralty’s e-navigator format
To Import Waypoints into a Chartpoint database

1. If you wish to import waypoints into an existing Chartpoint database, ensure it is open, otherwise create a new database (File \ New \ Chartpoint database).

2. Select the Chartpoint side panel and click the Edit button.

3. Choose Import from the File menu and click the Chartpoint icon.

4. Click the browse button to the right of File name and select the file to be imported.

5. Click Import.

The waypoint list must include all fields listed above: blank fields should be separated by commas (or you can change the default field delimiter (comma) or text qualifier (quote mark) at the top of the dialog).

An example comma separated value file (*.csv) follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>ID</th>
<th>Latitude</th>
<th>Longitude</th>
<th>Datum</th>
<th>Area</th>
<th>Group</th>
<th>Zone</th>
<th>Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;LIZARD&quot;,</td>
<td>&quot;AN110&quot;,</td>
<td>&quot;49°54.9798'N&quot;,</td>
<td>&quot;005°10.0098'W&quot;,</td>
<td>&quot;WGS84&quot;,</td>
<td>&quot;UK WEST&quot;,</td>
<td>&quot;WPT&quot;,</td>
<td>0.00,</td>
<td>&quot;England's most southerly point.&quot;</td>
</tr>
</tbody>
</table>

Latitude and longitude can be in any of the following formats (degrees (°) and minute ('') symbols can be entered but are not necessary):
<table>
<thead>
<tr>
<th>Degrees</th>
<th>Minutes / seconds</th>
<th>Sign</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>degrees followed by a space</td>
<td>decimal minutes or minutes and seconds separated by a space</td>
<td>N or S / E or W</td>
<td>&quot;49°54.9798'N&quot;, &quot;005°10.0098'W&quot;, OR &quot;49 54 30 N&quot; &quot;5 25 30 W&quot;</td>
</tr>
<tr>
<td>degrees followed by . (point)</td>
<td>Decimal degrees to a maximum 15 decimal places</td>
<td>Latitude – positive for N, negative for S Longitude – positive for E, negative for W</td>
<td>27.11666667, -50.1666667</td>
</tr>
</tbody>
</table>

Use the standard codes (WGS84, ETRS89, ED50 etc) to identify the datum of the position and ensure that the positions are correctly referenced to the chart.

**To Export Chartpoints to a file**

1. To export Chartpoints, open the Chartpoint database you wish to export.
2. Choose **Export** from the **File** menu and click the Chartpoint icon.
3. Click the browse button to the right of **File name**, select the location for the file and enter a filename with the suffix txt or csv depending on the file format required.
4. Click **Export**.
To Import Waypoints into a Route database

1. If you wish to import waypoints into an existing Route database, ensure it is open, otherwise create a new database (File \ New \ Route database).

2. Select the Route side panel and click the Edit button followed by the New button.

3. Choose Import from the File menu and click the Route icon.

4. From the drop down list, choose Record per line if importing from a text or CSV file or e-Navigator if importing an e-Navigator route.

5. Click the browse button to the right of File name and select the file to be imported.

6. Click Import.
If importing from a text or CSV file, all fields shown above must be included: blank fields should be separated by commas (or you can change the default field delimiter (comma) or text qualifier (quote mark) at the top of the dialog).

The maximum size of the data for each field is shown above.

An example comma separated value file (*.csv) follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>Latitude</th>
<th>Longitude</th>
<th>Datum</th>
<th>Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;LIZARD&quot;,</td>
<td>&quot;49°54.9798'N&quot;,</td>
<td>&quot;005°10.0098'W&quot;,</td>
<td>&quot;WGS84&quot;,</td>
<td>&quot;England's most southerly point.&quot;</td>
</tr>
</tbody>
</table>

Latitude and longitude can be in any of the following formats (degrees (°) and minute (') symbols can be entered but are not necessary):

<table>
<thead>
<tr>
<th>Degrees</th>
<th>Minutes / seconds</th>
<th>Sign</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>degrees followed by a space</td>
<td>decimal minutes or minutes and seconds separated by a space</td>
<td>N or S / E or W</td>
<td>&quot;49°54.9798'N&quot;, &quot;005°10.0098'W&quot;, OR &quot;49 54 30 N&quot; &quot;5 25 30 W&quot;</td>
</tr>
</tbody>
</table>
degrees followed by . (point)  
Decimal degrees to a maximum 15 decimal places  
Latitude – positive for N, negative for S  
Longitude – positive for E, negative for W  
27.11666667, -50.16666667

Use the standard codes (WGS84, ETRS89, ED50 etc) to identify the datum of the position and ensure that the positions are correctly referenced to the chart.

**To Export Route Waypoints to a file**

1. To export route waypoints, open a Route database and select the route you wish to export.

2. Choose **Export** from the **File** menu and click the Route icon.

3. From the drop down list, choose **Record per line** if exporting to a text or CSV file or **e-Navigator** if exporting to e-Navigator.

4. Click the browse button to the right of **File name**, select the location for the file and enter a filename with the suffix txt or csv for record per line or rtx (added automatically) for e-Navigator.

5. Click **Export**.

For Record per Line, you can change the default field delimiter (comma) or text qualifier (quote mark) at the top of the dialog.
To Import Waypoints from GPS or other NMEA compatible device

The GPS or other device must be capable of exporting the waypoints contained in its memory via the NMEA sentence WPL (Waypoint Location). Please refer to your device’s documentation to determine how to do this.

WPL includes latitude, longitude and Identifier (name). It does not provide any information about datum which is therefore assumed to be unknown.

1. To import waypoints into an existing Chartpoint database, ensure it is open, otherwise create a new database (File \ New \ Chartpoint database).

2. Select the Chartpoint side panel and click the Edit button.

3. Choose Import from the File menu and select the NMEA tab.

4. Select the correct Com port from the Receive drop down list.

5. Click Receive whereupon each waypoint will be added to the list in the dialog.

6. Once you have received all the waypoints click Receive again to prevent further waypoints being added. Uncheck the tickbox for any waypoints you do not wish to save.
7. You can now manually edit any of the fields, for example, datum as shown below.

8. Once you have finished click Save to transfer the waypoints to the currently open Chartpoint database.

**Backing up Chartpoint, Route and Log databases**

This feature enables you to quickly copy data to backup media (USB memory stick, another hard drive etc).
To carry out a backup:

1. Choose Backup from the File menu
2. Select the items you wish to backup from the list
3. Click the browse button to choose the destination location. The Backup button is greyed out until a location other than C:\Program Files\Navmaster is selected or if there is insufficient space on the backup media.
4. Click Backup.

**Using the Recent File List**

The charts you have recently opened appear at the foot of the File menu. Up to 4 charts can appear. To open one of these, double-click on its name.

**To Change the Folder Location for Charts and Databases**

If you wish, you can change the folder location for charts and the Navmaster databases as follows:

1. Log into Setup Mode
2. Choose Management from the Chart menu and select the General tab.
3. Click the Chart folder browse button to change the folder location.
4. Click the **External Chart Source** to change the CD Drive from which you will read chart CDs.

**Logs**

1. Log into **Setup Mode** and choose **Setup** from the **Navigator** menu and select the **General** tab.
2. Click the **Database** folder browse button to change the folder location.

**Chartpoints**

1. Log into **Setup Mode** and choose **Setup** from the **Chartpoint** menu and select the **General** tab.
2. Click the **Database** folder browse button to change the folder location.
3. Click the **Attachments** folder browse button to change the folder location.

**Routes**

1. Log into **Setup Mode** and choose **Setup** from the **Route** menu and select the **General** tab.
2. Click the **Database** folder browse button to change the folder location.
3. Click the **Attachments** folder browse button to change the folder location.

**To Open A Database from another Location**

If you wish to open databases from another location, such as disk or back-up locations:

1. Choose **Open** from the **File** menu, or click on the toolbar.
2. Click the type of database you want to open.
3. Click on the browse button alongside the **Look in** path.
4. Select the new location.
5. Double click the file required.
6. Remember to change the Database Folder location back to the original.
To Save A Database to A New Location

Follow this process to back up databases or copy them to media for transfer to another PC.

1. Choose Save As from the File menu, or click \ on the toolbar.
2. Click the type of database you want to save.
3. Click on the browse button alongside the Look in path.
4. Select the new location.
5. Type a filename in the File name box.
6. Click Save
7. Remember to change the Database Folder location back to the original if you do not wish to permanently save databases to the new location.
Maintaining Databases

These options are available from the Open, Save and Save as dialogs:

1. The Browse button, to change the location for opening and saving.
2. The Delete button to delete the selected file.
3. The Folder button to create a new folder.
4. The Tools menu which contains the following options:
   a. Change Directory to select a new location for file operations.
   b. Rename
   c. Delete
   d. Copy to create a copy of the selected file.
   e. ReadOnly to add or remove a read-only flag to a database.
      Navmaster will not operate correctly if a database is set to read-only.
      Databases backed up to CD are invariably set to read-only. If you copy them back to your hard disk use this option to turn off the read-only flag for each database.
   f. Clean Temporary Files which will remove temporary files left over from previous Navmaster sessions. The option is greyed out if there are no temporary files to remove.
   g. Refresh to redraw the file list.

Print and Print Preview

The following reports are available to print from Navmaster:
System Reports

Setup Record

A very useful report that lists com port allocations, vessel dimensions etc. We recommend that you print this report after installation or when you make and changes to your setup.

Chart Reports

**View of selected chart**
Prints the selected chart window.

**Installed chart list**
Provides a list of all charts installed with chart number, description and scale.

**Installed ARCS list**
Provides a list of all charts licensed with chart number, description and scale plus the permit number and chart
and update CD dates applicable to each chart.

**Chartpoint Reports**

| Chartpoint List | Provides a list of all Chartpoints in the current Chartpoint database. |

**Route Reports**

| Waypoint list | Provides a list of the waypoints in the currently selected route with distance and course for each leg. |
| Waypoint list (detailed) | As above plus any notes or memos. |
| Route list | Provides a list of all routes in the current database showing Name, From and To fields. |
| Route list (full details) | Provides a list of all routes in the current database showing Name, From and To fields plus additional information including the contents of the memo field for each route. |

**Plan Reports**

| Passage plan (with / without memos and with / without ROT) | Provides leg information only |
| Passage plan | Includes magnetic variation and deviation calculations |

**Log Reports**

| Vessel log | Limited report of positions, COG, SOG & notes |
| Voyage log | Full report to ECDIS requirements |
| Log list | List of all logs stored in the current log database |

**To view a report**

1. Choose **Print Preview** from the **File** menu. *Note that you must have a printer driver installed.*
2. Select the Chart, Chartpoint, Route or Log tab and double click the item you wish to preview.

To print a report

1. To print a report, choose **Print** from the **File** menu or click on the toolbar. *Note that you must have a printer driver installed.*

2. Select the Chart, Chartpoint, Route or Log tab and double click the item you wish to print.
The UK Hydrographic Office offers two update services for ARCS:

- The Navigator service where you licence charts for 12 months during which you receive a weekly Update CD.
- The Skipper service where you buy charts without time limit, and can buy updates annually or quarterly.

*Seafarer* is provided by the Australian Hydrographic Office in a similar fashion except that all charts are licensed without time limit with options to subscribe to a monthly or periodical update service.

**ARCS Licence Number**

With your first delivery of ARCS charts you received a UKHO sheet headed “Schedule A” containing your ARCS licence number. To purchase additional charts you must give your chart supplier this licence number.

**Chart Permits**

Each RC Chart CD contains all the charts available for a particular region. A chart permit is a code that unlocks a specific chart.

**To Delete All Charts**

Click **Delete** to delete all charts related to the tab currently in view (ARCS, ENC, Seafarer or CM93/3). This is useful should you need to reinstall charts from a clean start.

**Installing ARCS or Seafarer Charts**

For your first installation of ARCS or Seafarer charts you need:

1. One licence file and chart permit file.
2. One (or more) RC chart CDs.
3. One Update CD containing the latest chart corrections.
Installing charts on a computer Installing charts licences for the first time or when a new licence is issued

1. Choose Management from the Charts menu
2. Choose the ARCS or Seafarer tab
3. Insert your Weekly Update CD in your CD drive. If the ARCS Update data is not on a CD, click the browse button to the right and select the appropriate location (hard disk, memory stick etc).

Note that the CD Identifier field and all other options will be greyed out until a valid Update CD is inserted.

4. Once the Update CD has been recognised its CD identifier will be displayed, and the Select Permits field will light up.

5. Insert the media containing the Licence.
6. Click ... at the end of the Select Permits field.
7. Select the location of the permits.
8. Double click the GB.* (ARCS permits) or AUS.* (Seafarer permits) file.
9. Click the Install button. The permits and updates will be installed.
10. Once the Update CD has been read you will be prompted to insert each Area CD. If you want to skip an individual Area CD, click Cancel alongside the insert CD message. **Note: clicking Cancel at the bottom of the dialog cancels the complete chart installation.**

11. Insert the Area CD and / or Update CDs requested and click OK. Repeat this operation until all Area CDs are installed.

   **Note: If the ARCS data is not on a CD, click the browse button to the right and select the appropriate location (hard disk, memory stick etc).**

12. On completion, select the History tab and check that no errors have occurred. If data has failed to install refer to **Chart Installation Failures**.

   **Note: Each ARCS/Seafarer chart takes about 1.5-2MB hard disk space.**
ARCS Navigator or Seafarer Update Service

Charts provided under these services are issued with regular updates.

To install chart updates

The Update CD is cumulative and contains all the information on earlier Update CDs plus the new week’s information. You only need to install the latest weekly Update CD; all earlier Update CDs can be discarded.

1. Choose Management from the Chart menu and click the ARCS tab. The dialog will show Insert Weekly Update CD until you put a CD into the drive.

2. Insert your latest Update CD. Once recognised its identifier will be displayed, eg WK10_04 and the Select Permits field will light up.

   Note: If the ARCS data is not on a CD, click the browse button to the right and select the appropriate location (hard disk, memory stick etc).

3. Click Install in the Updates Installation section.

4. On completion, select the History tab and check that no errors have occurred. If data has failed to install refer to Chart Installation Failures.

To install additional charts from the licence

1. Start Navmaster.

2. Choose Management from the Charts menu.

3. Choose the ARCS or Seafarer tab as required.
4. The dialog will show **Insert Weekly Update CD** until you put a CD into the drive.

![Chart Management dialog](image1.png)

*Note: If the ARCS Update data is not on a CD, click the browse button to the right and select the appropriate location (hard disk, memory stick etc).*

5. As soon as a valid update CD is recognised the message will disappear and the CD identifier will appear, and the **Select Permits** field will light up.

![Chart installation](image2.png)

6. Click at the end of the **Select Permits** field.

7. Select the location of the Permits.

8. Double click the GB.* (ARCS permits) or AUS.* (Seafarer permits) file.

9. Click the **Install** button. The permits and Update CD will be installed.

![CD Identifier](image3.png)

10. Once the Update CD has been read you will be prompted to insert each Area CD. If you want to skip an individual Area CD, click **Cancel** alongside the insert CD message. *Note: clicking Cancel at the bottom of the dialog cancels the complete chart installation.*
11. Insert the Area CD requested and click OK. Repeat this operation when requested until all Area CDs are installed.

   Note: If the ARCS data is not on a CD, click the browse button to the right and select the appropriate location (hard disk, memory stick etc).

12. On completion, select the History tab and check that no errors have occurred. If data has failed to install refer to Chart Installation Failures.

To install additional charts by email or manually

If you have the appropriate Area CDs and Update CD you can install additional chart permits manually. Chart permits can be transmitted by fax, email or voice. If you receive permits by email, copy the two file attachments (for Skipper licences gb.lcn and gb.scp, for Navigator licences gb.lcn and gb.ncp) to a memory stick or CD.

Choose Management from the Charts menu and select the ARCS or Seafarer tab.

1. Insert your latest Update CD into your CD drive. If the ARCS Update data is not on a CD, click the browse button to the right and select the appropriate location (hard disk, memory stick etc).

2. As soon as a valid update CD is recognised the CD identifier will appear, eg WK10_04 and the Manual Entry fields will light up.

3. Enter the chart number followed by the permit string exactly as given (ignore the ‘+’ symbols). Note that all letters should be entered in lower
case and there are no letter O's, only zeros in the permit. If possible, copy and paste the permit string to avoid typing errors.

4. Click the **Add** button. If you have more chart permits to add, enter them now, otherwise click the **Install** button beneath Add. You will be prompted to insert the appropriate Area CDs.

5. On completion, select the History tab and check that no errors have occurred. If data has failed to install refer to **Chart Installation Failures**.

### ARCS Skipper and Seafarer Charts

Charts provided under these services are up-to-date at the time of purchase. They can be updated at intervals at extra cost. Navmaster must keep track of the RC Chart CD date and Update CD date applicable to each chart. Also, the UK HO periodically issues new RC Chart CDs; some of your charts may require an earlier Chart CD than the latest in order to load correctly.

If you have bought charts at different times it is essential that you keep all Chart and Update CDs until you next update all your charts to the same week. Then you can discard all Update CDs except the latest one, and you can discard any reissued Chart CDs except the latest one(s).

*To install an ARCS Skipper or Seafarer licence for the first time*

See section Installing ARCS or Seafarer Charts on page 68 above.
To install additional charts from a new licence

Your existing charts will not be updated to the same week as your newly bought charts (unless you have bought an annual or quarterly update at the same time). Use the new disk and CDs to install your new charts, but keep older CDs until you update all your charts to the same week.

1. Choose **Management** from the **Charts** menu, and choose the **ARCS** or **Seafarer** tab.

2. Insert your **latest** Update CD in your CD drive. Note that the CD Identifier field and all other options will be greyed out until a valid Update CD is inserted.

3. Once the Update CD has been recognised its CD identifier will be displayed, eg WK10_04 and the **Select Permits** field will light up.

4. Click \(\ldots\) at the end of the Select Permits field.

5. Select the location of the permits.

6. Double click the GB.* (ARCS permits) or AUS.* (Seafarer permits) file.

7. Click the **Install** button. The permits and updates will be installed.
8. Once the Update CD has been read you will be prompted to insert each Area CD. If you want to skip an individual Area CD, click **Cancel** alongside the insert CD message. **Note: clicking Cancel at the bottom of the dialog cancels the complete chart installation.**

9. Insert the Area CD and / or Update CDs requested and click **OK**. Repeat this operation until all Area CDs are installed.

10. On completion, select the History tab and check that no errors have occurred. If data has failed to install refer to **Chart Installation Failures**.

**To install additional charts by email or manually**

If you have the appropriate Area CDs and Update CD, you can be given chart permits by fax, email or voice. If you receive permits by email, either copy the two file attachments (gb.lcn and gb.scp) to a memory stick or save the permits to a folder you can point to on your PC. If necessary, you can install additional chart permits manually:
1. Choose **Management** from the **Charts** menu and then the **ARCS** or **Seafarer** tab.

2. As soon as a valid update CD is recognised the CD identifier will appear, eg WK10_04 and the **Manual Entry** fields will light up.

3. Enter the chart number followed by the permit string exactly as given (ignore the ‘+’ symbols). Note that all letters should be entered in lower case and there are no letter O’s, only zeros in the permit. If possible, copy and paste the permit string to avoid typing errors.

4. Click the **Add** button. If you have more chart permits to add, enter them now, otherwise click the **Install** button beneath Add. You will be prompted to insert the appropriate Area CDs.

5. On completion, select the **History** tab and check that no errors have occurred. If data has failed to install refer to **Chart Installation Failures**.

---

**To re-install all your charts when some charts are not updated to the latest week**

You may not be able to access some of your charts unless the correct procedure is followed so please follow these instructions.

1. Choose **Management** from the **Charts** menu and then the **ARCS** or **Seafarer** tab

2. Sort the CDs into date order, earliest first.
3. Insert your earliest Weekly Update CD in your CD drive. Note that the CD Identifier field and all other options will be greyed out until a valid Update CD is inserted.

4. Once the Update CD has been recognised its CD identifier will be displayed, eg WK10_04 and the Select Permits field will light up.

5. Click at the end of the Select Permits field.

6. Select the location of your oldest permit.

7. Double click the GB.* (ARCS permits) or AUS.* (Seafarer permits) file.

8. Click the Install button. The permits and updates will be installed.

9. Once the Update CD has been read you will be prompted to insert the Area CD(s) relating to this batch of charts. Insert the earliest Area CD(s) if you have identical Area CDs of different dates.
10. When the build is completed for your first batch of charts, remove the CD from your drive so that the panel reverts to the prompt “Insert Weekly Update CD”.  

11. Insert your next dated Weekly Update CD and follow the operation as described above for installing the second batch of charts. Repeat this operation until all your batches of charts are installed. Remove the CD and Licence disk from the disk drives. 

12. On completion, select the History tab and check that no errors have occurred. If data has failed to install refer to Chart Installation Failures. 

When Navmaster loads an ARCS chart, it applies any chart updates that are applicable. If for any reason the chart update is unavailable, you can load the chart without its update by pressing Cancel when prompted for an Update CD. The following warning will be displayed whilst a chart is used without a valid update. 

```
Chart ####. Warning - Licence is valid to NtoM correction XXXX.

The chart is correct to NtoM XXXX. Corrections are missing.

Please load Update CD that contains NtoM correction XXXX.
```

**To install ARCS Skipper chart updates**

You are, in effect, installing a new license, and need: 

- One licence and a chart permit file. 
- One (or more) RC chart CDs.
• One Update CD containing the latest chart corrections.

1. Choose **Management** from the **Chart** menu.

2. Choose the **ARCS** or **Seafarer** tab

3. Insert the Update CD into your CD drive.

4. Click the **Select Permits** button

5. Double click the GB.* or AUS.* (Seafarer permits) file depending on the format you are using.

6. Insert ARCS area CDs when requested.

7. On completion, select the History tab and check that no errors have occurred. If data has failed to install refer to Chart Installation Failures.

**ARCS \ Seafarer Chart or Update Installation Failures**

Should some or all charts or updates fail to install correctly, a message is displayed as shown above.

To assess the cause of the failure:

1. Refer to the History tab

2. Refer to System Messages \ Charts

Causes for failure include: incorrect licence, a faulty CD, Chart CD \ Update CD mismatch etc.
ARCS \ Seafarer Chart Management Information

Choose Management from the Chart menu and the ARCS or Seafarer tab and select the following tabs to view information about charts.

**Licence**

Click the Licence tab to view your licence details including User Permit number, Licence Type and Pin number.

![Licence Tab Image]

**Charts**

Click the Charts tab to see a list of all the charts you have licensed. Scroll to the right to see further information for each chart including: Chart CD ID and date, Update CD applied, expiry date (if appropriate), latest NtM, permit number and other technical information.
History

Click the History tab to see a date and time stamped record of all chart installation events including any errors that have occurred.
Installing Encrypted ENC Charts

To install encrypted ENCs you need:

- An attached eToken USB security key
  (provided by C-Map via PC Maritime)

- C-Map S57 installation licence file
  (normally pre-installed).
  If you need to install the S-57 compiler license please refer to *To Install ENC (S-57) Compiler License* on page 88.

- A digital certificate file (normally pre-installed)
  If you need to install a digital certificate please refer to *Installing the SA Security Certificate* on page 88 below

- A public key file (optional)
  PRIMAR.PUB

- A cell permit file
  Normally called PERMIT.TXT
  (provided by chart supplier)

- ENC Base and Update exchange sets
  which may be delivered on CD, DVD or other large media or via online services
  (provided by chart supplier)

### IHO S-63 Data Protection Scheme

Navmaster is compatible with the IHO S-63 Data Protection Scheme v1.1 and is backward compatible with version 1.0 of the scheme.

IHO S-63 Data Protection Scheme Error Messages are listed on page 297 below.

### Installing Encrypted ENC charts

1. Choose **Management** from the Chart menu and select the ENC \ S-57 \ **Encrypted** tab followed by the **Install** tab.
If the **Install** button is “greyed out” it is because the Scheme Administrators (SA) Security Certificate has not been installed. Follow the instructions under **Installing the SA Security Certificate** on page 88 below before proceeding.

2. Click the **Install** button. This will open a browse window headed **Select Permit File location**.

3. Locate and select `[filename].TXT` and click **Open**. (The filename will normally be Permit.txt).

4. The permits will be checked and if valid posted into the tree window under the heading Unassigned. They will be selected by default. If you wish to view the permits, expand the list by clicking the + symbol.

5. When the permit group is selected (designated by a number or producer code) the **Copy** button will light up. The tick box gives you the option to
separate data copying and installation. If ticked (the default) install will proceed automatically after all data has been copied. If unticked you have the option of copying the data and installing it in separate steps.

6. Click **Copy** and a **Chart Source Selection** dialog opens. Click **Drive** to select from an official base or update CD, DVD or other optical drive device or **Browse** to open a browse window so that you can select the location wherever it might be. **We recommend you select the Update first as this will give Navmaster information that can be used to guide you through the installation process (when data providers adopt v1.1 of the S-63 IHO Data Protection Scheme).**

7. Update / Base sets are identified by the volume name V01X01. Once a set has been copied you will be asked to select the location of the next set if one of a group (eg the Admiralty AVCS service consisting of nine CDs at the time of writing). If any of the remaining sets are not required for the license click **Cancel** to skip.

8. You will be asked if you have further Update or Base media to install.

9. If **Yes** select the location and proceed as described above.

During **Install** the ENCs are converted to SENC format so that Navmaster can display them. Depending on the number of ENCs being converted, this
can take some time. The progress bar will show the status of the operation.

On completion, click the View Log button and select the History tab to view any errors or warnings that have occurred. If data has failed to install refer to Chart Installation Failures.

You can open the installed charts from File \ Open or by clicking the Open button.

*Note that the C-Map ENC converter, type approved by DNV, generates chart installation errors. Non-critical errors can generally be ignored. Critical errors may need investigation. Queries regarding such errors should be directed to the chart data supplier.*

In this context the UK Hydrographic Office ENC Service User Guide page 9 comments as follows:

<table>
<thead>
<tr>
<th>… The data standard specification used for ENCs (S-57) is extremely complex and in some circumstances it is possible for the … ENC supplier to have subtly different interpretations of the standard. It is this that could cause the ECDIS to report conversion problems.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 The ENC or Update will not load at all. This is very uncommon …</td>
</tr>
<tr>
<td>2 The ECDIS loads the ENC or Update and reports an error. This is not common … Users should report the error … and only use the ENC with caution.</td>
</tr>
<tr>
<td>3 The ECDIS loads the ENC or Update and reports a warning. This is relatively common on some ECDIS systems. The warning indicates that there are minor interpretational problems between the ENC and ECDIS. These do not normally interfere with the correct operation of the ENC in the ECDIS.</td>
</tr>
</tbody>
</table>

**To Delete A Group Of Permits**

You can delete permits before you install them by selecting a group of permits and clicking the Delete button.
Updating Encrypted ENCs

1. Choose **Management** from the **Chart** menu and select the **ENC \ S-57 \ Encrypted \ Install** tab.

![Image of Permit List]

2. Select the group of permits to update, click **Copy** and select the location of the update via the **Browse** button if it is on your hard drive, USB key or other media, or **Drive** if you are installing from an official update CD.

![Image of Browse for Folder]

3. If Copy and Install (see above) are ticked install will proceed automatically after the data has been copied. Otherwise click the **Install** button when copying is complete. Click the **View Log** button and select the **History** tab to view any errors that have occurred. If data has failed to install refer to **Chart Installation Failures**.

**To Update an Existing Licence or Add New Cell Permits**

Proceed from **Installing Permits** above.
Maintenance

Installing the SA Security Certificate

If a certificate has not been installed or you wish to update it:

1. Choose Management from the Chart menu and select the ENC \ S-57 \ Encrypted tab followed by the Maintenance tab. (If a SA Security Certificate has been installed the View button will be available and you can read it.)

2. Click the Install button. This will open a file selection dialog headed Select SA certificate location. (If Install is greyed out, a Compiler License is not installed. See the section To Install ENC (S-57) Compiler License below.

3. Locate and select [filename].CRT and click Open. Note: The filename is not fixed, it may be IHO.CRT or Primar.CRT or UKHO.CRT and is normally delivered on exchange set media (base CD).

Note: If the SA Security Certificate is pre-installed you need take no action.
4. You will then be asked:

![Image of a dialog box]

5. Click **Yes** and select the file in the appropriate location or **No** if you do not have one.

*Note: Primar.CRT will generate a SSE26 error message. This can be ignored. Primar.CRT will be replaced by IHO.CRT when version 1.1 of the S-63 Data Protection Scheme is adopted whereupon SSE26 will no longer occur.*

**Viewing Installed Exchange Sets (Base and Update CDs)**

This dialog also shows the exchange sets that have been copied to the hard drive.

![Image of a table showing exchange sets]

**To Install ENC (S-57) Compiler License**

1. Choose **Management** from the Chart menu and select the ENC \ S-57 \ Access Permits tab.
2. To install the licence manually, select the **ENC licence** radio button and type or cut and paste the code that appears after V3CATMGR in the password.usr file to the Access Code field and click **Apply**.

3. To read the licence directly from the password.usr file, select the **Licence File** radio button, click the browse button to select the file location and click **Apply**.

An expiry date or the word **Purchased** is shown against **Licence Expiry Date** as appropriate.

**Installing Unencrypted ENC Charts and Updates**

1. Choose **Management** from the **Chart** menu and select the **ENC \ S-57 \ Unencrypted** tab.
2. Click the **Browse** button alongside *Charts Location* and select a folder (normally ENC_Root) containing ENCs you wish to import. The **Import** button will be available if there are valid charts or a valid catalogue at that location.

3. Click **Import**, the ENCs will be converted to SENC format so that Navmaster can display them. Depending on the number of ENCs being converted, this will take some time. The progress bar will show the status of the operation.

4. Click the **View Log** button and select the **History** tab to view any errors that have occurred. If data has failed to install refer to *Chart Installation Failures*.

   *Note that the C-Map ENC converter, type approved by DNV, generates these. Non-critical errors can generally be ignored. Critical errors may need investigation. Queries regarding such errors should be directed to the chart data supplier.*

5. You can now open the installed charts from **File \ Open** or by clicking the **Open** button.

**Installing CM-ENC Charts and/or Jeppesen Primar Service**

C-MAP deliver official ENC data in SENC format in accordance with the IHO amendment to paragraph 3.3 of S-52 and a new Technical Resolution A3.11 adopted at IHO’s 16th International Hydrographic Conference. The C-MAP CM-ENC SENC distribution system was type approved by Det Norske Veritas, DNV, in March 2003. The distribution system is supported
with a Real Time Updating service which allows users to access chart corrections directly online.

An advantage of SENC distribution is that the cells are pre-compiled which avoids the sometimes lengthy compilation process required when installing Encrypted ENC charts.

To install CM-ENCs you need:

- An eToken USB security key and CM-ENC licence file
- password.usr

 Licenses are generated for ENC charts based on the System ID of the ECDIS and the ENC coverage required in the form of a PASSWORD.USR file. Each licence is issued for a 12 month subscription period with a two month grace period. Jeppesen C-Map automatically renew licenses at the end of each 12 month subscription period unless the customer has terminated or defaulted on the subscription.

**Installing the CM-ENC chart database**

1. Choose **Management** from the Chart menu
2. Select the **ENC \ CM-ENC \ Database** tab.
3. Put the C-Map Chart CD into your CD-Drive.
4. Click the browse button to the right of the External Chart Source field and select the folder X:\C93_ROOT where X is the drive letter of your CD drive.
5. Click **Install**. If this button is greyed out the CD drive for the C93_ROOT folder described above is not selected correctly or the CD is not present. Chart data will be copied from the CD to the hard drive and carry out a digital signature check to ensure data integrity which will take a few minutes. If the SENC database fails the digital signature check the following message will be displayed and the database will not be available for registration:

*This database failed the digital signature check and therefore cannot be safely loaded into the ECDIS. Please contact your nearest C-MAP office for further information*

**To generate a CM-ENC chart licence**

6. Select the Licence Order tab. Select the chart or area name you wish to purchase and click the right arrow button to add the item to the Order box. Continue until all the items you need are listed in the order box. (Click the Load button if you wish to display the last order saved.)

![Image of Licence Order tab]

7. Check Subscribe if you are licensing charts under an annual subscription with updates or uncheck Subscribe if you are purchasing the charts without time limit or updates.

8. Click **Save**

9. Click **Copy To** to copy the CM-ENCLicenseOrder.ord file to a specified location on your hard drive or to a floppy disc.

10. Email the CM-ENCLicenseOrder.ord file to sales@pcmaritime.co.uk or your chart agent.
C-Map Norway will generate a licence code to enable you to access the Zones & Areas you have ordered. You will receive the codes within a few hours of sending the email (during normal working hours), in the body of the email or as an attached file – Password.usr. The information provided will be similar to the following (CM-ENC to the left; Jeppesen Primar to the right):

<table>
<thead>
<tr>
<th>[PC Maritime 00002]</th>
<th>[PC Maritime 00002]</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD-ROM ID-ENC.120</td>
<td>CD-ROM ID=jeppesenPRIMAR.402</td>
</tr>
<tr>
<td>Expired=9.2005</td>
<td>Expired=4.2.21</td>
</tr>
<tr>
<td>Rhine=1C5F9F3785EAF495</td>
<td>Zone 0 ENC=5D75A59F851E136</td>
</tr>
<tr>
<td>DE3001=2074D64F1531FE04</td>
<td></td>
</tr>
<tr>
<td>DE2001=5D0C09C623AF39E1</td>
<td></td>
</tr>
<tr>
<td>DE4019=E281D6D8408F6EEF</td>
<td></td>
</tr>
<tr>
<td>B13001=34C2C8CC0C5C248E1</td>
<td></td>
</tr>
<tr>
<td>NL2001=16B1B6D138A5D89</td>
<td></td>
</tr>
</tbody>
</table>

To activate CM-ENC charts

1. Select the Licence tab.

If you have a Password.usr file, check File Licence and click the browse button to its right. Open the folder containing Password.usr and select it. Click Apply to process the licence file.

If you do not have a Password.usr file:

2. Highlight the item you have licensed and click in the Licence column or press the Ins key to paste or type the 16 digit code. We recommend you copy the code from the email or Password.usr file (highlight and press Ctrl +C) and paste into the Licence column in Navmaster (Ctrl +V) to avoid typing errors.
3. If you have licensed more than one Area or chart repeat Item 2 above until you have entered the codes for them all.

4. Click **Apply**.

**Ordering additional charts**

1. Choose Management from the Chart menu and select the ENC \ CM-93/3-ENC \ Licence Order tab.

2. Follow the steps under the heading To generate a CM-ENC chart licence above.

**Activate the charts as described under the heading**

3. To activate CM-ENC charts above.

**Installing CM-ENC Updates**

CM-ENC updates are provided by installing a new chart database CD or by on-line update.

To install a new chart database CD, follow the steps described under **Installing the CM-ENC chart database** above.

**To update CM-ENC charts on-line:**

Note that this option is only available if your operating system is Windows 2000, XP or later.
4. You must have an active internet connection

5. Choose Management from the Chart menu and select the CM-ENC \ Update \ Auto tab.

6. Click Size if you wish to ascertain the file size of the download.

7. Click List to see a list of the updates that are available.

8. Click Download All to start the download.

9. Click OK to close the dialog when the download is finished.

**To update CM-ENC charts manually**

If you do not have Internet access you can request updates by sending a file to C-Map Norway. To do this:
• Choose **Management** from the **Chart** menu and select the **CM-ENC \ Update \ Manual** tab.

• Click Create File.

• Click **Copy to** to copy the **Updates.ord** file to a specified location on your hard drive or to a floppy disc.

• Send the file to C-Map Norway (updates@c-map.no).

• On receipt of the return file click the browse button to the right of the **Update Charts** field and select the folder and the **Answer.ans** file. Click **Update** to process the update file.

### ENC Chart or Update Installation Failures

![ENC Chart Update Failure Message]

Should some or all charts or updates fail to install correctly, a message is displayed as shown above.

To assess the cause of the failure:

1. Refer to the History tab
2. Refer to System Messages \ Charts

Causes for failure include: Incorrect licence, a faulty CD, Base CD \ Update CD mismatch etc.

### ENC Chart Management Information

Choose **Management** from the **Chart** menu and select the following tabs to view information about your charts.
Charts

Click the **Charts** tab to see a list of all the charts you have licensed. Scroll to the right to see further information for each chart including: Edition Number, Update Number, Authority, and whether out of date.

![Chart Table]

Chart Updates

Click the **Chart Updates** tab to see a sequential list of chart updates that have been applied together with an indication that each update has been registered or rejected.

![Chart Update Table]

The C-Map Cartographic Service

*The following text is provided by C-Map Norway for your information.*
The system that you are now using has the capability of using and displaying the CM-ENC vector chart databases. The ENC database charts are fully compliant with the latest IHO S-57 3.1 specifications and, when using this CM-ENC database (SENC) in an approved ECDIS, are considered equivalent to the navigational charts required by the SOLAS (Safety Of Life At Sea) convention.

**Registration of the system at C-MAP Norway**

A system that has the capability to use the CM-ENC SENC database can either be installed with an eToken or, in the case of Windows NT OS, the PC fingerprint method.

In the case of the PC Fingerprint method a file called USER.USR will be created (normally in the Program Files\CM93v3 directory). This file contains the Company ID and System ID assigned to the ECDIS/ECS system when it is installed. These IDs can be found on the back of the installation CD box or on a sticker placed on the equipment. If the eToken is not being used then this file must be sent to C-MAP Norway by email.

Licenses can only be generated once this file has been received and registered by C-MAP. In some cases the manufacturer of the system will have already pre-registered the system.

If, when installing a new system, you do not know your Company ID or System ID, please contact C-MAP Norway.

If you are using the eToken dongle then the USER.USR file has been automatically generated and stored on our system at C-MAP Norway. When you apply for chart licenses the application must include the System ID number as shown on the eToken key ring.

**Ordering Charts**

It is possible that charts will not be ordered together with the registration of the system. It is essential that as much information as possible is sent to C-MAP when ordering charts for a system. Charts can be ordered by Zone, Area or Cell or portfolio. Portfolios of charts can be defined and ordered by using the C-MAP Product Catalogue. Standard portfolios can be seen on our Internet pages at www.c-map.no. Price quotations can be obtained via your chart dealer or direct from your local C-MAP office. Once the licence
Applying Licenses

Once the order has been received at C-MAP, a licence will be generated and transmitted back to the user. This may be in the form of a single alphanumerical string (16 characters), or in the form of a file called PASSWORD.USR containing one or more licence strings. Once these licenses have been received they should be input using the software designed for this purpose by the ECDIS/ECS manufacturer. There are two types of licenses, purchase and subscription. The ENC database is only available on a subscription basis.

Subscription licenses need to be renewed each 12 months from the start of the subscription. Failure to renew a subscription will result in the charts becoming unavailable.

Updating SENC

It is a requirement from Primar Stavanger that the SENC database must be updated once per week by CD or automatic download via Internet or RAS. The SENC database can be updated with chart corrections via:

1. CD: C-MAP Norway will supply you with a new ENC database weekly. This CD contains the complete and updated ENC SENC database and completely replaces previous CDs. The new CD is installed into your ECDIS system and the SENC data is checked for authenticity. Please see your ECDIS user manual for more details on installation.

2. Internet, RAS or email: Your SENC subscription entitles you to download chart corrections by connecting to the Internet, C-MAP Remote Access Server (RAS), or by email. Once connected, charts updates are downloaded and applied to the SENC database with a log of all changes being available. If your system supports email updating you should prepare an update order and email this directly to updates@c-map.no. The update server will automatically process the request and reply to the email with the updates attached. The updates are split into 1,44MB files to allow them to be copied to floppy disks.
Licence Expiry

If you are using an updated CM-93 SENC database together with a type approved ECDIS it is considered equivalent to the navigational charts required by the SOLAS (Safety Of Life At Sea) Convention. It is the responsibility of the ships personnel to ensure that the charts are updated at the beginning of each voyage. It is also the responsibility of the ship owners or Management Company to ensure that all invoices are paid ensuring that the chart database is always available and that the “timeout” of the chart database does not occur.

Your SENC subscription licence entitles you to use the purchased charts for a period of twelve (12) months from subscription start. Two months prior to the end of each subscription period you will receive a new invoice for the next subscription period. Once the invoice is paid you will be sent new licenses extending your subscription for the next 12 months.

Two months prior to the licenses expiring, your ECDIS will start to display warning messages. These messages will appear every time you start the ECDIS or once every 24 hour period. The messages will inform you that unless the SENC licenses are renewed detailed charts will no longer be available after the expiry date. If the subscription is not renewed after the licence expiry period and detailed charts are no longer displayed, C-MAP will issue temporary licenses, upon request, in order for the vessel to navigate to the destination port.

Troubleshooting

If you are having problems installing your software or charts please check the following before calling the C-MAP support line:

- You are installing on Windows XP or Windows 2000. The system will not run correctly under Windows 95 or Windows 98.
- That the registered SENC database is available and not deleted.
- That you have correctly input the licence string(s).
- That you have not reinstalled Windows or any major hardware components. If you have done this you will probably need to reinstall your software.
- That your licenses have not expired.
Installing CM-93/3 Charts

To install CM-93/3 you need:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>password.usr</td>
</tr>
<tr>
<td>An eToken USB security key and CM-ENC licence file</td>
<td></td>
</tr>
<tr>
<td>CM-93/3 Global Chart Database CD</td>
<td></td>
</tr>
</tbody>
</table>

If an eToken security key is unavailable you can generate two files (User.usr & LicenceOrder.usr) and email them to PC Maritime for registration and licence issue.

If you have an eToken attached start from the section headed Installing the CM-93/3 chart database.

If you do not have an eToken start by generating a User.usr file.

To generate a User.usr file (if you do not have an e-Token)

The facility is provided in case of loss or damage to the e-Token to provide an emergency method of installing charts.

1. Start Navmaster.
2. Choose Management from the Chart menu
3. Select the CM-93/3 \ System tab. Note: This tab does not appear if a valid eToken is attached.
4. Enter the System ID number found on a sticker attached to the CM-93/3 CD jewel case in the User ID field. The sticker also contains the Company ID (PCMaritime UK).

5. Click Details. Enter your contact details in the Enter Customer Details section and click OK.

6. Click Apply.

7. Click Create.

8. Note that this action overwrites any existing licenses and you will be asked for confirmation twice before the file is created. Click OK to the message below to proceed.

9. Click No to the question asking you to cancel the operation. If successful, you will receive the message “New System ID has been successfully created”.

10. Click Copy To to copy the User.usr file to a specified location on your hard drive or to a floppy disc.
Installing the CM-93/3 chart database

1. Select the **CM-93/3 Database** tab.

2. Put the C-Map Chart CD into your CD-Drive.

3. Click the browse button to the right of the External Chart Source field and select the folder X:\CM93_3 where X is the drive letter of your CD drive.

4. Click **Install**. If this button is greyed out the CD drive for the C93_3 folder described above is not selected correctly or the CD is not present. Chart data will be copied from the CD to the hard drive and carry out a digital signature check to ensure data integrity which will take a few minutes. If the CM-93/3 database fails the digital signature check the following message will be displayed and the database will not be available for registration:

   *This database failed the digital signature check and therefore cannot be safely loaded into the ECDIS. Please contact your nearest C-MAP office for further information*

To generate a chart licence

1. Select the **Licence Order** tab.

2. Select the Zone or Areas within a Zone you have purchased and click **Add**. (Click + alongside each Zone for a list of Areas and cross-
reference with the CM-93/3 chart catalogue if necessary). Continue until all the Zones and Areas you need are listed in the order column. (Click the Load button if you wish to display the last order saved.)

3. Check **Subscribe** if you are licensing charts under an annual subscription with updates or uncheck **Subscribe** if you are purchasing the charts without time limit or updates.

4. Click **Save**

5. Click **Copy To** to copy the CM93v3LicenseOrder.ord file to a specified location on your hard drive or to a floppy disc.

6. Email CM93v3LicenseOrder.ord (and the **User.usr** file if you do not have an e-Token installed) to sales@pcmaritime.co.uk or your chart agent.

C-Map Norway will generate a licence code to enable you to access the Zones & Areas you have ordered. You will receive the codes within a few hours of sending the email (during normal working hours), in the body of the email or as an attached file – **Password.usr**. The information provided will be similar to the following:

```
[[PC Maritime 00002]]
CD-ROM ID=World.212
Date=07/15/05
Order=zone 2; Zone 3, Area 1;
```
To activate CM-93/3 charts

1. Select the Licence tab.

If you have a Password.usr file, check File Licence and click the browse button to its right. Open the folder containing Password.usr and select it. Click Apply to process the licence file.

If you do not have a Password.usr file:

2. Highlight the Zone or Area that you have licensed and click in the Licence column or press the INS key to paste or type the 16 digit code. We recommend you copy the code from the email or Password.usr file (highlight and press Ctrl +C) and paste into the Licence column in Navmaster (Ctrl +V) to avoid typing errors.

3. If you have licensed more than one Zone or Area repeat Item 2 above until you have entered the codes for them all.

4. Click Apply. After processing the CM-93/3 charts will be ready for use.

Ordering additional charts

1. Choose Management from the Chart menu and select the CM-93/3 Licence Order tab.

2. Follow the steps under the heading To generate a chart licence above.

3. Activate the charts as described under the heading To generate a chart licence above.
Installing CM93/3 Updates (subscription service only)

If you have a subscription licence a new chart database CD is issued to you every four months. You can also update your charts with all applicable Notices to Mariners and new chart editions at any time via an Internet connection.

To update CM93/3 charts from a new CD

1. Select the CM-93/3 \ Database tabs and put the C-Map Chart CD into your CD-Drive.

2. Click the browse button to the right of the External Chart Source field and select the folder X:\CM93_3 where X is the drive letter of your CD drive.

3. Click Install. If this button is greyed out the CD drive for the CM93_3 folder described above is not selected correctly or the CD is not present or there are no updates available. Chart data will be copied from the CD to the hard drive which will take a few minutes.

To update CM-93/3 charts on-line:

Note that this option is only available if your operating system is Windows 2000 or XP.

1. You must have an active internet connection
2. Choose **Management** from the **Chart** menu and select the **CM-93/3 \ Update \ Auto** tab.

3. Click **Size** if you wish to ascertain the file size of the download.

4. Click **List** to see a list of the updates that are available.

5. Click **Download All** to start the download.

6. Click **OK** to close the dialog when the download is finished.

**To update CM-93/3 charts manually**

If you do not have Internet access you can request updates by sending a file to C-Map Norway. To do this:

1. Choose **Management** from the **Chart** menu and select the **CM-93/3 \ Update \ Manual** tab.

2. Click **Create File**.

3. Click **Copy to** to copy the *Updates.ord* file to a specified location on your hard drive or to a floppy disc.

4. Send the file to C-Map Norway.

5. On receipt of the return file click the browse button to the right of the **Update Charts** field and select the folder and the *Answer.ans* file. Click **Update** to process the update file.
To renew all CM-93/3 licenses

This is a special facility to update all licenses to the same expiry date and is only available where necessary and by request to C-Map Norway.

1. Select the Licence tab.
2. Check Renew All Licenses
3. You will be supplied with a 16 character code – paste this into the Licence field.
4. Click Apply.

CM-93/3 Chart Management Information

Choose Management from the Chart menu and select the following tabs to view information about your charts.

Charts

Click the Charts tab to see a list of all the charts you have licensed.
Chart Updates

Click the **Chart Updates** tab to see a sequential list of chart updates that have been applied together with an indication that each update has been registered or rejected.

The C-Map Cartographic Service

*The following text is provided by C-Map Norway for your information.*

The system that you are now using has the capability of using and displaying the latest CM-93/3 worldwide vector chart database. These charts are fully compliant with the latest IHO S-57 3.1 specifications.

**Registration of the system at C-MAP Norway**

When a system is installed that has the capability to use the CM-93/3 database, it is required that an Aladdin eToken supplied by C-MAP is connected to the system (if the system has and supports USB). The eToken provides the system with a unique System ID that enables C-MAP to issue correct licenses. The actual System ID can be found on the eToken itself, on the back of the installation CD box or on a sticker placed on the equipment. This ID must be quoted on all chart orders, either by email (license@c-map.no) or by fax +47 51 46 47 01.

When a system does not have a USB port or does not have support for the eToken, a file called USER.USR will be automatically created during initial installation (normally in the Program Files\CM93v3 SDK directory). This file contains the Company ID and System ID assigned to the ECDIS/ECS.
system when it is installed. These IDs can be found on the back of the installation CD box or on a sticker placed on the equipment. This file must always be sent to C-MAP Norway by email (license@c-map.no) when installing the software. Licenses can only be generated once this file has been received and registered by C-MAP. It is important to note that the software may need to be reinstalled and reinitialised if the operating system or hardware is upgraded (see the troubleshooting section).

Please note that in some cases the manufacturer of the system will have already pre-registered the system by sending the USER.USR file to C-MAP.

If during installation you do not know your Company ID or System ID, please contact C-MAP Norway before continuing installation of the software.

Ordering Charts

A chart order may be sent together with the registration of the system as described above. It is essential that the required information be sent to C-MAP when ordering charts for a system. C-MAP has issued order forms specifying the information that is required, and contains vital information that will allow us to monitor and maintain your licenses throughout the lifetime of the system. Charts can be ordered by Zone, Area or Cell and these can be seen on our Internet pages at www.c-map.no or by downloading the Chart Product Catalogue also available on the web site. Price quotations can be obtained via your chart dealer or direct from your local C-MAP office. Once the licence order has been prepared it should be emailed to license@c-map.no or faxed to C-MAP Norway AS (+47 51 46 47 01).

Applying Licenses

Once the order has been received at C-MAP, a licence will be generated and transmitted back to the user. This may be in the form of a single alphanumerical string (16 characters), or in the form of a file called PASSWORD.USR. Once this licence has been received it should be input using the Licence Administrator software designed and supplied by the ECDIS/ECS manufacturer. There are two types of licenses, purchase and subscription. Purchase licenses are valid indefinitely while subscription
licenses need to be renewed each 12 months from the start of the subscription. Failure to renew a subscription will result in the charts becoming unavailable.

**Troubleshooting**

If you are having problems installing your software or charts please check the following before calling C-MAP:

- You are installing on Windows 2000 or Windows XP. The system will not normally run under Windows 95 or Windows 98 first edition.
- That the registered WORLD database is available.
- That you have correctly typed the licence string.
- That you have not reinstalled Windows or any major hardware components. If you have done this you will probably need to reinstall your software (only required for systems that are not using eToken).
ECDIS Chart 1

ECDIS Chart 1 is an ENC version of IHO INT1, including all simplified and traditional symbols; line styles and colours used. It is provided as a look up reference and can be accessed and used as follows:

1. Choose **ECDIS Chart 1** from the Help menu. The chart will open in a new window.

2. Click or scroll to the part of the chart you wish to access.

3. Right click to display a menu. By default traditional symbology is shown. Click **Display Simplified symbols** if required.

4. Click **Properties** and expand the item to display information and the attributes of the object.

5. Click **X** to close the chart.
Scalebar, North Up Symbol And Scale Factor

Scalebars are always drawn as shown to the right.

If the scale of the chart currently viewed is below 1:80,000 graduations are displayed every tenth of a nautical mile.

If the scale of the chart currently viewed is above 1:80,000, graduations are displayed every 2 nautical miles.

The North Up arrow is always drawn and rotated to represent true north.

**Underscale** or **Overscale** is displayed at the bottom left corner of the chart window when chart is not shown at its compilation scale.

On ENC and CM93/3 charts, a factor is shown. If the factor is >1 the chart is overscaled. If the factor is < 1 the chart is underscaled.

No indication is shown when the chart is displayed at its compilation scale.
Chart Options

Choose Options from the Chart menu to display the following tabs.

Overlays

![Chart Options Interface]

**CHART CATALOGUE**

Limit lines are drawn to show chart boundaries. You can:

- Select labels for display when the chart catalogue is selected under the ENC, ARCS, Seafarer and CM-93/3 tabs
  - **Type** (eg ARCS, ENC, CM-9)
  - **Name**
  - **Description**.

- Apply a filter to determine how densely chart boundaries are drawn. If you sent the slider close to None, then all chart boundaries will be drawn, regardless of the scale of chart being viewed (this can clutter the view and take time to draw). If you set the filter close to Max then only overview scale chart boundaries will be drawn. A setting in the middle will probably suit most requirements.

**GRATICULE**

Check Graticule to display a latitude and longitude grid on charts.
ENC and CM-93/3 chart options

GENERAL

CHART CATALOGUE

Check to display the chart boundaries of installed ENCs

CUSTOM DISPLAY

Custom display enables you to define additional vector chart displays to meet your requirements. To create a custom display:

1. Click new and enter a name.

2. Set the start level by clicking one of S52 Base, S52 Standard or S52 Other. For example, if you click S52 Standard, all the objects applicable to the standard display will be checked and you can run down the list deselecting or selecting objects as required. If an object is greyed out it is in Display base and cannot be removed from the chart.

3. Check or uncheck the objects you wish to select.
4. For example name a Custom display *Stnd with soundings, Set by S52 Standard* and then run down the list, select *soundings* and check *Point*. Click the Save button.

5. The Custom display will be available in the Vector Toolbar drop down list. Select *Standard* and then *Stnd with soundings* to observe the difference.

**ARCS & SEAFARER CHART OPTIONS**

![Image of Chart Options]

**LIMIT LINES**

Check **Chart catalogue** to display ARCS (or Seafarer under the Seafarer tab) chart coverage limits. **Chart catalogue** labels can be selected from **Overlays** above.

Check **Chart Updates** to display a blue outline around updates that have been applied to ARCS charts.

**ZOOMING**

Check **Use Default scale only** for zoom in / out operations to choose the default ARCS chart scale only. This means that Navmaster will always display the high-resolution image except at the largest scale of chart available for a position.

**Chart Setup**

Log into **Setup Mode** and choose **Setup** from the Chart menu to display the following tabs.
General

SCROLL BARS
Check or uncheck this item to show or hide scroll bars on chart windows (other than the Position Monitoring window which never has scroll bars).

ROTATION STEP
To set the step number in degrees for rotating vector charts.

CURSOR
This option allows you to set the cursor with an open or closed centre.

Selection

WORLD CHART
Use this option to set the chart that will be loaded when you press the World button. Run down the list to set the chart of your choice (perhaps ARCS chart 4000 covering the World) and click Apply.
Selecting Charts

To replace the chart in a window

First, if you have more than one chart open, click on the title bar of the chart window you want to replace to make it the active window and then do one of the following:

1. Choose **Open** from the **File** menu.
2. Choose a recently used chart from the bottom of the File menu.
3. Draw a zoom box (hold the left mouse button down and drag to the left or right) over the chart area you wish see in more detail.
4. Click the right mouse button on the chart and choose **Charts for vessel position** or **Charts for cursor position** from the menu. Select a chart from the list and click **Open**.

5. Click the (zoom in) or (zoom out) buttons on the Chart toolbar.
6. Click the (world) button on the Chart toolbar.
7. Press the (GoTo) button on the Chartpoint, Route, Voyage and ARPA or toolbars to open the best chart for the current Chartpoint, route waypoint or vessel position, respectively.
8. When using ARCS charts move the cursor over a chart border and click when the cursor changes to an open folder. This will open the best available adjacent chart.

To open a new chart window

1. Choose Open from the File menu, select a chart and choose Open in a new Window from the Open button.

2. Click the right mouse button on the chart and chose either Charts for vessel position or Charts for cursor position from the menu and choose Open in a new Window from the Open button.

NB: If the Open button is greyed out it means you already have the maximum number of chart windows open or have run low on memory.

Safety Contours

To set these parameters for your voyage, click the Contours button on the Vector Toolbar or choose Contours from the Chart menu.

Three contours can be set (vector charts only) together with a means of accentuating spot depths. If the values you enter do not correspond to a contour available in the chart, the next contour up will be used. For example if the chart on display has 5m and 10m contours
and you have set your safety contour at 6m, the 10m contour will be used as the safety contour.

**Safety Contour**

This contour is to distinguish between safe and unsafe water and to generate alarms and warnings against your planned and monitored route.

During route monitoring the Chart Warnings tab shows active safety contour warnings, (including contours within the vessel’s guard zone lower than the safety contour), and chart warnings set under Vessel \ Options \ Warnings for **Position Monitoring alarms**.

Select any item and click **Highlight** to identify it on the chart.

The area between the Safety Contour and the Shallow Contour is shaded light blue (day) and medium blue (night).

**Shallow Contour**

Shades the area from the shallow contour to zero depth medium blue (day) and light blue (night).

**Deep Contour**

Shades the area above the deep contour to white (day) black (night).

**Safety Depth**

Emphasises soundings on the display equal to or less than the value set. It could be set, for example, to the ship’s draught plus under keel clearance.
Display two shades only

Check this option to display depth in two shades: zero to safety contour and greater than safety contour. Uncheck this option to display shading for the following depth areas:

1. Zero to shallow;
2. Shallow to safety;
3. Safety to deep

It can be beneficial to set two shades on when the dusk or night palette applies, to improve contrast for viewing ARPA and AIS targets.

Display shallow pattern

Displays a cross hatch over the area beneath the safety contour to make shallow water more visible in dusk and night palettes.
Vector Chart Options

Display detail

The levels of detail that can be selected for ENC and CM93/3 (from the Vector Chart Toolbar or by right clicking on the chart) are:

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base</td>
<td>This level cannot be removed from the display. It is information that is required at all times in all geographic areas and all circumstances. It is not intended to be sufficient for safe navigation.</td>
</tr>
<tr>
<td>Standard</td>
<td>This displays the information that must be shown when a chart is first displayed.</td>
</tr>
<tr>
<td>Other</td>
<td>This displays the data in the Standard display plus Other Information (cables and pipelines, etc).</td>
</tr>
<tr>
<td>Custom</td>
<td>This displays any custom sets that you have defined from Chart \ Options \ ENC or CM-93/3 \ Custom Display. Custom sets can be generated based on Base, Standard or All displays with selected objects added and / or removed.</td>
</tr>
</tbody>
</table>

North up / Head up / COG Up

Select the orientation required from the Chart menu or by choosing the Position Monitoring tab from Navigator \ Options.

Rotate Clockwise \ Anticlockwise

Choose Rotate Clockwise \ Anticlockwise from the Chart menu to change the orientation of the chart in small steps. (Not available in Position Monitoring window). The rotation step can be set in Chart \ Setup \ General.

Presentation Parameters

ENC and CM-93/3 charts can be configured from the Presentation Parameter button on the Vector Chart Toolbar.

Note: the settings you apply here are automatically saved. However, if you select S-52 Base or S-52 Standard the chart display reverts to ECDIS standard settings. Some might regard this as a nuisance in which case you
should avoid using the these options. Instead create a **Custom Display** that you can use without losing Presentation Parameter Settings.

**Depth**

<table>
<thead>
<tr>
<th>Description</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>No depth contours, objects will be represented as safety contours</td>
<td>Removes bold line defining edge of safety contour</td>
</tr>
<tr>
<td>Hide all depth soundings greater than safety depth</td>
<td>Removes spot depths</td>
</tr>
<tr>
<td>Hide depth contour numbering</td>
<td>Removes numbers from contours</td>
</tr>
<tr>
<td>Hide depth soundings less than shallow contour</td>
<td>Removes spot depths</td>
</tr>
<tr>
<td>Display depth contours on all displays</td>
<td>Forces display of depth contours on for Base and Standard displays</td>
</tr>
<tr>
<td>Display soundings</td>
<td>Turns soundings (spot depths) ON</td>
</tr>
</tbody>
</table>

**Text**

<table>
<thead>
<tr>
<th>Description</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display important text</td>
<td>eg bridge clearance</td>
</tr>
<tr>
<td>Display other text</td>
<td>eg place and object names</td>
</tr>
<tr>
<td>Display short light description</td>
<td>Includes light characteristics</td>
</tr>
</tbody>
</table>
Additionally, if you hover the cursor over an object for more than 2 seconds, its name and short light description (if available) will be displayed until you move the cursor away.

### Generic Text Off (Display $Text objects)
Removes generic text such as place names. Useful to remove clutter when a chart is zoomed out.

### Display Objects with INFORM (NINFORM) attribute marked
Displays to identify objects with additional information

### Display objects with TXTDSC (NTXTDS) attribute marked
Displays to identify objects with additional information

### Display objects with PICREP attribute marked
Displays to identify objects with additional information

## Display

<table>
<thead>
<tr>
<th>Description</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain boundaries (e.g., Tracks, Routes, Areas, Limits)</td>
<td>Displays simplified boundaries</td>
</tr>
<tr>
<td>Display real length of lights (light sectors)</td>
<td></td>
</tr>
<tr>
<td>Display danger symbol for certain objects within safety contour (always activated when Standard display selected)</td>
<td>Highlights dangerous objects within safety contours.</td>
</tr>
<tr>
<td>Hide quality of data symbol</td>
<td></td>
</tr>
</tbody>
</table>
### Zooming Charts

The same operations are used to zoom both raster and vector charts,

<table>
<thead>
<tr>
<th></th>
<th>On the toolbar</th>
<th>On the keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>To zoom in</td>
<td></td>
<td>PgDn</td>
</tr>
<tr>
<td>To zoom out</td>
<td></td>
<td>PgUp</td>
</tr>
</tbody>
</table>

This will change the chart to the next larger or smaller scale.

### Changing scale

An alternative to zooming is to change scale or range via the buttons on the Vector toolbar. This operation is not available for raster charts.

### Raster charts

An ARCS or Seafarer chart is supplied as two independent images: a low-resolution (LR) image and a high-resolution (HR) image. The low-resolution image provides an overview of the chart. The high-resolution image is updated with Notices to Mariner corrections and is the resolution recommended for navigation.

Navmaster provides zooming in and out of high-resolution charts to provides warnings as follows:

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Zoom Level</th>
<th>Warning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Resolution</td>
<td>Normal (LR)</td>
<td>Underscale</td>
</tr>
</tbody>
</table>
**Vector charts**

Vector charts are supplied as a series of data points that can be drawn at any scale. The data is based on a “compilation scale” which gives an indication of the suitability of the data for display at large scale. For example if chart data is displayed on screen at 1:2500, it is not going to be highly detailed and accurate if the original scale is 1:300,000. The original and current scales are shown in the Chart Information panel.

**Moving Around Charts**

*To centre the chart on the cursor position*

Click anywhere on the chart to centre on that position.

*To pan the chart*

Use the scroll bars at the sides of the chart window.

**The Right Mouse Menu on Charts**

Clicking the right mouse button on any part of a chart will display a menu that is partially context sensitive. The top portion of the menu displays context sensitive options as follows:

- **Position monitoring in DR mode**
  - Position Vessel (DR)...
  - Offset Vessel...

- **Chartpoints**
  - Add New Chartpoint
  - Delete Selected Chartpoint

- **Route**
  - Add New Waypoint
  - Insert New Waypoint
  - Delete Selected Waypoint

In all operations, the following are available:

- **Scale selector** to choose the exact scale for the display of vector charts.
Default scale to display the current chart at its compilation scale.

Best chart for Cursor Posn to select the largest scale chart for the position.

Charts for Vessel Posn to display, and optionally select from, a list of charts for vessel position.

Charts for Cursor Posn to display, and optionally select from, a list of charts for cursor position.

Lock Chart Format - If you have more than one chart format installed, use this option to lock the current chart format to the current window. This is useful if:

1. You wish to temporarily disable the selection of other chart types.
2. You wish to have two or more chart windows, one displaying ARCS and the other CM-93/3 or ENC.

[Chart type] Display to display a menu from which you can select: [for ARCS, the Overview chart, low resolution chart and Verify Chart integrity to ensure that no data corruption has occurred (if verification fails, re-install the chart and / or updates)], [for ENC/ CM-93/3, select between Base, Standard, Full and Custom display.]

Obtain Magnetic Variation for the cursor position.

Display a Tidal Stream vector for the cursor position.

View chart Properties including description and datum and, for vector charts, Object information and Updates.

Other Chart Commands

Duplicating a chart window

Choose Duplicate from the Chart menu to open a new chart window with the same chart settings as the currently selected window.

To GoTo any position

Choose Go To Position from the Chart menu to open the dialog shown here.

Enter a latitude and longitude and Select Go
To .... On current chart or On Best chart

Click Previous to go to the last selected position.

To select a screen symbol (Chartpoint, route waypoint, ARPA target, Target etc)

Right click the symbol. Options and information will vary depending on the type of symbol selected.

To Display the World Chart

Click on the chart toolbar.

Additional Chart Database

This option allows "client charts" in S-57 format to be displayed on Navmaster ECDIS concurrently with ENC and ARCS charts. An example of a client chart is specialised survey data, held in AutoCad format and converted to S-57 format for display on ECDIS, as shown above.
Installing and maintaining S-57 overlay charts to an Additional Database

1. Choose Additional Databases from the Chart menu and click the browse button to select the location of the charts to be imported.

2. Click the Import button. The chart will be verified and compiled.

3. Click the View log button to view the outcome of the compilation. The latest result will be shown and the foot of the log file.

4. Check Display chart data and click Apply to display the chart(s) as overlays to standard ENCs or ARCS.

5. Click Delete and answer the prompts as they appear to remove any additional chart overlays.

Manual Chart Updates

Manual updates are displayed on the chart as S-52 chart objects, with an orange line dropped down from the position of the update object to indicate that it is a manual update.

Note: manual updates can be added to RNCs using the same symbols and procedures described below. However no information is available for objects on RNCs and delete symbols are added without reference to any object on the chart.
To Add A New Manual Update

1. Choose **Manual Updates \ Add Manual Update** from the Chart menu or click on the Manual Updates toolbar.

2. Select the object to add in the category list (click the + symbol to expand each category).

   For example to add a cardinal buoy, expand **Aids to Navigation** followed by **Buoys** and select **Buoy, cardinal**.

3. Alternatively enter text in the **Search** field and click **Find**. The first appearance of the text will be selected. Click **Find** again to find the next appearance and so on.

4. Some objects can be represented by a point, line or area. If there is such a choice, select the **Object type** required.

5. Click **Next** when you have completed your selection.
6. Click any field in the Attributes property column to set attributes which will vary according to the nature of the object. Some fields offer a drop down list with appropriate attributes such as North, South, East and West for category of a cardinal mark. Other fields, such as Object name allow you to enter suitable text.

7. Click the Add Attribute button (if available) and select any additional attributes required. For example, adding a light attribute enables further details to be defined. Click Next when you have finished defining attributes.

8. Set Scale maximum and Scale minimum values if you wish to restrict the scales within which the update is drawn to avoid clutter. Scale minimum (SCAMIN) specifies the smallest display scale at which the object will be drawn. For example, an object with a SCAMIN value of 50,000, indicating a scale of 1/50,000, will not be drawn on a display of 1/60,000. Scale maximum (SCAMAX) specifies the largest display scale at which the object will be drawn. For example, an object with a SCAMIN value of 10,000, indicating a scale of 1/10,000, will not be drawn on a display of 1/8,000.
9. Now, you can set the position(s) for the update. Click **Edit** and either
   a. Click on the chart where you want the update placed. A
      hatched circle is placed at the chosen position. At this point,
      the circle can be moved by clicking and dragging, OR
   b. Click the **Add Position** button / add position to list and enter
      the latitude and longitude of the object.

   (It may be quicker to enter the position on the chart first and then fine
   tune it in the position list.)

   Click **Next** when finished.

10. Enter final details and click **Save** when finished.
To Delete a SENC object

1. Ensure that you have an ENC or CM-93/3 chart open.

2. Choose Manual Updates \ Delete object from the Chart menu or click on the chart toolbar.

3. Click Select Point in the dialog that appears and then click the object on the chart that you wish to delete. This will populate the dialog with all the SENC objects found for the selected point.

4. Select the point you wish to delete (eg Buoy, safe water as shown above and click Delete Object. The object is marked with an orange diagonal line as shown here (it is not physically removed from the SENC).

5. You can repeat the process for another SENC object or click Close if you have finished.

If you wish to restore a deleted SENC object follow the procedure described in the section headed Review Manual Updates below.

To apply a Delete symbol to a RNC

1. Choose Delete object from the Chart menu or click on the chart toolbar.

2. Click Select Point in the dialog that appears and then click the position on the chart where you want the delete symbol to appear.
3. A delete symbol will be laid at the chosen position. Click in the latitude \ longitude field to edit the position.

4. You can repeat the process for another object or click Close if you have finished.

If you wish to restore a deleted object follow the procedure described in the section headed Review Manual Updates below.

**To Review Manual Updates**
1. Choose **View All Manual Updates** from the Chart menu or click on the chart toolbar.

2. Expand the history tree on the left to see the record for each correction with creation / modified / deleted date as appropriate together with the name of the person who made the change if entered.

3. Click the button to the left of *History List* to view updates that have expired (i.e., that were deleted more than 90 days ago).

4. Select any update and click \[\] to centre it on the chart.

5. Select any update and click \[\] to toggle on / off the update’s highlight.

6. Select any update and click \[\] to delete the update (note that to restore a deleted SENC object you delete the manual update that placed the delete symbol over it).

**To Edit a Manual Update**

1. Choose **View All Manual Updates** from the Chart menu or click on the chart toolbar.

2. Select the update you wish to edit and click **Edit**.

3. Follow the **Manual Update edit Steps** listed above.

**The Chart Information Panel**

**General**

The information displayed here varies depending on the type of chart.

<table>
<thead>
<tr>
<th><strong>ARCS or Seafarer</strong></th>
<th><strong>ENC, CM-ENC or CM93/3</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart number</strong></td>
<td><strong>Chart number</strong></td>
</tr>
<tr>
<td>The chart number.</td>
<td>The chart number.</td>
</tr>
<tr>
<td><strong>Manufacturer</strong></td>
<td><strong>Manufacturer</strong></td>
</tr>
<tr>
<td>The manufacturer of the chart</td>
<td>The manufacturer of the chart</td>
</tr>
<tr>
<td><strong>Edition date</strong></td>
<td><strong>Issue date</strong></td>
</tr>
<tr>
<td>The date the chart was first issued.</td>
<td>The date the chart was issued</td>
</tr>
<tr>
<td><strong>NtoM</strong></td>
<td><strong>Update date</strong></td>
</tr>
<tr>
<td>The last Notices to</td>
<td>The date the chart was</td>
</tr>
<tr>
<td></td>
<td>updated</td>
</tr>
<tr>
<td><strong>ARCS or Seafarer</strong></td>
<td><strong>ENC, CM-ENC or CM93/3</strong></td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Mariners number applied.</td>
<td>last updated</td>
</tr>
<tr>
<td>Heights in</td>
<td>Edition No</td>
</tr>
<tr>
<td>Depths in</td>
<td>Update No</td>
</tr>
<tr>
<td>Projection</td>
<td>Data quality</td>
</tr>
<tr>
<td>Horiz datum</td>
<td>Safety depth</td>
</tr>
<tr>
<td>Depth Datum</td>
<td>Safety contour</td>
</tr>
<tr>
<td>Height Datum</td>
<td>Visible safety contour</td>
</tr>
<tr>
<td>Buoyage</td>
<td>Heights in</td>
</tr>
<tr>
<td>Original Scale</td>
<td>Depths in</td>
</tr>
<tr>
<td>Current Scale</td>
<td>Projection</td>
</tr>
<tr>
<td><strong>ARCS or Seafarer</strong></td>
<td><strong>ENC, CM-ENC or CM93/3</strong></td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td><strong>N/S range</strong></td>
<td><strong>Horiz datum</strong></td>
</tr>
<tr>
<td>The vertical distance of the chart in nautical miles.</td>
<td>The geodetic datum of the chart, normally WGS84</td>
</tr>
<tr>
<td><strong>Display Resolution</strong></td>
<td><strong>Sounding datum</strong></td>
</tr>
<tr>
<td>The number of metres represented by each pixel on the computer display, which will alter depending on the zoom level of the chart.</td>
<td>The datum to which depths are referred.</td>
</tr>
<tr>
<td><strong>Vertical datum</strong></td>
<td></td>
</tr>
<tr>
<td>The datum to which depths are referred.</td>
<td></td>
</tr>
<tr>
<td><strong>Buoyage</strong></td>
<td></td>
</tr>
<tr>
<td>The buoyage system in use on the chart.</td>
<td></td>
</tr>
<tr>
<td><strong>Original Scale</strong></td>
<td></td>
</tr>
<tr>
<td>The scale of the chart as supplied by the manufacturer.</td>
<td></td>
</tr>
<tr>
<td><strong>Current Scale</strong></td>
<td></td>
</tr>
<tr>
<td>The scale of the chart as currently displayed by Navmaster.</td>
<td></td>
</tr>
<tr>
<td><strong>Display Resolution</strong></td>
<td></td>
</tr>
<tr>
<td>The number of metres represented by each pixel on the computer display, which will alter depending on the zoom level of the chart.</td>
<td></td>
</tr>
<tr>
<td><strong>Intended usage</strong></td>
<td></td>
</tr>
<tr>
<td>The category of use for which the chart is intended</td>
<td></td>
</tr>
<tr>
<td><strong>Magnetic variation</strong></td>
<td></td>
</tr>
<tr>
<td>The value of the magnetic variation taken from the chart</td>
<td></td>
</tr>
</tbody>
</table>
ARCS - Cautions \ T&P NTMs \ Notes

Cautions repeat any special notes for the chart on view.

T&P NTMs provides access to text files containing Temporary and Permanent Notices to Mariners. Select any item and click View or double click on the item to see it. Click View or double click on the item again to close the window.

Notes provides a link to the relevant part of the ARCS chart on view. Select any item and click GoTo to view it. Click Back to return to where you were on the chart.

ENCs or CM-93/3 Notes

Picture or text files pertaining to the chart in view are available in this tab. Select any item and click View or double click on the item to see it. Click View or double click on the item again to close the window.

Categories removed from Standard Display

Click the Features tab to see a list of any categories, normally a part of the Standard Display, which are not currently displayed. This occurs if you have selected the Base display or a Custom display.
Chart Information on the Title Bar

The title bar permanently displays the following information relating to the chart on display:

- Chart type
- Chart number
- Horizontal datum
- Units of depth
- Original scale
- Actual scale
- Description

Display mode (ENC & CM93/3 only)

The description may be cut short for lack of space, but the full description will be given in the Chart Information panel. *Note that no descriptions are provided for ENC \ CM-93/3 charts.*

Chart Notes and Diagrams (ARCS)

Display the Information side panel and choose the Notes tab.

Select the item of interest, and click GoTo to display it. Click Back to return.

Temporary and Preliminary Notices to Mariners (ARCS)

Display the Information side panel and choose the T&P NtoM tab.

Choose the notice of interest and double click or click View to display it. Click the close button on the window to close it.

The Blank Chart

The Blank Chart is, as the name suggests, a geographically referenced window for:

- Planning and plotting in areas where you do not have chart coverage or if you have temporarily lost access to your charts.
- Position plotting in a very small geographical area.

All Chartpoints, routes and positions are plotted on the Blank Chart. The chart can be scaled from a world size to a very small area. Most of the
standard chart buttons work in the Blank Chart. When operating in the Blank Chart it may be helpful to turn on the latitude and longitude graticule by choosing Options | Overlays from the Chart menu and clicking the Graticule check box.
A “Chartpoint” is the latitude and longitude of a geographical position stored in a database.

You can use Chartpoints to define waypoints, or for other points of interest such as anchorages, wreck positions, events or significant landmarks.

For each Chartpoint, you have optional database fields to enable you to add information. You can create any number of Chartpoint databases and each database can contain any number of Chartpoints.

To enter Chartpoint mode click on the display toolbar. The Chartpoint side panel will be displayed. If it is turned off, click on the display toolbar.

The Chartpoints in the current database are displayed by a symbol. The selected Chartpoint is highlighted thus

For information on starting a new Chartpoint database and saving your work see managing databases.

Tip: when position monitoring, switch to a different chart window or disengage position monitoring.

Creating and Editing Chartpoints

To create a new Chartpoint

1. Open an existing Chartpoint database or create a new one.

2. Select the Chartpoint side panel and click Edit.
ON THE CHART

3. Move the cursor to the required position, right click and click **Add new Chartpoint** on the menu. The latitude and longitude is automatically stored, adjusted for WGS84.

IN THE SIDE PANEL

4. Click in the latitude / longitude field and use the mouse or the left / right arrow keys to move to the value you wish to change. Then type the required entry or use the spin buttons or up / down arrow keys to change the values.

   *A Chartpoint symbol will be displayed on the chart (if the position is in view). The latitude and longitude are stored in WGS84 co-ordinates. If you wish to enter the position in the chart’s local datum, see the Entering Chartpoints in the Local Chart Datum below.*

5. Complete the **Name** and **Area**, **Type**, and **ID** fields, enter any text you want in the **Memo** field if required and click **Apply**.

   *Note that if you move to another side panel without clicking **Apply**, entries to these fields will not be saved.*

Selecting a Chartpoint

Click any Chartpoint symbol on a chart, use the scroll buttons on the Chartpoint toolbar to move between Chartpoints or click the **button on the Chartpoint toolbar to select a Chartpoint from a list (if the Chartpoints are unnamed the list will show blanks).**

If the Chartpoint toolbar is not displayed, you can select the first, previous, next or last Chartpoint by choosing **Selection** from the **Chartpoint** menu.

GoTo Chartpoint

GoTo Chartpoint opens the best available chart centred on the selected Chartpoint. It is useful for reviewing Chartpoints and navigating around charts. For example, when planning a route you may place Chartpoints a great distance apart. You could change the chart view manually to view each Chartpoint, but this would take time. Instead select each Chartpoint and click **GoTo Chartpoint**.

To use GoTo Chartpoint:
1. Select a Chartpoint.

2. Click **GoTo Chartpoint** on the Chartpoint toolbar.

**To Move A Chartpoint**

1. Click the **Edit** button on the Chartpoint panel.

2. Select the Chartpoint you wish to move and drag it to its new position.

**To Delete A Chartpoint**

1. Click the **Edit** button on the Chartpoint panel.

2. Select a Chartpoint and press the **Del** button on the keyboard or click Delete on the Chartpoint panel.

**To Sort Chartpoints**

To sort the current Chartpoint database in a different order, choose **Sort by** from the Chartpoint menu or Chartpoint Toolbar and select a field.

**The Chartpoint Panel**

Toggle this panel on or off by clicking on the display toolbar. Whilst the panel is hidden you can create new Chartpoints, by choosing **Edit** from the Chartpoint menu, but cannot edit fields associated with them.

**Chartpoint Panel Buttons**

<table>
<thead>
<tr>
<th><strong>Datum</strong></th>
<th>Provides the option to view and edit the Chartpoint co-ordinates in local chart datum co-ordinates. This option is “greyed out” if the Chartpoint is not on the currently selected chart.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong></td>
<td>Click to enable / disable Chartpoint editing. All fields and buttons are “greyed out” whilst edit is disabled.</td>
</tr>
<tr>
<td><strong>Apply</strong></td>
<td>Click to save changes made in the Chartpoint fields.</td>
</tr>
<tr>
<td><strong>New</strong></td>
<td>Click to clear the panel, ready for the keyboard entry of a new Chartpoint.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click to delete the current Chartpoint.</td>
</tr>
<tr>
<td><strong>Nav</strong></td>
<td>Click to download the current GPS position as a Chartpoint.</td>
</tr>
</tbody>
</table>
CPT list | Click to open a list view of the Chartpoints in the database. As you move the cursor in this window, the list view is synchronised to the Chartpoint panel to show the details of each Chartpoint. The button changes to CloseDB when the list window is open. Click to close the list view or use the standard window buttons.

**Attachments**

Attachments refer to images that can be attached to a Chartpoint. You can add up to three images to each Chartpoint.

**To attach an attachment**

1. Click Attach
2. Navmaster opens a list box showing the files of type bmp, jpg, tga, tif and pcx located in the Attachment folder.
3. Select a file and click Attach.

**To view attachments**

1. Select an attachment from the combo box.
2. Click View.

Buttons are provided on the Chartpoint Toolbar, with images indicating a picture. Click this button to view or close the attachment.

**To detach attachments**

1. Select the attachment to delete from the combo box.
2. Click Detach.

**Chartpoint Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>An alphanumeric identifier.</td>
</tr>
<tr>
<td>Latitude</td>
<td>Degrees, Minutes and Decimal Minutes to a maximum of four decimal places.</td>
</tr>
<tr>
<td>Longitude</td>
<td>Degrees, Minutes and Decimal Minutes to a maximum of four decimal places.</td>
</tr>
<tr>
<td>Datum</td>
<td>The geodetic datum of the position. This field cannot be</td>
</tr>
</tbody>
</table>
edited. For more information on geodetic datums, see below and Appendix B - Geodetic Datums.

<table>
<thead>
<tr>
<th>Zone Time</th>
<th>You can enter a suitable value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>To indicate the type of Chartpoint such as a wreck or waypoint.</td>
</tr>
<tr>
<td>Area</td>
<td>To allow sorting by area - e.g. West Channel, North Sea, Caribbean etc.</td>
</tr>
<tr>
<td>Name</td>
<td>Maximum of 25 characters.</td>
</tr>
<tr>
<td>Memo</td>
<td>Up to several pages of text</td>
</tr>
<tr>
<td>Attachments</td>
<td>Up to four attachments.</td>
</tr>
</tbody>
</table>

**Chartpoint Options**

<table>
<thead>
<tr>
<th>Overlays</th>
<th>Turns on or off the display of Chartpoint symbols.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Turns on or off Chartpoint ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Turns on or off Chartpoint name.</td>
</tr>
</tbody>
</table>

**Chartpoint Setup**

Log into **Setup Mode** and choose **Setup** from the Chartpoint menu to set the following options

**Auto save database every...**

Tick this box and set a time to autosave the current open Chartpoint database.
To change the Chartpoint folder location

1. Click the Database folder browse button to change the location of Chartpoint databases.

2. Click the Attachments folder browse button to change the location of attachment files.

Entering Chartpoints in the Local Chart Datum (ARCS charts only)

Navmaster stores Chartpoints in WGS84 co-ordinates where possible. If the Chartpoint is on the selected chart, this option enables you to edit the Chartpoint to match the local chart datum. Viewing the Chartpoint’s co-ordinates in the local chart’s datum does not move it. This enables you to read a position from a paper chart and input it directly as follows.

*Note that this option is greyed out if the datum of the chart on view is WGS84 or its equivalent (eg ETRS89).*

**TO EDIT LATITUDE AND LONGITUDE TO THE CHART’S DATUM:**

1. Select the Chartpoint you wish to edit.

2. Select the largest scale chart you have for the Chartpoint

3. Click the Edit button on the Chartpoint panel.

4. Click the Datum drop down arrow and select the chart’s datum.

5. Enter the required co-ordinates in the latitude / longitude field.

6. Click the Apply button.

Preparing to upload Chartpoints to GPS

Some makes of GPS have limitations to the way they receive Chartpoints/routes. For instance, some models cannot accept lower case letters, or spaces, and the GPS will reject the uploaded positions. Before
you store large numbers of Chartpoints, we suggest you establish what your GPS is capable of receiving.

The Application of Datum Shifts to Chartpoints (ARCS charts only)

As ENCs are required to be in WGS84 datum, this section applies only to ARCS charts.

Navmaster’s Chartpoint datum management involves minimum user input. The objective is to store positions in WGS84 co-ordinates so that, if possible, Chartpoints are converted to the local chart datum of any chart.

Ideally you should avoid creating Chartpoints on charts whose datum is unknown. For example, in the region of Jamaica, you have a choice of charts to work with: including Chart 255 on the North American Datum 1927 with a supplied shift to WGS84 or chart 486 with an undetermined datum. If you create a Chartpoint on chart 255, then Navmaster can add the shift and store the position in WGS84 co-ordinates. If you create the Chartpoint on chart 486 there is no shift available and Navmaster has to store the position in “unknown” co-ordinates. Consequently Navmaster is unable to apply datum shifts when you display the Chartpoint on other charts. In this instance a Chartpoint created on Plumb Point lighthouse on chart 486 is almost three quarters of a mile from the Chartpoint created on the same point on chart 255 so the need for care is obvious.

The following is a summary of the different circumstances that might arise and how Navmaster deals with them:

**Chartpoints created on a chart**

**Datum of chart - WGS84**

<table>
<thead>
<tr>
<th>Shift available</th>
<th>Shift added</th>
<th>Chartpoint stored in (datum)</th>
</tr>
</thead>
<tbody>
<tr>
<td>None required</td>
<td>No</td>
<td>WGS84</td>
</tr>
</tbody>
</table>

The Chartpoint can be correctly referenced to any chart with a supplied datum shift from WGS84. If the Chartpoint is viewed on a chart of undetermined datum the following warning is given:

< One or more screen objects cannot be accurately referenced to this chart. >
Datum of chart - Any other datum

<table>
<thead>
<tr>
<th>Shift available</th>
<th>Shift added</th>
<th>Chart stored in (Datum)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>WGS84</td>
</tr>
</tbody>
</table>

The Chartpoint can be correctly referenced to any chart with a supplied datum shift from WGS84. If the Chartpoint is viewed on a chart of undetermined datum the following warning is given:

< One or more screen objects cannot be accurately referenced to this chart. >

Datum of chart - Undetermined

<table>
<thead>
<tr>
<th>Shift available</th>
<th>Shift added</th>
<th>Chart stored in (Datum)</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>No</td>
<td>Unknown</td>
</tr>
</tbody>
</table>

The Chartpoint cannot be accurately referenced to any chart other than the one it was created on. It was created on a chart with an unknown datum and therefore no datum shift can be applied to it when it is displayed on a chart with a known datum and supplied shift to WGS84. If the object appears on a chart with a supplied datum shift the following message is given:

< One or more screen objects cannot be accurately referenced to this chart. >

If the object appears on a chart with an undetermined datum the following message is given:

< One or more screen objects cannot be accurately referenced to this chart. >

Chartpoints created by typing in co-ordinates in the Chartpoint panel

All co-ordinates typed in to the Chartpoint panel are assumed to be WGS84 and are stored accordingly.
A route can be built from Chartpoints or by drawing on a chart.

To enter Route mode click on the display toolbar. The route side panel will be displayed. If it is turned off, click on the display toolbar.

In accordance with ECDIS regulations, the following symbols are used in respect of routes.

<table>
<thead>
<tr>
<th>Monitored Route</th>
<th>Dashed bold line, waypoints (WPT) as circles.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned or Alternate Route</td>
<td>Dotted line, WPT as circles.</td>
</tr>
</tbody>
</table>

The next waypoint on the monitored route is shown by a symbol.

The selected route waypoint is highlighted thus.

For information on starting a new Route database and saving your work see Managing databases.

**To Create A Route**

You can create a route by:

- **Drawing on the chart** - the waypoints created by this method are numbered and can be named.

- **Selecting Chartpoints** - the Chartpoints you select are copied to the route waypoint list; if you subsequently move the route waypoint, no changes are made to the Chartpoint database and, equally, if you edit the original Chartpoint, the changes are not carried through to the route.

- **Using the keyboard** – to enter waypoints in the route sidepanel.

You can mix these methods to create your route.
To create a new route

1. Open an existing route database or create a new one.

2. Click the **Edit** button on the Route side panel.

3. Click the **New** button.

4. Complete the **Name** and **From** and **To** fields, enter any text you want in the **Memo** field and click **Apply**.
   
   *Note that if you move to another side panel without clicking **Apply**, entries to these fields will not be saved.*

5. Select the **Waypoint** tab
   
   … **BY DRAWING ON THE CHART**

6. Move the cursor to the required position on the chart and right click.

7. Click **Add New Waypoint** and repeat until the route is complete.
   
   *When you create or move a route waypoint, its lat/long co-ordinates are automatically saved.*

8. To name the waypoint, select it in the Waypoints tab, click the name field in the waypoint list and type the name.

9. To add a note, scroll to the right, click the note field and type the text you wish to add (limited to 255 characters). If a Chartpoint, with memo information already attached, was used to create the waypoint, its memo information will be carried over to the route waypoint. Memos are included in appropriate passage plan reports.
… **BY SELECTING CHARTPOINTS**

10. Ensure that the Chartpoint database you wish to use is open.

11. Double click on a Chartpoint on a chart

**OR**

12. Click **CPT List** to open the Chartpoint list, double click a Chartpoint or press <ENTER> and repeat until you have finished. Click **CPT List** again to close the Chartpoint list.

… **VIA THE KEYBOARD**

13. Click the button to enter a new waypoint or the key to delete a waypoint.

14. Use the <TAB> key to place the cursor in the waypoint list and then to place the cursor in the field you wish to edit. Use <SHFT> + <TAB> to move back a field.

15. Use the right \ left arrow keys to move between the latitude \ longitude fields and the up \ down arrow keys or number keys to change the values.

### Setting Route Parameters

Click at the foot of the Route side panel to open a dialog that enables you to enter, per leg:

- Off track limit to port and to starboard in nautical miles

  The default values for new legs are applied from the values set under **Route \ Setup \ Default – Off track limit**. They are drawn against the route if **Route \ Options \ Limits of deviation** is ticked. Off track limits define the area used to check the route for chart-based warnings.

- Planned speed

  The default value for new legs is applied from the **Speed** entered in under **Route \ Setup \ Default – Speed**.
• Turn radius in nautical miles

The default value is applied from Route \ Options \ Overlays \ Turning Circles - Default radius. If, in the same dialog, Turning circles is ticked, Estimated rate of turn is calculated when you enter a speed and \ or turn radius for each leg and the corresponding curved track is shown against each waypoint.

Some fields are display only. These are:

No, Name, Latitude, Longitude, distance, course, leg type and rate of turn. (Name and Leg type can be changed from the Route side panel waypoint list.)

The remaining fields: Planned Speed, OTL (port), OTL (Stbd) and Turn radius can be changed, individually or by column.

To change an individual cell:
1. Move the cursor to the required cell and double click.
2. Enter an appropriate value.
3. Click on another cell to save the entry

To change all the values for a column:
4. Use the cursor to select a cell you wish to standardise on.
5. Move the cursor to the label at the top of the column, eg Planned speed, right click and select Standardise.
6. All values for the column will be set to the value selected.

To set all the values for a column to default values:
1. Right click on the column label you wish to set to default.

2. Select Reset. Speed will be set to the value you have entered in the Route side panel, Plan tab. OTL values will be set to the Limit of Deviation value you have entered in Route \ Options \ Monitoring. Radius and Rate of Turn will be set to the values entered in Route \ Options \ Overlays.

Editing A Route

To select a route to edit

Open a route database and either:

1. Select a route from the Route Toolbar. Use the scroll buttons on the route toolbar to move between routes or click the button to select a route from the drop down list (if routes are unnamed the list will show blanks), or

2. Select an alternate route from the Route Management side panel. (Choose Route Management panel from the View menu or click the from the display toolbar), or

3. Select the first, previous, next or last route by choosing Selection from the Route menu, or

4. Click the right / left buttons alongside the route name in the Route side panel.

   Note that this toolbar does not select the Active route

To add or insert a route waypoint

1. Select the Route side panel and click the Edit button.

2. Select the waypoint list position where you wish to add / insert a waypoint by one of the following methods:

   o Click on the waypoint number in the Waypoint list.
Click any route waypoint symbol.

Click the route waypoint scroll buttons on the route toolbar.

Click a waypoint in the drop down list on the route toolbar.

3. On the chart, move the cursor to the position of the new waypoint and right-click. Choose **Insert New Waypoint** to insert the waypoint before the selected waypoint or **Add New Waypoint** to add the waypoint after the selected waypoint.

4. In the Chartpoint list, select the waypoint before the insertion point, click **CPT List** and select the Chartpoint you wish to add. Double click on the Chartpoint or press the <ENTER> key. Click **CPT List** again to close the Chartpoint list.

5. In the Chartpoint list, select the waypoint before the insertion point, click the button, Select the new waypoint and then tab to move between the latitude and longitude and other fields. Use the right \ left arrow keys to move between the latitude \ longitude values and the up \ down arrow keys or number keys to change the values.

**To add or insert a waypoint from GPS**

Click the **Nav** button to download the current position from your GPS as a waypoint in your route. A popular use of this function is to get the first waypoint in a route. If you are inserting your current position into an existing route, select the waypoint before the insertion point, before clicking the **Nav** button.

**To Move a Waypoint to a different location in the list**

Click the **Waypoints** tab and select the waypoint to move. Click the Up / Down arrows to the right of **List Order** to move the waypoint to the required location in the list.
To Move a Waypoint

Select and drag the waypoint to its new location.

To Delete a Waypoint

Select a waypoint and press the Del button on the Waypoint List tab of the side panel or press the DEL key or right-click on the chart and select Delete Selected Waypoint. Note that the Del key at the bottom of the side panel deletes the entire route.

To Set Leg Type (Rhumb or Great Circle)

1. By default, the route line is set to Rhumb. To change the leg type:

2. Select the waypoint at the beginning of the leg you wish to change.

3. Click the down arrow to select the method you wish to apply.
   
   **Rhumb** will draw a straight-line track for the leg. Rh will be displayed under leg type.
   
   **GC** will draw a curved-line track for the leg with its initial bearing and distance in the route waypoint list. GC will be displayed under leg type.
   
   **GC wpts** will break the curved-track into segments based on the parameters set under Route | Options | Great Circle. A number of rhumb line legs will be created named GC x.1, GC x.2 etc, where x is the number of the first waypoint in the leg.

   This is shown here, where the original leg from Lizard to Newport has been broken down into rhumb line legs.

Reviewing A Route

To open the best available chart centred on the selected waypoint:

1. Select a waypoint.
2. Click **GoTo Route Waypoint** on the route toolbar.

Alternatively, click along the route line to centre the chart and review the route.

**Route Functions**

The following are available at the foot of the Route Side Panel:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Clears the panel for the entry of a new route.</td>
</tr>
<tr>
<td>Del</td>
<td>Deletes the current route from the database.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the current route to a new route with the same waypoints. (CPY) is added to the name, which you can change if you wish.</td>
</tr>
<tr>
<td>Reverse</td>
<td>Creates a new route with the same waypoints in reverse order. (REV) is added to the name, which you can change if you wish.</td>
</tr>
<tr>
<td>Edit</td>
<td>Enables / disables route editing. All fields and buttons are “greyed out” whilst edit is disabled.</td>
</tr>
<tr>
<td>Apply</td>
<td>Saves changes made in the route fields.</td>
</tr>
</tbody>
</table>

Opens the horizontal panel that enables you to enter planned speed, off track limits and turn radius per leg and view courses, distances and estimated rate of turn.

**Route Side Panel Tabs**

*The General Tab*

The General Tab provides the following options

**MEMO FIELD**

This field is to enable you to enter information related to the route that you wish to record and optionally printed in the passage plan report. Click **Apply** when you have finished.

**ATTACHMENTS**

Up to three images can be attached to a route. Any images you wish to attach must be located in the C:\Program Files\Navmaster\Attach folder.
To attach an image

1. Click Attach

2. Navmaster opens a list box showing the files of type bmp, jpg, tga, tif and pcx located in the Attachment folder.

3. Select a file and click Attach.

To view images

1. Select an attachment from the combo box.

2. Click View.

When an image is attached, a camera buttons lights up on the Route Toolbar. Click to view or close the attachment.

To detach images

1. Select the attachment to delete from the combo box.

2. Click Detach.

Waypoint Tab

The Waypoint Tab provides the following options

**DEL**

Deletes the currently selected waypoint.

**NAV**

Downloads current position into the waypoint list

**CPT LIST**

Opens a list view of the Chartpoints in the current database. This enables you to select Chartpoints for your route. Click this button again to close the window or use the standard windows buttons.

**THE ROUTE WAYPOINT LIST**
The Route Waypoint list contains the following information:

<table>
<thead>
<tr>
<th>No</th>
<th>Name</th>
<th>Leg Type</th>
<th>Distance</th>
<th>Course</th>
<th>Lat</th>
<th>Long</th>
<th>Datum</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 .. n</td>
<td>25 char</td>
<td>GC</td>
<td>nnnnn.nn</td>
<td>Nnn.n°T</td>
<td>WGS84</td>
<td>Rh</td>
<td>Unknown</td>
<td></td>
</tr>
</tbody>
</table>

Use the scroll bar to see the columns that are out of view. Latitude and Longitude are shown with the number of decimal places specified under Tools | Options | Workspace.

**The Plan Tab**

The Plan tab is described on page 174 below.

**The Warnings Tab**

This tab displays warnings generated by ENC, CM93/3 vector charts and [Mariner Overlays](#).

Warnings are generated for any relevant object within the off track limits of each leg and are listed in leg order. The same warning may occur in more than one leg if the warning area is large, such as for a fairway.

**To review Warnings:**
1. Select the tab for the type of warning you wish to view: ENC, CM93/3 or Mariner Overlay.

2. Click **Display Warnings** to list the warnings for the route.

3. Click the + box alongside each leg to view the warnings applicable to that leg.

4. Select a warning; it will be highlighted on the chart in red, surrounded by a bounding rectangle. If the warning is not visible double click or click the **Go to** button to view it. (**Go to** is only available in a deactivated Position Monitoring window).

5. Click the + box alongside the warning to view the detail of the warning and move the slider to the right to see more information and to open any text or image file.

6. Click **Clear Highlight** to remove the highlight from the chart.

**Note:** The warnings displayed here are for the alternate route. To see, or display the list of warnings for the monitored route select the Route Warnings tab on the Position Monitoring side panel.

The example below shows a fairway highlighted on an ENC chart.

**The Charts Tab**

This tab displays the installed charts covered by the route, divided by chart type.

Click Refresh to display the list.

**Route Warnings**

Route warnings occur for various reasons including when a route crosses prohibited areas, caution notes, the safety contour or a mariner overlay.
Note: Navmaster searches the area within the off track limits of each leg for objects that should generate a warning. See route parameters for further information on setting off track limits.

They are recalculated whenever a route is changed, a new route is selected or the safety contour value is changed.

The source of each warning is given in the Route Warnings tab in the Route side panel as described above.

See Appendix B, Alarms and Indications for information on alarms and warnings.

**Using Critical Points in Route Planning**

A *Critical Point* is used to define a position on a route to draw attention to an action required on a leg, eg “Call Master”

*Critical Points* must be inside the off track limits of the route leg. Alarms are triggered for the current route leg, which is automatically selected if the route is locked; if the route is not locked you can select the current leg manually from the Monitor side panel. Two alarms are triggered:

1. On approach, when the farthest extent of the vessel’s guard zone reaches the *Critical Point* or a line perpendicular to the route leg extending 10 nm either side of the *Critical Point*.

2. On arrival, when a perpendicular from the first point of the vessel’s outline reaches the *Critical Point*.

If you change the deviation limits for any leg, warnings are recalculated.

*Critical Points* are stored as part of a Mariner Overlay.
To define a *Critical Point*:

1. Create a [Mariner Overlay](#).
2. Click the Edit Overlay button and select the Point object from the [Mariner Overlay toolbar](#).
3. From the [Point Properties](#) dialog, select *Critical Point* from the Point Type drop down list.
4. Left click on the chart where you want the *Critical Point* to be placed.
5. Enter any text in the Point Properties text box and tick [Display Text](#) if you want the text to be shown against the *Critical Point* on the chart. Click OK when you have finished.
6. Click the Edit Overlay button on the Mariner Overlay toolbar to exit Edit mode.

**Route Transfer to Backup ECDIS**

Where dual Navmaster ECDIS systems are correctly configured (see ECDIS Backup configuration on page 19) you have the option to transfer the currently open route database from one Navmaster ECDIS to the other.

To identify the status of each Navmaster ECDIS, choose [About Navmaster](#) from the [Help](#) menu. The version field will state *primary* or *secondary* as appropriate. If neither word is present Navmaster has not been configured to operate as a dual system.

To transfer a route database:

1. Complete your work on the route database and de-select the [Edit](#) button
2. Click the [Transfer DB](#) button. (while Edit is selected or if there is no connection between the ECDIS’, the Transfer DB will be greyed out).

The following will be recorded in System Messages:
On the sending ECDIS – *Route database transferred – filename.dbf*
On the receiving ECDIS - *Route database received – filename.dbf*

If the transferred route database is open, it is closed down on the receiving system before the transfer takes place. You must then reload it and select the required route.

*Important*

This operation transfers the entire route database to the other ECDIS. Therefore it is important to ensure that the transferred database will not overwrite routes unintentionally and to minimise the risk of loss by backing up your data (see Backing up Chartpoint, Route and Log databases on page 60).

**Saving Your Work**

Choose **Save** or **Save as** from the **File** menu, select the **Route** button and enter a filename if necessary. Please ensure that you save your work regularly.

**Route Locking**

If you cannot start a new Route Database or open an existing Route Database because the route is locked:

1. Uncheck **Lock** on the Position Monitoring side panel
   
   Or

2. Choose **Options** from the **Route** menu, select the **Monitoring** tab and uncheck **Automatic Leg Advance**.

**Multiple Route Display**
The ECDIS performance standard requires that it shall be possible to plan an alternate route in addition to the active route and during the voyage, to modify the active route or select an alternate route.

Select the **Route Management** side panel by clicking the display toolbar.

This panel allows you to select the **Active** and **Alternate** routes from drop down lists and to select additional routes for display.

**To select the Active route**

You can also select the Active route in the Position Monitoring side panel. In this side panel, to select an Active route, click the drop down arrow alongside **Active**. To clear the active route, click the drop down arrow and select **Reset** from the top of the list.

*Note: this section is greyed out if the route is locked on the Position Monitoring side panel.*

**To select the Alternate route**

Click the drop down arrow alongside **Alternate** to select a route to edit. If you wish to clear the editable route, click the drop down arrow and select **Reset** from the top of the list.

**To Display Additional Routes**

Tick the box to the left of the route name under **Multiple Display**. Clear the tick box to remove the route from display.

The following image shows Navmaster displaying an active route (red) and alternate route (orange).
Route Symbology

Monitored Route Symbology is shown to the right. When position monitoring, the next waypoint is shown as per the left hand waypoint.

Alternate Route Symbology is shown to the right. The left symbol indicates the currently selected waypoint.

Route Options

Choose Options from the Route menu.

To turn off Active / Alternate route display clear the Display tick box.

Overlays

The Overlays tab is further divided into General display items, items related to Route monitoring and items related to the display of Turning Circles.

GENERAL OVERLAYS
Click the down arrow and select Active or Alternate to set the following.

<table>
<thead>
<tr>
<th><strong>Direction arrow</strong></th>
<th>Displays a direction arrow alongside each leg.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Course</strong></td>
<td>Displays planned course alongside each leg</td>
</tr>
<tr>
<td><strong>Planned speed</strong></td>
<td>Displays planned speed alongside each leg</td>
</tr>
<tr>
<td><strong>Distance to run ticks</strong></td>
<td>Displays ticks for the entire route or current leg at the interval selected.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Entire route</strong> or <strong>Current leg</strong> depending on your preference.</td>
</tr>
<tr>
<td></td>
<td>Use the spin buttons to change the time tick interval.</td>
</tr>
<tr>
<td><strong>Waypoint number</strong></td>
<td>Turns on or off the route waypoint number.</td>
</tr>
<tr>
<td><strong>Waypoint name</strong></td>
<td>Turns on or off the route waypoint name.</td>
</tr>
<tr>
<td><strong>Plan ETA</strong></td>
<td>Displays Plan ETA at each waypoint if a plan has been calculated.</td>
</tr>
</tbody>
</table>

**TURNING CIRCLES**
The Turning Circles tab sets whether turning circles are drawn based on a turn radius and rate of turn for each waypoint along the planned route.

If **Turning Circles** is ticked, this calculation is applied to your Active or Alternate route(s) based on the values set in the Route parameters horizontal panel.

Use the spin buttons to enter a default **Radius** value.

If **Display Wheel over symbol** is ticked, a symbol is applied at the starting point of the turn.

Tick **Advance warning alarm** to generate an alarm at the desired number of minutes ahead of the wheel over point.

These values can be set for each leg of the route. See the section Setting Route Parameters on page 152 above.

**HOW RATE OF TURN IS CALCULATED**

Rate of turn \( (\omega) \) is the turn radius \( (R) \) divided by the vessel's speed \( (V) \):

\[
\omega = \frac{V}{R}.
\]

And in degrees per minute \( \omega = \frac{180V}{60\pi} / R = 3V/\pi R \)

**MONITORING OVERLAYS**

Tick any combination of the Arrival Circle, Perpendiculars and Limits of deviation boxes to display an overlay on both **Active** and **Alternate** routes.
Route Monitoring

**ARRIVAL CIRCLE ENTRY**

Tick this box to change to the next leg when the vessel enters the circle of radius set under Route \ Options \ Overlays \ Monitoring described above. The position and time of entry, and the waypoint name are recorded in the log.

**PASSING PERPENDICULAR**

If ticked, this option sets **Automatic Leg Advance** to trigger when you pass a perpendicular to the waypoint. The position and time of entry, and the waypoint name are recorded in the log.

**AUTOMATIC LEG ADVANCE**

Tick this option and route legs will automatically increment as you pass through the active Waypoint Detection parameters. You can also set or unset Automatic leg advance by clicking the **Lock** check box on the Position Monitoring side panel. Note that whilst **Automatic leg advance** is active, the route and route leg is locked. *(Note: if the correct leg is not selected it may be because lock was checked before or during a period when position input became active. In this event uncheck and recheck the lock box and the correct leg will be selected).*

**NOTIFY ON ARRIVAL**
Check this box for a message to be displayed on arrival at waypoints.

**LIMIT OF DEVIATION**

Tick the Limit of Deviation from Planned Route box to generate an alarm if the vessel exceeds the limits set for the current leg. A warning message is displayed until the vessel returns inside the limit. When the vessel exceeds the limit a log entry is made, with time and position and again when the vessel returns inside the limit. Note that variable off track limits to port or starboard can be set for each leg of the route. See the section Setting Route Parameters on page 152 above.

**Great Circle Options**

**GREAT CIRCLE INTERCEPT**

This option enables you to set the interval (in degrees of longitude) at which the Great Circle leg will be divided into segments, by clicking the spin buttons alongside the option. By default the intercept is set to 5°. For example, if the departure is 5°W, and you specify an intercept of 5°, waypoints will be generated for 10°, 15° etc when you select GC Wpts.

**FORCE TO WHOLE DEGREES OF LONGITUDE**
If, as is likely, the first point in the Great Circle is not a whole number of degrees of longitude, it is convenient for plotting on paper charts if each waypoint is forced to a whole number of degrees. If you check this option, the first segment will be calculated to arrive at a whole number of degrees of longitude and all subsequent waypoints along the Great Circle will be whole numbers.

**Composite Great Circle**

**LIMITING LATITUDE**

Since a Great Circle track passes nearer to the pole than a Rhumb line track, it may carry the ship into ice, counter currents, land or adverse winds. You can enter a north or south latitude limit to avoid high latitudes. If you set a limiting latitude the calculation will produce:

1. A Great Circle course to pass through the origin and the start of the limiting parallel of latitude.
2. A rhumb line course along the limiting latitude.
3. A Great Circle course to pass through the end of the limiting parallel of latitude and the destination.

Click a north or south limiting latitude box and use the spin buttons to set the latitude.

**Route Setup**

Log into **Setup Mode** and choose **Setup** from the Route menu.

**General**

**AUTO SAVE DATABASE EVERY...**

Tick this box and set a time to autosave your Route database.
AUTO TRANSFER DATABASE TO BACK-UP SYSTEM

This option applies if dual Navmaster ECDIS systems are configured to operate as dual ECDIS. When this option is checked, any route changes saved are automatically transferred to the other ECDIS.

PATHS

1. Click the Database folder browse button to change the location of route databases.

2. Click the Attachments folder browse button to change the location of attachment files.

Default

The values entered here will be applied to new route legs for passage plan calculation. See the section Setting Route Parameters on page 152 above.

The Application of Datum Shifts to Route Waypoints

Route waypoints created on ENC or CM93/3 charts are always stored in WGS84 co-ordinates. On ARCS or Seafarer charts, route waypoints are stored in WGS84 co-ordinates if they created on a chart with a supplied datum shift or in unknown co-ordinates if created on a chart of undetermined datum. The datum of each waypoint can be viewed from the waypoint list. If the waypoints were created from Chartpoints, their datum will already have been determined.

The following error messages may be generated:

<p>| &lt;One or more waypoints cannot be referenced to this chart. &gt; | If a route containing WGS84 waypoints is displayed on a chart of undetermined datum. |</p>
<table>
<thead>
<tr>
<th>One or more waypoints cannot be referenced to this chart.</th>
<th>If a route containing one or more waypoints of unknown datum is displayed on a chart with a supplied datum.</th>
</tr>
</thead>
<tbody>
<tr>
<td>No datum shift available</td>
<td>If a route containing one or more waypoints of unknown datum are displayed on a chart of undetermined datum.</td>
</tr>
<tr>
<td>One or more objects cannot be referenced to this chart.</td>
<td></td>
</tr>
</tbody>
</table>
Having created a route, you can enter planned speed(s) and desired departure or arrival time and calculate, for each leg:

1. Course to steer allowing for variation and deviation
2. Distance
3. Estimated time of arrival for each waypoint.

You can then view the plan on screen, re-calculate it if you wish to change the variables and print it.

The passage plan layout can be customised with your own layout and logo if required. Please contact PC Maritime for more information.

Plan calculations assume that you are working in local time. Remember to take the difference between local and destination time into account when planning departure or arrival times.

**How to Create a Passage Plan**

1. Prepare a route.
2. Select the **Plan** tab on the Route panel
3. Enter departure/arrival time
4. Enter estimated speed per leg if required
5. Click **Calc** and then **Report** to see the plan
The Plan Tab

Setting departure or arrival time

Click the **Edit** button and check **To depart at** for the plan to be calculated from a departure time or **To arrive for** to arrive at a specified time. To change the date and/or time either: click on the values you wish to change and type a new value, click the spin buttons to increase or reduce the dates, hours and seconds, or click the down arrow for a calendar view and select a date.

**Entering Estimated Speed and Off Track Limits per leg**

Click **.** For more information, see the section Setting Route Parameters on page 152 above.

**Calculating a Plan**

Distances, courses and estimated times of arrival are calculated based on the departure or arrival time selected above.

Click **Calc** to calculate the plan and then click **Report** to choose a passage plan report layout from the dialog.

You can also select passage plan reports by choosing **Print Preview** from the **File** menu and selecting the **Plan** tab. A description is attached to each report name to indicate its purpose.
The Passage Plan report includes variation and deviation in the report. Variation is based on a mathematical model included with Navmaster (Note: Always check magnetic variation calculations against other sources of data, such as official charts, when using them in passage making.); Deviation requires that you have completed a deviation table (Vessel \ Setup \ Deviation).

Printing and Exporting Plans

With the report displayed on screen, you can print it, export to another format, increase or reduce the size of the display and search for text within the report, from the controls at the top of the report. Note: Navmaster does not save the plan. If you want to save a plan, export it to another application.

Exporting the plan

You can export passage plans to another applications such as Adobe Acrobat (PDF) or Word for Windows.

To export a plan:

1. Click the Report button or choose Print Preview from the File menu and select a plan layout from the Plan tab.
2. Click the Export button at the top of the Print Preview window
3. This opens the Export dialog. Click the down arrow alongside the Format entry box and select the file format you require and click OK.
4. From the next dialog, choose a folder location, enter a filename and click OK.

**Printing a Plan**

1. Click the **Print** button at the top of the report window.

2. Click the **Print** button on the Standard Toolbar and select a plan layout from the **Plan** tab.

3. Choose **Print** from the **File** menu and select a plan layout from the **Plan** tab.
Navmaster accepts position information from electronic position fixing systems (normally GPS). In Position Monitoring mode, a side panel provides information related to position and the active route. Primary and secondary position inputs can be defined.

**Interfacing to GPS**

When a valid position is received, a Position Monitoring window is automatically opened, centred on the vessel’s position.

To configure Navmaster to receive GPS data please refer to allocating COM ports and configuring baud rate.

For information on GPS NMEA sentences please refer to GPS NMEA Sentences.

To save your settings permanently, see **Workspace**.

For positions to be plotted correctly on charts and stored correctly in the log, the following procedure must be followed:

1. Your GPS must be set to output position in WGS84 co-ordinates.

2. If your GPS supports the NMEA sentence DTM (which identifies the geodetic datum of positions), Navmaster will verify the datum applied to position information.

3. If your GPS does not output DTM, Navmaster will ask you to confirm the datum.

Check the box if you are certain that your GPS is set to WGS84. Uncheck if it is set to any other datum. If in doubt check your GPS.
Starting a Passage

1. If using ENC or CM93/3 charts set [Safety Contours](#) appropriate for the voyage.

2. Click the drop down arrow alongside **Route Name** to select the active route.

   *To clear the active route, click the drop down arrow and select Reset from the top of the list.

   *Note that this option will be greyed out if the route is locked.*

3. If connected to a backup Navmaster, **Save** the route to transfer it to the backup.

4. Check **Lock** to lock the active route. The leg will increment so that it is correct for your position. If you wish to change the leg manually, uncheck **Lock** and change the leg number using the spin buttons.

   *Lock automatically increments legs in accordance with waypoint detection options set under Route \ Options \ Monitoring to provide To Wpt information.*

   *Note: if the correct leg is not selected it may be because lock was checked before position input became active. In this event uncheck and recheck the lock box and the correct leg will be selected.*

5. Set **Vessel Warnings** appropriate for the start of the passage and the type of chart in use.

6. If vessel position is not visible, ensure that Position Monitoring is engaged (if in Look Away mode, click [on the Voyage Toolbar or press F9]),

7. Click **New Log** on the Voyage Toolbar to start a new log segment and, if desired, enter a Voyage ID and Watch Officer, and click OK.
8. Click Activate RADAR overlay if interfaced to Radar.

To close the log segment at the end of the voyage, click on the Voyage Toolbar.

**The Position Monitoring Side Panel**

This panel repeats information from your instruments and provides information related to the active route. If no data is being received, **NMEA inactive** is shown.

If data is being received, the top box indicates:

- The source of position data (e.g., GP for GPS or dGP for DGPS, II for Integrated Instruments). If the source sentence indicates that the data is Estimated (DR), Manual or Simulated this will be shown and the position display will turn red.

- A letter a (automatic) or m (manual) to indicate whether the datum has been confirmed automatically via the NMEA sentence DTM, or manually by the user.

- The datum of the received position (e.g., WGS84, OSGB36).

Shift will show **None required - Chart** if the chart is WGS84, **Applied - Chart** if the chart is referenced to a different geodetic datum but a datum shift to WGS84 is applied, or **None available** if the chart cannot be referenced to WGS84. See Appendix B for information on geodetic datums.

Latitude and Longitude is displayed to the number of decimal places set under **Setup|Workspace** in the **Tools** menu.

Speed and heading are shown against a blue background which is blanked and changed to a red background when data is lost or the source sentence indicates that the data is Estimated (DR), Manual or Simulated. To the right of each field the source of the data is shown by its NMEA Talker ID.

The following route information is displayed:
<table>
<thead>
<tr>
<th>Name</th>
<th>The name of the active route</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leg</td>
<td>The current leg number in the active route</td>
</tr>
<tr>
<td>Wpt</td>
<td>The next waypoint number and name in the active route</td>
</tr>
<tr>
<td>Destination</td>
<td>ETA at the last waypoint in the route</td>
</tr>
</tbody>
</table>

**Position Monitoring Panel Tabs**

**NMEA**

This tab displays data received from the NMEA device. When in dead reckoning mode, the tab name changes to DR.

**TO WPT**

**TO Wpt** provides information calculated from your position to the next waypoint in the route.

Select **Calc** from the drop down list, Navmaster calculates parameters from the last position received to the end waypoint of the current leg. Select **NMEA** from the drop down list to repeat waypoint data received from your NMEA device (if available).

The information displayed under **TO Wpt** includes:

<table>
<thead>
<tr>
<th>BRG</th>
<th>Bearing to waypoint in degrees true.</th>
</tr>
</thead>
<tbody>
<tr>
<td>RNG</td>
<td>Range to waypoint in nautical miles. The Rhumb line range and bearing of the current leg are shown to the right.</td>
</tr>
<tr>
<td>XTE</td>
<td>Distance off track in nautical miles. &lt;&lt;&lt; in red or &gt;&gt;&gt; in green is displayed to indicate that you should steer to port or</td>
</tr>
</tbody>
</table>
starboard to reduce cross track error.

<table>
<thead>
<tr>
<th>TTG</th>
<th>Time to go to the next route waypoint (dd hh:mm:ss)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETA</td>
<td>Estimated time of arrival at the next waypoint (calculated from current speed over ground (SOG)).</td>
</tr>
<tr>
<td>Next Leg</td>
<td>The rhumb line course (° true) and distance for the next leg taken from the current route.</td>
</tr>
</tbody>
</table>

**WAYPOINT ETAS**

This tab provides ETA’s at route waypoints as follows:

<table>
<thead>
<tr>
<th>Waypoint no</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Waypoint name</td>
<td></td>
</tr>
<tr>
<td>ETA</td>
<td>based on ship’s speed at the time of calculation</td>
</tr>
<tr>
<td>Planned ETA</td>
<td>at the next waypoint based on ship’s speed at the time of calculation and, planned ETAs at subsequent waypoints based on the planned speed for each leg.</td>
</tr>
</tbody>
</table>

If the content of a field is not fully visible, hover the cursor over it to display the text in a yellow box.
**ETD (ESTIMATED TIME OF DEPARTURE)**

Set a departure or arrival time here to calculate a planned ETA for each waypoint on the monitored route. Planned ETA can be displayed at each waypoint from Route \ Options \ Overlays.

The calculation is based on the speed applied to each leg of the route which can be viewed by clicking the leg scroll buttons. To change planned speeds, select the route in the Route side panel and adjust the speeds as described under **Setting Route Parameters**.

**WIND**

Displays wind information if an anemometer is connected.

**DEVICES**

This tab lists position input devices with a green dot indicating an active device. Move the slide bar to the right to view latitude and longitude, COG, SOG, and HDOP and whether the data received is valid.

Place your cursor over a device for its full name (Dead reckoning, Primary & Secondary Positioning systems).

The lower part of this tab shows position differences in metres if more than one position input is active.
SATELLITE

This tab repeats information from GPS to allow you to check the validity of received data. For instance it shows the number of satellites in use. If this value were 0 it would indicate why positions were not plotted.

The Route Warnings Tab

This tab displays warnings for the monitored route, generated by ENC or CM93/3 vector charts based on the safety contour value that you have set, and Mariner Overlays. Warnings are generated for any relevant object within the off track limits of each leg and are listed in leg order. The same warning may occur in more than one leg if the warning area is large, such as for a fairway.

Warnings are listed in leg order. The same warning may occur in more than one leg if the warning area is large, such as for a fairway.

To review Warnings:

1. Select the ENC, CM93/3 or Mariner Overlay tab.
2. Click Display Warnings to list the warnings for the route.
3. Click the + box alongside each leg to view the warnings applicable to that leg.
4. Select a warning; it will be highlighted on the chart in red, surrounded by a bounding rectangle.
5. Click the + box alongside the warning to view the detail of the warning and move the slider to the right to see more information and to open any text or image file.
6. If the warning is not visible and you are in the Position Monitoring window, click to
deactivate position monitoring and click the Go to button to view it.

7. Click **Clear Highlight** to remove the highlight from the chart.

8. Click [on] to reactivate position monitoring if necessary.

**Note:** The warnings displayed here are for the active route. To see, or display the list of warnings for the alternate route go to the Route Warnings tab on the Route side panel.

**The Chart Warnings tab**

During route monitoring this tab shows active safety contour warnings, (including contours within the vessel’s guard zone lower than the safety contour), and chart warnings set under Vessel \ Options \ Warnings for **Position Monitoring alarms**. **Note:** no warnings are given if Course over Ground (COG) is 0.

Select any item and click **Highlight** to identify it on the chart.

To review Warnings:

1. Select the tab for the type of chart in use: ENC or CM93/3.

2. Select a warning; it will be highlighted on the chart in red, surrounded by a bounding rectangle.

3. Click the + box alongside the warning to view the detail of the warning and move the slider to the right to see more information and to open any text or image file.

4. If the warning is not visible and you are in the Position Monitoring window, click [on] to deactivate position monitoring and click the Go to button to view it.

5. Click **Highlight** again to remove the highlight from the chart.

6. Click [on] to reactivate position monitoring if necessary.
Route Locking

Once underway, and with the route locked, the route leg will automatically increment as you pass through the waypoint perpendicular or arrival circle specified under **Route | Options | Monitoring**. This ensures that you get the correct information (R&B to next wpt, TTG, ETA at final waypoint etc) in the display toolbars and on the Position Monitoring side panel. Whilst locked you cannot manually change the leg on the Position Monitoring panel (the boxes are greyed out), and you cannot change route.

To change route or the leg of a route, de-activate route locking:

1. Uncheck **Lock** on the Position Monitoring side panel
2. Or choose **Options** from the **Route** menu, select the **Monitoring** tab and clear **Automatic Leg Advance**.

Whilst the route is locked you are unable to open a route database or start a new database. The Route folder in the **File | Open** dialog will be marked with a lock symbol. If you find that you cannot open a route database, de-activate Route Locking.

The Position Monitoring Window

A dedicated window is automatically allocated to monitor vessel position on, by default, the largest scale of chart available, and changing chart when necessary. This window cannot be minimised or closed if position input is active.

The following options enable you to control the type of motion and to position the vessel relative to the chart.
True / Relative / Directional Relative Motion

Choose Position Monitoring\ True Motion or Relative or Directional Relative motion from the Navigator menu or press <F7> or <F8>.

Reposition

To reposition the vessel in the Position Monitoring Window, left click where you want the vessel displayed.

Centre vessel

Press <F6> to move the vessel position on the chart between centre and off centre or choose Position Monitoring\ Centre Ship from the Navigator menu.

Look Ahead / Look Away

TO LOOK AWAY (DISENGAGE POSITION MONITORING)

You can Look Away via a button or function key that disengages display of vessel position in the Position Monitoring window. This allows you to scroll ahead or view another chart.

1. Click on the Voyage Toolbar.
2. The chart title bar changes to read Look Away as shown below

   ![Navmaster - [Look Away] - ENC - WCS84 - Depth [Unknown] - Height [Unknown] - 1:5888](image)

3. Use normal chart commands to scroll elsewhere or to select a new chart.
4. Click on the Voyage Toolbar or press <F9> to return to Position Monitoring.

TO LOOK AHEAD

You can set a Look Ahead distance via a set of buttons and function keys that force the Position Monitoring window to display a chart, or scale a vector chart, with a set distance from vessel to the edge of the chart window, in the direction of travel. This option is for ARCS or Seafarer charts that, because of their raster format, cannot be scaled without losing clarity and to prevent the vessel being plotted up to the chart border before changing to the next chart.
For example, in open water, you might set Look Ahead to 10nm whereas in confined waters 0.5nm would be more appropriate. If Look Ahead falls below the value, the chart will change to one with at least the set distance ahead.

To activate Look Ahead:

1. Choose Position Monitoring\Activate Look Ahead from the Navigator menu or press <F3>.
2. Choose Increase \ Decrease Look Ahead from the Navigator menu or press <F4> to increase or <F5> to decrease the look ahead value.

The default Voyage Toolbar provides a button to turn Look Ahead on or off and a display field to show the current look ahead value.

Note: If you change chart or scale in the Position monitoring window whilst Look Ahead is active, the look ahead value is overridden to match the new chart scale.

Position Source

By default Position Source is set to NMEA to accept positional information from GPS.
Click the **AIS** radio button to receive positional information via the VDO sentence transmitted by AIS. *Not available in ECDIS mode*

Click the **DR** radio button if you wish to operate in DR.

Click the **Off** radio button if you wish to disable positional input.

**Position Offset**

You may wish to apply an offset to the GPS position. You can offset the position in two ways:

1. From the **Navigator** menu choose **Position Offset**. Enter the bearing and distance by which you want to offset position.

2. In Position Monitoring mode (press <F9>) right click at the point to which you want to offset position and choose **Offset Vessel** from the menu. The dialog will appear with the offset already calculated. Select **Apply** to confirm.

To remove the offset chose **Position Offset** from the **Navigator** menu and click **Reset** and then **Apply**.

When an Offset has been applied a warning message is put on permanent display stating “*Vessel position offset by x.x metres, x.xº*.”
Choose **Options** from the **Navigator** menu and select the **Monitoring** tab to set options to relative or true motion; the maximum amount of chart ahead (or astern) of the vessel and to maintain a minimum look-ahead distance within a chart window.

**RELATIVE MOTION**

When operating in relative motion, the chart moves under the vessel while the vessel appears stationary relative to the screen.

If **Directional** is ticked, use the slide bar to define how much chart you want ahead or astern of vessel position.

**TRUE MOTION**

When operating in True Motion, a chart redraw takes place when the vessel approaches a set distance from the chart window border. Use the min / max slide bar to define the distance from the border at which you want chart redraw to take place.
**CHART ORIENTATION**

If you are using a vector chart, use this option to set the chart to North Up, Head Up or COG Up. This option does not apply to raster charts.

**ACTIVE AT …**

This option filters out chart movements at slow or zero speed when the chart may frequently reposition itself if COG received from GPS is changing rapidly. Check this box to deactivate chart movements below a speed in the range 0.1 to 1nm.

**LOOK AHEAD**

To activate this feature, check **Look Ahead** and select your preferred look ahead parameter: distance or time.

**AUTO SELECT LARGEST CHART AT CHART BOUNDARY (WHEN LOOK AHEAD OFF)**

This option when ticked causes the largest available scale chart to be selected when a vessel reaches the edge of the current ARCS chart or ENC cell. If un-ticked, a chart with the closest possible scale to the current chart will be selected.

---

Choose **Setup** from the **Navigator** menu, select the **Position** tab and then the **General** tab to set:
Log position interval and Log location

- The interval at which you wish to store log entries in the range 1 – 60 seconds (default 60 seconds)
- The location of log databases

Activate DR on position failure

Tick the checkbox for Navmaster to automatically switch into DR mode if the position source fails (after the interval specified under the Primary \ Secondary tabs).

Primary \ secondary position difference alarm

Tick the checkbox if an alarm is required if positions received from the primary and secondary position source vary by more than a set number of metres. Use the spin button to set the distance at which the alarm is activated.
Position \ Depth \ Gyro \ Keltron ES \ Speed and Wind

These tabs enable you to set the COM port applicable to each instrument.

You can set the following options under the Primary or Secondary tabs:

- **Name** - records the name of the position device that is displayed in the Position Monitoring side panel.

- **Receive** - sets the COM port to receive NMEA data from the instrument.

- **Transmit** - sets a COM port to transmit NMEA data received from this device to another instrument or PC or to upload routes and waypoints.

- **Valid duration:**

  - **Sentences**: sets the length of time that a NMEA sentence is considered valid (default 15 seconds). If a replacement sentence is not received within this time, the information from the sentence is discarded and, in some cases, a warning given.
- **Data**: sets the length of time that a data element is considered valid (default 5 seconds). EG, position may be arriving in several different sentences. If it is not refreshed within the data duration, it is discarded and, in some cases, a warning or alarm given.

- **Transmit** – character separator

- **HDOP threshold value** - sets the value of HDOP (Horizontal Dilution of Precision) below which GPS positions are considered invalid. If this value is breached and another position fixing system is available with a valid HDOP value, it will be switched to become the primary system.

- **Elapsed time for DR to initialise after failure** - defines the interval without GPS data after which Navmaster will switch to Dead Reckoning.

**NMEA**

![Navigator Setup](image)

Refer to [NMEA Sentences](#) for information concerning the **Sentences** tab. The **General** tab contains the following:

**REPEATER**

This facility enables you to transmit the data received from one or more COM ports out through any COM port. It can be used to feed data to another PC or instrument.

To transmit NMEA data:

1. Tick the COM ports you wish to repeat data from.
2. Select the COM port through which you wish to repeat the data
3. Click OK or Apply and save your Workspace.

**SIMULATION**

This facility enables you to replay NMEA data contained in a text file. To operate the simulator you must not have active input from GPS or other instruments.

To replay a file containing NMEA data:

1. Choose **Position Source** from the **Navigator** menu and click **Off**.
2. Click the browse button to the right of the **Simulation** file field.
3. Check the **Process** box. By default the data will replay at 4800 baud, the standard NMEA rate. Select a different value from the **Bits per second** drop down list to speed up or slow down the data replay.
4. Click OK to close the dialog. You can operate Navmaster as if you were receiving live data whilst the data is being replayed.

Choose **Position Source** from the **Navigator** menu and click **NMEA**. When in Simulation mode, the following symbol is shown in the top right hand corner of the Position Monitoring chart window, to comply with **IEC 62288, Presentation of navigation-related information on shipborne navigational displays**.

![Simulation Mode Symbol](image)

**EXPORT**

This facility enables you to record all received NMEA data in a text file for diagnostic purposes or to replay later, perhaps as a training exercise.

To record a data file

1. Click the browse button to the right of the **Export** file field.
2. This opens a standard dialog where you
   a. Select a location for the file (we suggest My Documents for ease of access).
   b. Type a file name.
c. Click Open.

3. Check the Process check box and click Apply.

4. When you have captured sufficient data for your purpose, uncheck the Process box (there is no limit to the amount of data you can capture – it can be a full voyage.)
An additional module is available that processes radar signals in real-time to overlay the radar image on ARCS, ENC CM 93/3 or Navmaster’s Blank Chart. The options described will not be seen if the Radar Overlay module has not been purchased.

**To Turn On/Off Radar Overlay**

Choose **Radar** from the **Navigator** menu and select **Turn on \ off Radar Overlay** or click on the Radar Toolbar (start up messages appear whilst the image is being processed for display that can be closed if required).

**To Hide the Radar Overlay**

Choose **Radar** from the **Navigator** menu and select **Hide Radar Overlay** or click on the Radar Toolbar to temporarily remove the radar overlay from the display. Click again to restore the overlay.
To Set Radar Overlay Options

Choose **Radar** from the **Navigator** menu and select **Display Radar Options** or click on the Radar Toolbar. This enables you to change the range of the radar overlay and to adjust Brightness and Gain, Rain & Sea clutter settings. In each case make your selection and click **Apply** to activate. Click **Default** to set to original settings if required.

Click **Display Radar Ring** to display the limits of the radar overlay display.

If data is not received after the **Valid Duration** interval set, the data is considered invalid and the overlay removed. Set **Data Valid** between 5 and 60 seconds (default 10s) for data to be valid for a time that suits you.

**Communications Port** is applicable to a special hardware solution that allows automatic switching between a primary and secondary radar input.

**Dead Reckoning (DR)**

DR mode calculates and plots estimated positions from true course and speed and estimated set and drift.

If the setup option Activate DR on position failure is on (page 191 above) and the Primary NMEA connection is lost for the interval set under **Navigator | Options | Position** (default 1 minute), Navmaster will switch
to the Secondary NMEA connection if available and if not to DR and will switch back again if the connection is regained.

DR can be enabled manually from Navigator|Position Source. DR can be used to simulate a passage. Set an initial position and the other values, and you are ‘underway’. This can be useful for practise and training in the use of ECDIS.

Starting a DR passage

To start a DR passage NMEA position input must be unavailable or off.

A DR passage can be started in one of two ways:

- From Position Source in the Navigator menu, click the Dead Reckoning radio button and enter position, course, speed, set and drift. Click Apply when finished.

- Or, move the cursor to the desired initial position and right click. Choose Vessel Position from the menu. A position will be entered automatically. Click the Dead Reckoning radio button and enter course, speed, set and drift and click OK when finished.

COG and SOG are calculated from the values entered.

If Apply immediately is checked, the Course and Speed fields are given spin buttons so that you can change their values and have them applied to the DR update immediately.
**Updating a DR position**

To update your position, move the cursor to the new position and right click. Choose **Vessel Position** from the menu. For the log to record the type of fix, select a type from the drop-down list below the position fields. When you are satisfied with the position click OK.

**DR Warnings**

When Navmaster is in DR mode the letters DR are displayed in the top right corner of the chart window, the banner at the top of the Position Monitoring panel will read DR and the background colour of the latitude and longitude display will change from blue to red.

**Position Logging**

Logs are stored in databases containing any number of passages or segments of passages.

For information on starting a new Log database see managing databases.

Log data is automatically saved whenever there is active NMEA input.

**Start Log Segment**

This option creates a new log segment. It is greyed out if there is no position input or if a log database is not setup correctly.

**To start a log:**

1. Click the **Start New Log** button on the **Voyage** toolbar or choose **Logbook \ Start New Log** from the **Navigator** menu.

2. Enter a Voyage ID and watch officer name if desired and click OK.

The Voyage ID is used to name the log segment with any entry in Watch Officer added to the end of the log segment name.
Making a Log Book Entry

To add an entry to the logbook:

1. Choose **Logbook** from the **Navigator** menu and select **Logbook Entry**

2. Enter text

3. Check **Add time label** (on by default) to add a time label to the track record.

4. Click OK

**Automatic Log Entries**

In addition to position entries made at the specified interval, the following automatic entries are made:

<table>
<thead>
<tr>
<th>Type</th>
<th>Message</th>
<th>Occurs</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System status</strong></td>
<td>EPFS reception lost. Caution. NMEA not received. Position calculation transferred to DR.</td>
<td>On loss of NMEA position input. On transfer to DR calculation</td>
</tr>
<tr>
<td></td>
<td>EPFS position re-established</td>
<td>On regaining NMEA position input</td>
</tr>
<tr>
<td></td>
<td>NMEA manually switched off</td>
<td>When user turns off NMEA reception</td>
</tr>
<tr>
<td></td>
<td>Dead Reckoning manually switched off</td>
<td>When user turns off DR calculation</td>
</tr>
<tr>
<td><strong>Position</strong></td>
<td>User confirmed GPS set to WGS84</td>
<td>On start up if Navmaster cannot automatically determine datum of incoming positions</td>
</tr>
<tr>
<td></td>
<td>User confirmed GPS not set to WGS84</td>
<td>On start up if Navmaster cannot automatically determine datum of incoming positions</td>
</tr>
<tr>
<td><strong>Route monitoring</strong></td>
<td>Vessel outside off-track limit for the active route</td>
<td>When vessel moves outside off-track limit for the active leg</td>
</tr>
<tr>
<td></td>
<td>Vessel inside off-track limit for the active leg</td>
<td>When vessel moves inside the</td>
</tr>
<tr>
<td>the active route</td>
<td>off-track limit for the active leg</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>-----------------------------------</td>
<td></td>
</tr>
<tr>
<td>Arrival circle entered – Wpt number - name</td>
<td>When vessel enters the arrival circle set under Route</td>
<td>Options</td>
</tr>
<tr>
<td>Perpendicular passed – Wpt number - name</td>
<td>When vessel passes a perpendicular set under Route</td>
<td>Options</td>
</tr>
</tbody>
</table>

**Opening a log database**

Old logs can be recalled and viewed when NMEA data input is inactive. To view an old log:

1. Choose **Position Source** from the **File** menu, set to **Off** and **Close** the dialog.
2. Choose **Open** from the **File** menu.
3. Click the Log symbol.
4. Select the database you wish to open

The display of log database names in the **Open** dialog is initially collapsed. Click the + sign alongside each level to expand the list until you have all levels displayed.

A log database could contain all the logs for a series of passages during, for example, a week. The data for each log is stored at level 2 as LogN (where N is a number added after the word Log) automatically incremented.
from 1. Under the LogN heading all or part of a passage will be stored at level 3 as follows:

Vessel name. From start date, time to end date, time

(If the log description does not show an end time, the log is still open.)

If you turn NMEA on whilst running Navmaster or re-enter Navmaster, a new LogN is created.

**Continuing Log to Complete Passage**

If you break during the voyage, you can save the log in the same log file.

Choose **File| Open| Log**

1. Select the log file you were using previously and wish to append to

2. Check **Append to current log**

3. Click **Open**

**Log Reports**

Navmaster maintains a log of positions saved at the time interval specified under **Navigator|Options|Position Logging** menu.

The following log reports are available to view or print for the current log:

<table>
<thead>
<tr>
<th>Log Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vessel log</td>
<td>Simplified report listing COG &amp; SOG.</td>
</tr>
<tr>
<td>Voyage log</td>
<td>Full record including Position, COG / SOG,</td>
</tr>
<tr>
<td></td>
<td>Heading / Speed, Depth &amp; chart in use.</td>
</tr>
<tr>
<td>Log list</td>
<td>List of log segments in the current database.</td>
</tr>
</tbody>
</table>

**Printing Logs**

1. Choose **Print Preview** from the **File** menu and select the **Log** tab

2. Select the report you wish to print

3. Click **OK**
TO EXPORT A LOG

You can export a log to another format, for example, Word or Excel.

You cannot load a past log whilst GPS or DR is active. To load a past log:

1. Choose Position Source from the Navigator menu and set to OFF.
2. If the log you wish to export is not already open select it from File | Open | Log | Log Name. Once loaded click the Log button to check that the correct log is loaded.
3. Choose File | Print Preview from the menu, select the Log tab.
4. Click the Export button at the top of the Print Preview window.
5. Click OK to the Microsoft Outlook Message.
6. This opens the Export dialog. Click the down arrow alongside the Format entry box and select the file format you require and click OK.
7. For destination, select **disk file** and click OK

8. Choose a folder location, enter a filename and click Save. The default location where the file is saved is Navmaster \ System\ Reports\ Plan

9. If you wish to view the exported file, open the appropriate application.

10. Once the export is complete, turn **Navigator \ Position Source** back ON.

### Uploading Routes and Waypoints to GPS

*Note: this facility is provided so that a route can be monitored from GPS as well as ECDIS. It is not provided so that the GPS can be used to steer the vessel, which requires a type approved track control system.*

Some GPS cannot accept route uploads (requires the NMEA sentence RTE), but can accept waypoint uploads (requires the NMEA sentence WPT). Some GPS will not accept spaces or lower case letters or certain characters such as * $ , ^ ~. For instance, the name START POINT may be rejected, whereas STARTPOINT will be accepted. Check your GPS manual to see what it is capable of receiving and for any characters that will cause all or some waypoints to be rejected.

**To Upload Waypoints**

To upload waypoints

1. Open the Chartpoint database containing the waypoints you wish to send to GPS.

2. Choose **Upload|Chartpoints** from the **Navigator** menu.

3. Click on individual waypoints to select or de-select them individually or click **Select All**. Click **Select None** to de-select all waypoints.

4. Choose the Chartpoint identifiers you wish to use (refer to your GPS manual).
**Number starting at** .... defines a number for the first waypoint to be sent. Usually waypoints are sent to the corresponding memory location. In other words if you enter 50 in this box, the waypoints will be sent to memory location 50 and onwards in the GPS.

In addition you can select one of the following:

<table>
<thead>
<tr>
<th>Name</th>
<th>Uses the Chartpoint name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Uses the Chartpoint ID field</td>
</tr>
</tbody>
</table>

5. Click **Upload**.

6. If waypoints are not received correctly or some are missing, try using each identifier in turn and check that you do not have any invalid characters in the names.

---

**To Upload a Route**

GPS distinguishes routes in its memory by an identifier. Please refer to your GPS manual to find out the identifiers used by your model. Under **Route Identifier**, you can identify the route by Name or Number. The waypoints usually arrive in the GPS’s waypoint bank where they can be used to construct a route in the GPS.
To upload a route:

1. Open the Route database containing the route to send to GPS.
2. Choose **Upload|Routes** from the **Navigator** menu.
3. Select a route from the **Available Routes** combo box. Click **Report** if you wish to see a list of waypoints in the route.
4. Note the message that confirms whether the route waypoints have been stored in WGS84.
5. Choose a **Route identifier** if the GPS accepts this information.
6. Choose a **Waypoint identifier** if the GPS does not accept the Route Identifier.
7. Check **Number starting at ....** if you wish to define a number for the first waypoint to be sent.
8. Select Name or ID depending on your preference for the route identifier.
9. Click **Upload**.
10. Check that the route has been received correctly by the GPS. If any are missing, try sending with each identifier in turn and check that you do not have any invalid characters in names.

**Checksum**

Checksum is a verification process required by some GPS. Refer to your GPS manual and tick Checksum if required.
Uploading a Great Circle Route

Because most GPS do not accept the NMEA RTE sentence for uploading whole routes, to upload a great circle route you must first store each great circle waypoint as a Chartpoint. Once you have created the great circle route waypoints and can see the route on the chart, change to Chartpoint mode; place your cursor over each waypoint, right-click and store the position as a Chartpoint. You can then upload the Chartpoints following instructions earlier in this chapter.

Tip - Using Position Monitoring With a “Look Ahead” Window

A shortcoming of electronic charts is that the amount of chart you can display is limited by screen size. You can overcome this by opening a second chart window to display the area around the vessel at smaller scale. To do this:

1. Choose Duplicate from the Chart menu.
2. Click the Zoom Out button on the Chart Toolbar until you are happy with the scale displayed.
3. If your course is largely east / west choose, from the Window menu, Tile Horizontally; or if north / south Tile Vertically.
Navmaster accepts target information via NMEA data input from AIS units.

Interfacing with AIS

To configure Navmaster to receive AIS data please refer to allocating COM ports and Setting the Baud Rate.

For information on AIS NMEA sentences please refer to AIS NMEA Sentences.

Using AIS as a Position Source

This option is not available in ECDIS
The NMEA VDO sentence, transmitted by AIS incorporates own ship position and heading information.

To ensure that you have a Consistent Common Reference Point (CCPR), log in to Setup, choose Setup from the Vessel menu and enter the location of the AIS antenna.

To activate, choose Position Source from the Navigator menu and select the AIS radio button.

If AIS is used as the positioning source then AIS will be shown as the NMEA source at the top of the Position Monitoring side panel; the Devices tab will list AIS with a green dot to show that it is active.

## AIS Data Categories

Information from AIS is categorised as follows:

1. **Dynamic Information** that is constantly updated including position, COG and SOG. The frequency of transmission depends on various factors including speed and course; see tables below. Information is regarded as invalid if not received within a specified interval.

2. **Static Information** that relates to own vessel including dimensions and type. This information is transmitted every 6 minutes or when changed.

3. **Voyage Information** that relates to a specific voyage including ETA, and destination. This information is transmitted every 6 minutes or when updated.

### Class A ship borne reporting intervals

<table>
<thead>
<tr>
<th>Ship’s dynamic conditions</th>
<th>Nominal Reporting Interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ship at anchor or moored and not moving faster than 3 knots</td>
<td>3 minutes</td>
</tr>
<tr>
<td>Ship at anchor or moored and moving faster than 3 knots</td>
<td>10 seconds</td>
</tr>
<tr>
<td>Ship’s dynamic conditions</td>
<td>Nominal Reporting Interval</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Class B ship borne equipment not moving faster than 2 knots</td>
<td>3 minutes</td>
</tr>
<tr>
<td>Class B ship borne equipment moving 2-14 knots</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Class B ship borne equipment moving 14-23 knots</td>
<td>15 seconds</td>
</tr>
<tr>
<td>Class B ship borne equipment moving &gt;23 knots</td>
<td>5 seconds</td>
</tr>
<tr>
<td>Search and rescue aircraft</td>
<td>10 seconds</td>
</tr>
<tr>
<td>Aids to navigation</td>
<td>3 minutes</td>
</tr>
<tr>
<td>AIS base station</td>
<td>10 seconds</td>
</tr>
</tbody>
</table>

**AIS Symbology**

To comply with IEC 62288, *Presentation of navigation-related information on shipborne navigational displays* the symbols shown below are used in respect of AIS targets.

If a target is **activated** additional symbology will be displayed as shown below with any text labels selected for display.

If a new sentence is not received within the **Nominal Reporting interval**, the target is displayed as **dangerous**.

If a new sentence is not received after the **Nominal Reporting interval** plus the valid sentence time interval set under **Target \ Setup \ AIS \ Configuration** the target is displayed as **lost**.
2.4 Sleeping AIS targets

Sleeping AIS targets shall be presented as acute isosceles triangles oriented to the targets’ reported heading (or COG if heading is not reported) and centred at the targets’ reported position. The base of the triangles shall be 2 mm and the height shall be 4.5 mm. The triangles shall be drawn using a thick solid line style (or a broken line if a collision avoidance computation cannot be done) with the same basic colour used for target symbols.

A sleeping AIS target with neither a reported heading nor COG shall be oriented toward the top of the operational display area.

<table>
<thead>
<tr>
<th>Symbol name and description</th>
<th>Symbol graphic(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.6 a Activated AIS targets</td>
<td><img src="image" alt="Symbol graphic" /></td>
</tr>
<tr>
<td>Activated AIS targets shall be presented as acute isosceles triangles oriented to the targets’ reported heading (or COG if heading is not reported) and centred at the targets’ reported position. The base of the triangles shall be 4 mm and the height shall be 6 mm. The triangles shall be drawn using a thick solid line style (or a broken line if a collision avoidance computation cannot be done) with the basic colour used for target symbols.</td>
<td><img src="image" alt="Symbol graphic" /></td>
</tr>
<tr>
<td>An activated AIS target with neither a reported heading nor COG shall be oriented toward the top of the operational display area.</td>
<td><img src="image" alt="Symbol graphic" /></td>
</tr>
<tr>
<td>Activated AIS targets may be labelled. Alphanumeric text used to label AIS targets shall be drawn with the same basic colour as used for target symbols.</td>
<td><img src="image" alt="Symbol graphic" /></td>
</tr>
</tbody>
</table>

2.5 b Activated AIS targets – true scaled outlines

Alternatively, when own ship is presented as a true scaled outline, the user may select to add true scaled outlines to activated AIS target symbols.

True scaled outlines for activated AIS targets shall be drawn around the AIS target symbol triangles relative to the targets’ reported position according to the offsets, beam and length. The outline shall be drawn using a thick solid line style.

True scaled outlines for activated AIS targets shall be drawn with the same basic colour used for target symbols.

True scaled outlines for individual activated AIS targets shall not be used when a target’s heading is not reported or when the beam of the outline is less than 7.5 mm.
2.5 c  Activated AIS targets – dangerous targets

Activated AIS targets designated as dangerous targets may be presented with larger triangles, with a base of 5 mm and a height of 7.5 mm, shall be the required basic colour red, drawn with a thick solid line and shall flash until acknowledged by the user.

Once acknowledged, the symbols shall cease flashing but shall still be presented using the required basic colour red until no longer considered to be a dangerous target.

2.6 a  Velocity vectors

Velocity vectors for targets shall be selected for display.

Velocity vectors shall be presented as single lines originating at the targets’ tracked/reported position and extending in the direction of course CTW or COG, as appropriate, for a length representing the distance the target will travel in the time interval used for own ship’s velocity vector. Vectors shall be drawn using a thick short-dashed line style with the same basic colour used for target symbols.

Velocity vectors for dangerous targets shall be the required red basic colour and shall flash with their base target symbols until acknowledged by the user.

Once acknowledged, the symbols shall cease flashing and unless considered as dangerous, shall assume the basic colour of other non-dangerous target symbols.
### 2.8 b Velocity vectors – time increments

Time increments may be shown drawn across target velocity vectors.

Time increments shall be presented as single lines perpendicular to the vectors with their midpoint on them and extending not more than 1.5 mm on either side. They shall be spaced along the vectors to represent the distance the target will travel in the time increment of the time interval used for own ship’s velocity vector. The increments shall be drawn using a thick solid line style with the same basic colour as for target symbols.

Time increments for dangerous targets shall be the required red basic colour and shall flash with their base target symbols until acknowledged by the user.

Once acknowledged, the symbols shall cease flashing and unless considered as dangerous, shall use the basic colour of other non-dangerous target symbols.

#### Symbol graphic(s)

<table>
<thead>
<tr>
<th>Radar target time increments:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Radar target time increments" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AIS target time increments:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image2" alt="AIS target time increments" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Associated target time increments:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Associated target time increments" /></td>
</tr>
</tbody>
</table>

### 2.10 AIS aids to navigation

AIS aids to navigation (ATON) shall be presented as a diamond with crossed lines centred at the reported position of the ATON. The crossed lines shall be not more than 2 mm in length and the sides of the diamond shall be not more than 8 mm in length.

A virtual AIS ATON shall have the letter ‘V’ superimposed on the symbol so that it does not extend beyond the diamond and does not intersect with the crossed lines.

The diamond, crossed lines and ‘V’ shall be drawn using a thin solid line style.

The basic colour for an “off position” AIS ATON is red.

The basic colour for an “on position” AIS ATON is as used for the ATON symbols.

AIS ATON may be labelled. Alphanumeric text used to label an AIS ATON shall be the same basic colour as the AIS ATON symbol.

#### Symbol graphic(s)

<table>
<thead>
<tr>
<th>Real AIS ATON:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4" alt="Real AIS ATON:" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Virtual AIS ATON:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="Virtual AIS ATON:" /></td>
</tr>
</tbody>
</table>
### 2.11 AIS search and rescue transmitter

An AIS search and rescue transmitter (AIS-SART) shall be drawn with a solid line and shall be the same basic colour as the AIS ATON symbols.

**NOTE** A radar-SART has a receiver which scans for X-band radar signals. When the SART detects a signal, it transmits its own signal, consisting of a series of twelve pulses, on the same frequency. These pulses are displayed as a series of twelve echoes originating at the position of the SART and spaced 0.6 nautical miles apart along the line of bearing toward the edge of the screen (see IEC 62368).

<table>
<thead>
<tr>
<th>Symbol name and description</th>
<th>Symbol graphic(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2.12 Selected targets</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Selected target symbols shall be presented as broken squares indicated by their corners, centred on the selected target symbol by the user and clearly extending beyond it. The square shall be drawn using a dashed line. Alphanumeric text used to label a selected target shall be the same basic colour as the selected target symbol. | ![Selected radar targets](image1) (SN243)
| ![Selected AIS targets](image2) (SN243) | ![Selected AIS ATON](image3) | ![Selected AIS SART](image4) |
Displaying scaled outlines of AIS targets

Navmaster will draw a true scale outline of activated AIS Targets where the beam of the vessel represents more than 7.5mm on the display. The following criteria must also be met

- The last position received must be valid (the target must not be lost)
- The target’s heading must be valid
The AIS Toolbar

The AIS toolbar provides access to frequently used commands.

**Hide targets**

Click to temporarily hide AIS targets from the display. Click again to restore targets and any history associated with them. Any filtering applied to hide targets is shown at the bottom of the AIS side panel.

**To Quick View text labels alongside targets**

Click to show text labels against targets for a limited time. Click again to remove text labels.

**To acknowledge a Lost Target alarm**

Click to acknowledge an alarm for the selected target.

**To GoTo a specific target**

Click to go to the selected target.

**To upload Voyage Data to AIS**

To upload data to your AIS equipment you must have an upload connection to the AIS and must set the COM port for transmission under Target \ Setup \ AIS \ Configuration – See allocating COM ports for further information. Normally this will be the same COM port used to receive AIS data.

Click and the following dialogue appears.
Each item has three states:

1. **No Change**: select this button if no change is required.

2. **Unavailable**: select this button if you wish to make the item unavailable. This will cause the AIS unit to transmit an invalid data field. AIS receivers will see a blank field for the item.

3. **Valid Setting**: select this button to enter data for upload. **Note**: in some cases you will get a pre-set list of selections defined by AIS specifications.

Once you are satisfied with your selections click the **Send** button. After a short while you can check the data by selecting **Own vessel** in the AIS target side panel and viewing the **Dynamic**, **Static** and **Voyage** displays.

**The AIS Target Tracking Side Panel**

Select the AIS Target Tracking side panel by clicking 🎨 on the Display Toolbar, by choosing **Target Tracking panel** from the **View** menu, or by pressing <F12>. Select the AIS tab to view AIS data.
The AIS Target Tracking side panel consists of a target list and Dynamic, Static and Voyage buttons to display data associated with each target.

If own vessel data is received via the AIS data stream, “Own Vessel”, is placed at the top of the AIS Target side panel target list so that you can view own vessel data as transmitted.

If own vessel position exists, targets are sorted by range with the nearest first; otherwise they are displayed in the order in which they are received.

Targets are listed by name, call sign or MMSI number, dependent on availability. If name has not been received, call sign will be used and failing that the MMSI number, which is always available.

Lost targets are annotated with 😱 and moved to the bottom of the list.

The target types include: Class A, Class B, Base Station, Aid to Navigation and Search and Rescue Transmitter.

Click the Dynamic, Static or Voyage bars in the side panel to display information relating to each target including:

<table>
<thead>
<tr>
<th>Dynamic</th>
<th>Static</th>
<th>Voyage</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIS Type (Class A, Class B etc.)</td>
<td>MMSI</td>
<td>Draft</td>
</tr>
<tr>
<td>Latitude \ longitude</td>
<td>IMO number</td>
<td>Destination</td>
</tr>
<tr>
<td>Position accuracy</td>
<td>Ship type</td>
<td>ETA</td>
</tr>
<tr>
<td>Range to own vessel</td>
<td>Call sign</td>
<td>Cargo \ activity</td>
</tr>
<tr>
<td>Bearing to own vessel</td>
<td>Vessel name</td>
<td>Persons on board</td>
</tr>
<tr>
<td>TCPA \ CPA</td>
<td>Length</td>
<td></td>
</tr>
<tr>
<td>UTC</td>
<td>Beam</td>
<td></td>
</tr>
<tr>
<td>COG, SOG and heading</td>
<td>Antenna position from port</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and bow</td>
<td></td>
</tr>
</tbody>
</table>
To Select an AIS target

You may wish to do this to view target information in the side panel and display the target log, open a chart to display the target or to delete a target.

To select a target

1. Ensure that you are in Target Tracking mode by clicking \( \text{Target Tracking} \) on the Display Toolbar, by choosing Target Tracking panel from the View menu, or by pressing <F12>.

2. Click on any target in the AIS side panel target list, or

3. Click on any target on the chart.

Activating Targets

You can set parameters to automatically activate targets as described below. If you wish to activate an individual target:

1. In the target list click the target you wish to activate and then click the checkbox or press the spacebar.

2. On the chart, click on a target to select it and then right click. From the menu that appears select Properties and then the AIS Target Summary tab. Select the Target Status field and change it’s setting from sleep to active.

On activation the target is enlarged and a COG \( \text{\&} \) SOG vector, heading marker and rate of turn indicator are displayed. If you have selected text labels they will be displayed. The target is displayed in true scale if the chart scale is large enough.

AIS alarms

When a target is lost a \( \text{\&} \) symbol is shown alongside the target name. You can acknowledge this alarm by selecting the target
with the alarm state and:

1. Clicking the symbol in the target list or
2. Pressing the letter A or
3. Clicking the **Acknowledge Alarm** button 📢 on the AIS toolbar or
4. Selecting **Target \ AIS \ Current Target \ Acknowledge Alarm**.

Once the alarm is acknowledged the Alarm state symbol changes in the target list changes to 📢.

### AIS system messages

When Navmaster receives an **ALR: Set Alarm State** sentence the message is placed in the **System Messages \ AIS** record as shown below. The message is not repeated for 30 minutes or until the message changes.

To view the window click the **Messages** symbol on the status bar or choose **System Messages** from the **View** menu and select AIS in the left hand column.

![System Messages](image)

### Changing Individual AIS Target Properties

To display individual target properties right click on a target on the chart, choose **Properties** from the menu and select the **AIS Target Summary** tab. To change settings select the item to change – options will appear on the right (if there are no options the item cannot be changed). Click **OK** or **Apply** to save your changes.
AIS Options

Overlays

Choose Options from the Target menu and select the AIS tab and then the Overlays tab.

**Text**

Check the labels, e.g. Name, Call sign, CPA, TCPA, Destination, you want to display alongside a target when it is activated.

**Vessel Fill**

Use the drop down list to set colour fill for scaled vessel outlines to hollow or 75% transparent.

**Path Predictor**
Check to display instead of the speed and direction vector when the target is activated or dangerous and COG, SOG and ROT are received.

<table>
<thead>
<tr>
<th>Symbol name and description</th>
<th>Symbol graphic(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.8 d Path predictor</td>
<td>AIS target path predictor:</td>
</tr>
<tr>
<td>Optionally, the user may select to display a path predictor in place of a velocity vector.</td>
<td>[Image of path predictor]</td>
</tr>
<tr>
<td>The path predictor shall be represented as a curved vector originating at the targets' tracked/reported position and extending along the predicted path over the ground that the target will travel, in the time interval used for the target vector.</td>
<td>[Image of path predictor]</td>
</tr>
<tr>
<td>The path shall be drawn using a thin long-dashed line style with the same basic colour used for target symbols.</td>
<td>[Image of path predictor]</td>
</tr>
</tbody>
</table>

**DISPLAY TURN INDICATOR**

Check to display for activated targets

<table>
<thead>
<tr>
<th>Symbol name and description</th>
<th>Symbol graphic(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.7 b Heading lines – turn indicators</td>
<td>[Image of turn indicator]</td>
</tr>
<tr>
<td>The user shall select to display turn indicators for activated AIS targets and associated targets represented by AIS target symbols.</td>
<td>[Image of turn indicator]</td>
</tr>
<tr>
<td>Turn indicators shall be presented as a single line extending at least 1 mm but not more than 2 mm perpendicular to the heading line in the direction of turn. The indicator shall be drawn using a thin solid line style with the same basic colour as used for their target symbols.</td>
<td>[Image of turn indicator]</td>
</tr>
<tr>
<td>Turn indicators for dangerous targets shall be the required colour red (until no longer dangerous) and shall flash with their symbol until acknowledged by the user.</td>
<td>[Image of turn indicator]</td>
</tr>
</tbody>
</table>

**TARGET PAST POSITIONS**

Check to display target past positions.

Check **Limit to previous** to limit past positions to the time specified in **Hrs: Mins**.
2.5 Target past positions

Optionally, target past positions may be shown.

Past positions shall be presented as a series of small circular symbols of 1 mm diameter. They may be connected by a line drawn from the current tracked or reported position of the target.

The line shall be drawn using a thin short-dashed line style with the same basic colour as their target symbols.

**DEFAULT**

Click this button to change all settings to their defaults.

**Activation**

Choose **Options** from the **Target** menu and select the **AIS** tab and then the **Activation** tab for AIS targets to be automatically activated based on:

- CPA \ TCPA
- Target Range
- Target Type

**Filter**

Choose **Options** from the **Target** menu, select the **AIS** tab and then the **Filter** tab for AIS targets to be filtered out based on:

- CPA \ TCPA
- Target Range
- Target Type

**AIS Setup**

Log into **Setup Mode** and choose **Setup** from the **Target** menu and then the **AIS General** tab for the following options.
Vessel Shape

Click **Symbol** to draw targets as a symbol only or **Automatic** for vessel to be drawn as a scaled outline when the chart scale is large enough.

Track

The time interval here determines how frequently a track point is stored and therefore the accuracy of each targets track. Set the time value low to see a more accurate track for all targets.

Quick View

**Quick View** turns on text labels against all or limited targets. The labels appear for the length of time set (from 5 to 60 seconds).

If **Display ALL information** is checked all text fields are shown, otherwise only text fields checked under **Options \ Target** are shown.

If **View Activated Targets only** is checked then text fields are only shown against activated targets.

Lost Targets

**SOUND AND DISPLAY ALARM**

Tick to sound an alarm if a target is lost within the range specified here.

**DELETE “LOST” TARGETS AUTOMATICALLY**

Check this box for targets to be deleted if data is not received for the time specified in **Time before delete lost target**. This time interval is triggered from the point that a target is lost. If this item is not checked targets must be deleted manually.
Navmaster accepts ARPA target information via NMEA data input. For information please refer to ARPA NMEA Sentences.

**ARPA Target Symbols**

To comply with IEC 62288, *Presentation of navigation-related information on shipborne navigational displays*, the following symbols are used in respect of ARPA targets

<table>
<thead>
<tr>
<th>Topic</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
</table>
| Tracked Target including Dangerous Target  | ![Symbol](image) | Solid filled or unfilled circle located at target position.  
The course and speed vector should be displayed as dashed line, with short dashes with spaces approximately twice the line width.  
Optionally, time increments, may be marked along the vector.  
For a “Dangerous Target”, bold, red (on colour display) solid circle with course and speed vector, flashing until acknowledged. |
| Target in Acquisition State                | ![Symbol](image) | Circle segments in the acquired target state.  
For automatic acquisition, bold circle segments, flashing and red (on colour display) until acknowledged. |
| Lost Target                                | ![Symbol](image) | Bold lines across the circle, flashing until acknowledged. |
| Selected Target                            | ![Symbol](image) | A square indicated by its corners centred around the target symbol. |
| Target Past Positions                      | ![Symbol](image) | Dots, equally spaced by time. |
| Tracked Reference Target                   | ![Symbol](image) | Large R adjacent to designated tracked target.  
Multiple reference targets should be marked as R1, R2, R3, etc. |
Interfacing to ARPA

To configure Navmaster to receive ARPA data please refer to allocating COM ports and configuring baud rate.

For information on ARPA NMEA sentences please refer to ARPA NMEA Sentences.

To save your settings permanently, see Workspace.

The ARPA Toolbar

The ARPA toolbar provides access to frequently used commands.

*Hide targets*

Click to temporarily hide ARPA targets from the display. Click again to restore targets and any history associated with them.
**Acknowledge alarm**

Click to acknowledge an alarm for the selected target.

**To Go to an ARPA target**

1. Click on the *Display Toolbar* to select the *Target Tracking* side panel.
2. Select the target you want to go to.
3. Click the on the *ARPA* toolbar

**Toggle Radar Cursor**

Provided that Navmaster is receiving NMEA sentence RSD from the ARPA, clicking will show or hide the radar cursor.

**The Target Tracking Side Panel**

Select the ARPA Target Tracking side panel by clicking on the Display Toolbar, by choosing *Target Tracking panel* from the *View* menu, or by pressing <F12>. Select the ARPA tab to view ARPA data.

To select any target, click its target number or click the target symbol on the chart. This will enable you to:

- View the data associated with the target (use the scroll bars to see any hidden information).
- Double click on the target number to open a chart displaying the target
- View a log showing data for the target
- Delete the target

**Delete**

Select any target and click *Delete* to remove it from the list
Changing Individual ARPA Target Properties

To display a target’s Properties right click on a target on the chart, and choose Properties from the menu (you must be in Target Tracking mode - click on the Display Toolbar.).

The Summary tab displays a target’s information and allows you to customise target characteristics.

ARPA Options

Choose Options from the Target menu and select the ARPA tab to set options.

Target

Text

Check Reference, Name, Number and Label to display these items alongside each target. Number is the number generated by the ARPA to identify individual targets. Label and name are (rarely) provided by the ARPA and may be blank.
**TRACK**

Check **Track** to display each target’s track.

Check **Limit to previous** to limit the track to the time specified in **Hrs:** **Mins**.

**DEFAULT**

Click this button to change all settings to their defaults.

**ARPA Setup**

Log into **Setup Mode**, choose **Setup** from the **Target** menu and select the **ARPA** tab to set options.

![ARPA Setup Interface]

**TRACK**

Click the spin buttons to change the interval at which position markers will be added and positions saved to the target log.

**DELETE ‘LOST’ TARGETS AUTOMATICALLY**

Check this box for targets to be deleted if they have been set as dangerous (lost) for the time specified in **Maximum time out limit** or if the target is given a “lost” status by the ARPA.
TotalTide Interface

Admiralty TotalTide is a tidal prediction program that provides a worldwide tidal height and tidal stream data prediction capability. The software automates the prediction process, eliminates the possibility of user error and provides an easy means of viewing both underkeel and overhead clearances.

PC Maritime offer a link to TotalTide’s tidal height and stream outputs directly from Navmaster. For this feature to be available, users must have activated a valid license for TotalTide, available from PC Maritime or your Admiralty chart agent.

For detailed information on the operation of TotalTide and the information provided, please refer to the TotalTide help system.

Note: it is not possible to run TotalTide as a standalone application and the TotalTide interface from Navmaster simultaneously.

Installing or renewing a TotalTide Licence Key

This can be done either from the Admiralty Digital Publications (ADP) CD or via Navmaster’s user interface. If you are installing the key via ADP please follow their instructions.

If you wish to install a new license key or renew a license key via Navmaster proceed as follows:

1. Close Navmaster and install the TotalTide application from the ADP CD.
2. Restart Navmaster and choose TotalTide from the Tools menu and then Licence Wizard.
3. Choose the appropriate action and follow the instructions that appear.

TotalTide Functions

The following functions are available from the Tools menu:
**DISPLAY DATA ON CHART**

Click to turn on or off display of the locations of tidal ports and streams. Double click on the tidal stream arrow or tidal port square to display the predictions for each location. Switch between the tabs for more detail.

**QUICK VIEW**

Click to turn on additional information for a limited time.
**DISPLAY PREDICTION TIME PANEL**

This panel shows the current prediction time as set in Tools \ TotalTide \ Options. If time is set to User Defined scroll buttons and date and time selectors become available so that you can change time here, as required.

*Note: you can reduce the size of TotalTide panels by double clicking on their borders and restore to full size by double clicking on the blue title bar.*

**DISPLAY FILTER PANEL**

Click to display a panel that lets you filter out port and stream information by country and data type. Simply clear the tick box to remove unwanted items from the display.

**DISPLAY TIDAL LIST PANEL**

Click to display a panel listing tidal ports. Double click on any port to show the predictions. Right click for a number of options including GoTo (that location).
**TotalTide Options**

From the **General** Tab you can change:

**DISPLAY OF PORT PREDICTION**

To show alongside the port the Tidal Event (eg time of high water) or Predicted Height (at high water)

**PREDICTED TIME ZONE**

Select Admiralty Time, Coordinated Universal Time or System Time as required. Admiralty Time is Standard Local Time Zone from Admiralty Tide Tables without adjustment for daylight saving time.

**QUICK VIEW**

**Quick View** turns on text information for the length of time set.

**PREDICTION TIME SOURCE**

Choose from Positioning System Time, Start Time from Current Plan, System Time and User Defined. If the latter is selected, turn on the
Display Prediction Time Panel so that the required date and time can be selected.

From the **Overlay** Tab you can change:

![Overlay Tab](image)

**TEXT**

Select 75% or 90% transparent to draw text on a transparent background.

Check the labels, e.g. **Name, Prediction**, to display during Quick View.

**TIDAL STREAMS**

Select 75% or 90% transparent to fill tidal stream arrows.

**MINIMUM SCALE**

Enter a scale against prediction text, Prediction Image and Station Symbol above which each item should not be drawn.

**Tidal Stream Atlas**

Proudman tidal stream is official tidal stream data to load into Navmaster. Proudman Oceanographic Laboratory, the UK’s tidal research centre, has validated every data point against observed currents. The minimum observation period at each data point is 30 days. When Proudman data is installed, Navmaster can display tidal atlases overlaid onto charts, rate & direction for any single point on a chart, and allow for tidal stream when calculating passage plans.

The following models are available:
**Standard Model – Continental Shelf**

Divided into nine areas, each area consists of a grid of data points every 12 km covering the whole of Western Europe.

**Fine Model – English Channel**

Available in three areas, the Fine Model provides much more data than the Standard Model, consisting of data points every 1.2km.

**Ocean Model – North East Atlantic**

Available in four different areas, the Ocean Model provides tidal data to a 35km grid.

**To Display a Tidal Atlas**

1. Choose **Display Tidal Atlas** from the **Tools** menu.

2. If you have a tidal data model for all or part of the current chart display, a tidal atlas will be drawn otherwise the option is greyed out.
3. To change the date and/or time either: click on the value you wish to change, click the spin buttons to increase or reduce, or click the down arrow for a calendar view and select a date. If the Apply Immediately box is checked, the atlas will update as you change time or date. If unchecked, click the Apply button when you want to view the atlas for the new time. The Caution button provides information about the tidal data model and any limitations.

4. Click Close when you are finished.

To Display Tidal Rate and Direction for A Single Point

1. Move the cursor to any position on the chart, right click and choose Tidal Stream from the menu. A panel will be displayed with a tidal arrow for the position. The Caution button provides information about the tidal data model and any limitations.

2. To change the date and/or time either: click on the value you wish to change, click the spin buttons to increase or reduce, or click the down arrow for a calendar view and select a date. If the Apply Immediately button is checked, the tidal vector will update as you change time or date. If left unchecked, click the Apply button when you want to view the tidal vector for the new time. The Caution button provides information about the tidal data model and any limitations.

3. Click Close when you are finished.
Tidal atlas options

Choose Options from the Tools menu and select the Tidal data tab or click the Options button on Tidal Stream controls to set options:

**LIMIT LINES**

Check this box to display the boundaries of tidal atlas models.

**TIDAL ARROWS**

By default the Length of the tidal arrow is scaled to 20 pixels per knot. You can change this setting if you require longer or shorter tidal arrows.

**LABELS**

Check Height to display the height above mean sea level by each arrow.

Check Speed to display the tidal rate alongside each arrow.

**TO SET THE TIME OF THE ATLAS DISPLAY**

Select one of:

<table>
<thead>
<tr>
<th>Time Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real time</td>
<td>The atlas is updated in real time</td>
</tr>
<tr>
<td>Use current</td>
<td>Time for atlas display is taken from the computer’s clock</td>
</tr>
<tr>
<td>Use start time from current plan</td>
<td>Time is taken from the departure or arrival time set for the current passage plan</td>
</tr>
</tbody>
</table>
User defined | You enter date and time as required.

**TO SET THE SPACING OF TIDAL ATLAS ARROWS**

This option defines the density of tidal arrow display. Set the slider towards **Low** if you want the arrows spaced widely or towards **High** if you want to see more arrows. The spacing will be consistent regardless of the scale of chart you are viewing. Note that it will take longer to draw a very detailed display. When drawing the Atlas Navmaster will examine the demand placed on the processor and automatically reduce spacing if necessary.

**Tidal arrow colour coding**

The tidal arrows drawn on the screen are colour-coded by Proudman to indicate their reliability, based on the number of data points used to calculate the tide at any point.

<table>
<thead>
<tr>
<th>Reliability</th>
<th>Colour</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Black</td>
</tr>
<tr>
<td>Medium</td>
<td>Blue</td>
</tr>
<tr>
<td>Low</td>
<td>Red</td>
</tr>
</tbody>
</table>

In some areas close inshore, the tidal prediction is so uncertain that no tidal arrows are displayed.

**Range and Bearing Tool (R&B)**

To measure distances and bearings on a chart.

1. Click ![Add](image) on the **Chart Toolbar** and select **Add** from the drop down menu for each R&B line you wish to draw.

2. Whilst you are drawing R&B lines, the letter E is added to the cursor thus, ![Cursor E](image) to indicate that normal cursor commands are suspended.

3. Move the cursor to the start point and left click.

4. Move the cursor to the end point and left click again.

5. Or move the cursor to the start point and drag the line to the end point and release to finish.

6. The drawing operation is complete and E is removed from the cursor.
To edit Range and Bearing lines

Whilst in R&B mode a left click will not reposition the chart, although the chart can be scrolled. If a R&B line is selected then a right click will display a menu for the selected line no matter where the cursor is on the chart.

To enter edit mode:

1. Click on the Chart Toolbar and select Edit mode from the drop down menu. The cursor changes to .

2. Click on the line to edit which will be marked by selection boxes as shown above. Click and hold on any of the selection boxes to move or rotate the line.

3. Right click on the line for a menu that will enable you to:
   - **Deselect** the currently selected line.
   - **Show Annotation** to turn on or off the range and bearing of the line.
   - **Ship Centred** to attach the line to vessel position (if available).
   - **Extend to Edge** to extend the end point of the line to the edge of the chart window (textual display of the line's range is turned off).
   - **Fixed End Position** to fix the line to its current end position. This option is only available if the line is Ship Centred and a vessel position is available. As the vessel moves, range and bearing labels are updated.
   - **Rotate** to rotate the line around its centre point.
   - **Delete** to delete the selected line.
• **Properties** to display a dialog that enables you to manually set range and bearing.

4. To exit R&B edit mode, click on the **Chart Toolbar** and select **Edit mode** from the drop down menu. The letter E is removed from the cursor.

To delete R&B lines either:

1. Select the line to delete, right click and select **Delete** from the menu.
2. Click the R&B button and select **Delete all** from the menu.

**Voyage Data Recording**

This is an optional module that can be added to Navmaster. Please contact PC Maritime if you wish to take up this option.

*Note: this feature does not meet carriage requirements for Voyage Data Recording as defined by IMO regulations.*

**Objective**

- To record and archive sensor inputs to Navmaster without the need for operator action.

- To provide replay of data for analysis, training or presentation.

**Background**

Sensor input data is received by Navmaster in a standard protocol - NMEA 0183. Typically this includes GPS, Gyro heading, speed log, ARPA and AIS data.
The data is recorded at the COM port level. Therefore even if the operator has not activated ARPA or AIS target display, data is recorded and can be replayed. **Note that one instrument per COM port must be set to Receive or Transmit in Navmaster for data to be recorded.**

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Connected to:</th>
<th>Navmaster setting</th>
<th>Data recorded</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPS</td>
<td>COM 1</td>
<td>COM 1</td>
<td>Yes</td>
</tr>
<tr>
<td>ARPA</td>
<td>COM 1</td>
<td>OFF</td>
<td>Yes</td>
</tr>
<tr>
<td>GPS</td>
<td>COM 1</td>
<td>COM 1</td>
<td>Yes</td>
</tr>
<tr>
<td>ARPA</td>
<td>COM 2</td>
<td>OFF</td>
<td>NO</td>
</tr>
</tbody>
</table>

All Navmaster features can be used during voyage replay to manipulate the chart, change vectors and overlays, display and interrogate targets etc.

**Benefits**

The recorded data is the actual data received during a voyage. Therefore the voyage can be reconstructed in real time, speeded up or slowed down. Position, COG & SOG from the GPS and heading from the Gyro enable the vessel outline with heading marker and direction vector to be displayed and manipulated for analysis. The tracked target table from ARPA allows other vessels to be displayed with their positions, tracks, CPAs, TCPAs etc. Logs of individual targets can be shown as below.
The key benefits are:

1. Documentary proof of what happened in the run up to an incident.

2. Post incident analysis

As shown above, own ship’s position can be played as well as all tracked targets. The data allows reconstruction and analysis of own track and target tracks.

The chart display can be printed via normal Windows routines. A screen capture program (such as Paint Shop Pro) can be used to capture and annotate portions of the display.

3. Training

Common manoeuvres can be recorded (eg berthing or transiting difficult sections of a passage) and used in training and familiarising new personnel.
Voyages can be replayed for crew training and for system familiarisation.

4. Risk Assessment

Management can assess, in the office, risk areas for their routes based on recorded voyage data.

5. Navmaster in the office

The parameters for each ship can be stored in the office so that they can be imported when required.

In addition, Navmaster in the office provides a wide range of benefits including planning, risk assessment, emergency response and presentation to potential customers and other interested parties.

To activate Voyage Data Recording (VDR)

Voyage Data Recording is activated by specific programming of Navmaster’s security key (dongle). Once the dongle is programmed to activate VDR it cannot be deactivated.

To set VDR Storage Limits

Data is recorded at all times when Navmaster is running. To automatically erase data from the hard disk after a defined interval:

Choose Voyage Data Recording from the Tools menu and select the Recording tab.

1. Tick Erase Interval and click the spin arrows to select the number of days after which data is erased.

2. Tick Capacity Check and click the spin arrows to select a number of Megabytes, which if exceeded, erases the oldest data.

3. Click Apply to save the settings and OK to close the dialog.

4. To save your changes permanently, see Workspace.
To recover VDR data from a ship

In addition to recovering data it is advisable to save the ship’s workspace so that voyages can be replayed with the same parameters used onboard. To do this:

1. On the ship, choose Workspace from the file menu and select Export.
2. This will save a file named Registry x.txt where x is a number incremented by 1 each time the registry is exported.

The files and folders that should be copied are the ship’s:

<table>
<thead>
<tr>
<th>Registry (setup) file</th>
<th>C:\Program Files\Navmaster\Registry x.txt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chartpoints</td>
<td>C:\Program Files\Navmaster\Chartpoints</td>
</tr>
<tr>
<td>Routes</td>
<td>C:\Program Files\Navmaster\Routes</td>
</tr>
<tr>
<td>Logs</td>
<td>C:\Program Files\Navmaster\Logs</td>
</tr>
<tr>
<td>VDR</td>
<td>C:\Program Files\Navmaster\VDR</td>
</tr>
</tbody>
</table>

For example, if using Ahead Nero to burn to CD the project could look like this:

We recommend you create a Nero folder named–Shipname date and copy the Chartpoints, Logs, Routes, VDR folders and Registry file as shown above.

Copying data to an “Office” PC

To keep data separate from any Chartpoints, Routes etc that you have created on the Office PC we suggest you use Windows Explorer to copy the CD created above to C:\Program Files\Navmaster\VDR as shown.

Alternatively the data can be replayed direct from a CD.
Replaying Voyage Data

The following instructions assume knowledge of the general operation of Navmaster when undertaking a voyage. Before replaying data:

1. Import the ship’s workspace by choosing Workspace from the File menu and selecting Import. Navigate to the folder containing the Registry file to be imported, select it and click OK.

2. Ensure that a chart window is open.

3. When data is replayed click the Position Monitoring button to open a chart window to automatically plot vessel position.

To replay voyage data:

The Playback tab is hidden during normal operation so you must first log into Setup Mode to display it.

Then choose Position Source from the Navigator menu, click OFF and click Apply.

To replay voyage data:

1. Choose Voyage Data Recording from the Tools menu and select the PlayBack tab.

2. Uncheck All archives (if checked) and click to select the folder containing VDR data.

3. Select the first archive file (if All archives are to be replayed) or an individual archive file in the dialog and click Open.

4. Tick All archives to replay all files from the beginning.

5. Click Play to start voyage replay.

6. If the data does not display automatically choose Position Source from the Navigator menu, click NMEA (or AIS if replaying AIS only data) and click Apply.
7. Click **Pause** to pause voyage replay.

8. Click **Fast Forward** to speed up voyage replay.

9. Click the down arrow alongside **Fast Forward Rate** to change fast forward speed.

10. In each case click **Apply** to activate the change.

**TO RESTART REPLAY OR TO REPLAY A DIFFERENT ARCHIVE:**

1. Keep the Voyage Data Recording dialog on display.

2. Choose **Position Source** from the **Navigator** menu, click **OFF** and click **Apply**.

3. Ensure that the **Play** button is not depressed.

4. Select the archive you wish to play in the **Voyage Data Recording** dialog and click the **Forward** button.

5. Click **NMEA** (or **AIS** if replaying AIS only data) in the **Position Source** dialog and click **Apply**. Close the **Position Source** dialog if you are finished with it.

**VDR File Structure**

When recording, data is saved to an individual file every five seconds. Every hour, or on exit from Navmaster, the files are compressed and archived into a single archive file as shown below:
The filename, using the first file in the list above is made up as follows:

<table>
<thead>
<tr>
<th>2002</th>
<th>07</th>
<th>16</th>
<th>16</th>
<th>58</th>
<th>46</th>
<th>.archive</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>Month</td>
<td>Date</td>
<td>Hrs</td>
<td>Minutes</td>
<td>Seconds</td>
<td>suffix</td>
</tr>
</tbody>
</table>

The filename gives the time at the beginning of the time slice. The date and time as shown in Windows Explorer represents the end of the time slice.

**Opening Ship’s Chartpoint, Route or Log databases**

If you have copied the above databases as described above the databases will not be in the default location.

To load any of these databases:

1. Choose **Open** from the **File** menu and select the folder to look in (Chartpoint, Route or Log).

2. Click [ ] and choose the location of the database you wish to load (e.g., C:\Program Files\Navmaster\VDR\Cymbeline 18-7-02\Chartpoints) and click OK.

**Mariner Overlays**

Mariner Overlays provide tools to draw lines and highlight areas for passage planning and route monitoring.

Mariner Overlays can be drawn on any type of chart (ARCS, ENC or CM-93/3) however they are of particular value when operating with ARCS charts since they provide the mechanism to enable Navmaster to emulate some of the alarms and warnings automatically generated by ENC and CM-93/3 vector chart data.
Lines, areas and points can be set to activate an alarm based on a preset distance or time to the overlay. An alarm can also be given if an area is entered or exited or a line is crossed. All alarms are automatically logged with position and timestamp (provided that logging is on).

Mariner Overlays are created in groups and automatically saved so that different sets of overlays can be defined and turned on / off. There is a GoTo facility to load the best chart for an individual overlay.
Creating and managing Mariner Overlays

1. From the **Tools** menu choose **Mariner Overlays**.

   A ‘List of current Overlays’ is provided for existing overlays organised as follows:
   
   - **Type**: e.g. polygon, text, point etc. Click the + or - sign alongside each type to expand or collapse the list. Each overlay is identified by any text associated with it or by “No note” if appropriate.
   - **Category**: States whether a given overlay is a Danger Highlight (alarmed) or Simple (non alarmed).
   - **Created Time**: lists the date and time the overlay was created.
   - **Last Modified Time**: lists the date and time an overlay was last changed.

2. To start a new group click **New** and enter a name for the overlay.

3. To rename a group click **Rename** and enter a name for the overlay.

4. To close a group click **Close**.

5. To delete a group click **Delete**.

6. To open an existing group click the down arrow alongside the group name and select the required group.

7. To delete an individual overlay select an overlay and click ![x] to the right of List of Current Overlays for [overlay name] and click **Apply**.
8. To open the best available chart for an overlay, select the overlay and click GoTo.

9. To show or hide an overlay, tick or untick the box alongside the overlay type or name and click Apply.

**Drawing Mariner Overlays**

![Drawing Mariner Overlays](image)

**EDIT**

If this button is greyed out it is because a Mariner Overlays group has not been created, or opened, see **Creating and managing Mariner Overlays** above for details.

Click the Edit button to enter the drawing and editing mode. Whilst in Edit mode, the cursor is displayed thus: ![Edit Cursor]. Click the Edit button when you have finished to return to normal operation.

When adding overlays, click OK in the Properties dialog to save it or Cancel to abandon the overlay.

**HIDE**

Click Hide to temporarily remove / restore overlays from the chart.
**Overlay Properties**

Click any button and a Properties dialog as shown to the right is displayed. The properties dialog is similar for each type of overlay and contains:

1. An area for you to enter text. Press <ENTER> to enter a line break.
2. A tick box to determine whether to display the text on the chart,
3. A set of attributes to apply to the overlay. Depending on the type of overlay the list may include:

   **Type:** Simple (yellow and alarmed), Danger Highlight (red and alarmed) and Clearing line.

   **Labels etc** to set labels such as bearings on or off.
**Flashing**: to determine whether the overlay flashes on screen. An overlay set to flash flashes once a second. An overlay whose alarm has been triggered flashes twice a second.

**Maximum Scale** (SCAMAX) specifies the largest display scale at which the object will be drawn. For example, an object with a SCAMIN value of 10,000, indicating a scale of 1/10,000, will not be drawn on a display of 1/8,000.

**Minimum Scale** (SCAMIN) specifies the smallest display scale at which the object will be drawn. For example, an object with a SCAMIN value of 50,000, indicating a scale of 1/50,000, will not be drawn on a display of 1/60,000.

To add a point overlay

- Click the Point button
- Left click at the required place on the chart. Repeat for as many points as you require.
- In the **Properties** dialog:
  - Type any text required.
  - Set type to **Simple, Danger** (alarmed), **Critical Point**
  - Select the desired symbol from the drop down list (by default CHINFO09, Mariners Caution Note). For example, if you wish to display a wreck symbol, click the drop down list next to symbol, press the W key, scroll down to WreckS01 and select it. The symbols used here are the chart symbols as displayed in ECDIS Chart 1 (available from the Help menu). You can view the symbols on ECDIS Chart 1 and identify its name by right clicking on the symbol and selecting Properties.
  - Complete SCAMAX and SCAMIN values if required.

To move a Point, close the properties dialog, left click to select it and drag to the new position.
TO ADD A LINE OVERLAY

- Click the Line button.
- Move the cursor to the origin of the line and left click. Move the cursor to the destination of the cursor and left click again. Repeat for as many points as your require.
- In the Properties dialog:
  - Type any text required.
  - Set type to Simple or Clearing Line (only clearing lines can be alarmed).
  - Select whether you require the line to be labelled with Distance, Bearing or Reciprocal Bearing.
  - If a Clearing Line set whether the line is to be labelled Not More Than (NMT) or Not Less Than (NLT) if is to be labelled as such.
  - Complete SCAMAX and SCAMIN values if required.

To move a line, left click to select it. Click and drag any selection box to the position required and release.

TO ADD A POLYLINE OVERLAY

A PolyLine consists of multiple line segments joined together.

- Click the PolyLine button.
- Left click each point to draw the PolyLine. Double click on the last point to complete the PolyLine.
- In the Properties dialog:
  - Type any text required.
  - Set type to Simple or Danger Line (alarmed).
  - Select whether you want the line to flash.
  - Complete SCAMAX and SCAMIN values if required.

To move a PolyLine, left click to select it. Click and drag any selection box to the position required and release.
**TO ADD A POLYGON, BOX OR CIRCLE OVERLAY**

- Click the Polygon, Box or Circle button.
- For a polygon left click to draw the points of the polygon and double click when finished. For a box or circle left button click at the intended centre of the box or circle and drag the cursor out to define its size. Left click again to finish.
- In the Properties dialog:
  - Type any text required.
  - Set type to **Simple** or **Danger Highlight** (alarmed).
  - Select whether you want the line to flash.
  - Complete SCAMAX and SCAMIN values if required.

To move a Polygon, Box or Circle left click to select it. Click and drag any selection box to the position required and release.

**TO ADD A RANGE MARKER**

Range markers can be used for a number of purposes including to mark the rising or dipping limits of navigational lights.

- Click the Range Marker button.
- Left click on the origin point of the range marker.
- In the Properties dialog:
  - Type any text required.
  - Select want an ARC or circle displayed.
  - Specify the bearing and distance of the range marker.
  - Complete SCAMAX and SCAMIN values if required.

You cannot move a Range Marker.

**TO ADD A TEXT, INFORMATION OR CAUTIONARY NOTE OVERLAY**

- Click the Polygon, Box or Circle button.
- In the Properties dialog:
  - Type any text required.
  - Complete SCAMAX and SCAMIN values if required.
To move a Point (after it has been created) left click to select it and drag to the new position.

On completing an overlay you can carry on drawing the next overlay without closing the Overlay Properties dialog. Click OK for the last overlay you are drawing – clicking Cancel will abandon the current overlay.

Click the Overlay Mode button when you have finished drawing.

**To Edit existing Mariner Overlays**

You can change an overlay after it has been created as follows:

1. Display the Mariner Overlays toolbar and click the Edit button.

Right click on any overlay and select Properties. Depending on the overlay you have selected, there will be a tab displaying its attributes. From this dialog you can change the overlay type (for example from line to clearing line), turn on or off labels etc. Click Apply to activate your changes.

2. The overlay’s selection points will be outlined. Click and drag any of the selection points to a new location to adjust its shape or direction.

3. Click the Overlay Edit button when you have finished.

**Route Monitoring with Mariner Overlays**

Mariner Overlays can be set to generate alarms when a vessel is a preset time or distance away. See position monitoring alarms for more information.
To activate alarms select **Options** from the **Vessel** menu and select **Warnings**. Tick **Mariner Overlay Alarms** and tick either **Distance** or **Time** or both.

Alarms are given as follows:

<table>
<thead>
<tr>
<th>Overlay</th>
<th>Type</th>
<th>Alarm message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Clearing Line</td>
<td>Approaching clearing line</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clearing line crossed</td>
</tr>
<tr>
<td>Poly</td>
<td>Simple</td>
<td>Approaching danger line</td>
</tr>
<tr>
<td>Line</td>
<td></td>
<td>Danger line crossed</td>
</tr>
<tr>
<td>Polygon</td>
<td>Danger Highlight &amp;</td>
<td>Approaching danger area</td>
</tr>
<tr>
<td></td>
<td>Flashing Danger</td>
<td>Danger area entered</td>
</tr>
<tr>
<td></td>
<td>Highlight</td>
<td></td>
</tr>
<tr>
<td>Box</td>
<td>Danger Highlight</td>
<td>Approaching danger area</td>
</tr>
<tr>
<td></td>
<td>Flashing Danger</td>
<td>Danger area entered</td>
</tr>
<tr>
<td></td>
<td>Highlight</td>
<td></td>
</tr>
</tbody>
</table>

A window is displayed when an alarm is activated and the event is entered in the logbook with position and timestamp. An overlay whose alarm has been triggered will flash twice a second. Overlays set to flash do so at a frequency of once a second; in the alarm state this will increase to twice a second.

**Mariner Tools**

Mariner Tools are temporary objects that are provided for chartwork and route monitoring. There is no limit to the number of objects that can be created at any time.
Using Mariner Tools

EDIT

Click the **Activate Mariner tools** button to enter the drawing and editing mode. Whilst active, the cursor is displayed thus: ![cursor](image). Click the **Activate Mariner tools** button when you have finished to return to normal operation.

**TO DELETE MARINER TOOLS**

When you click any tool button a menu appears. Each menu has an option to delete all existing overlays of the type associated with the button.

**TO HIDE ALL MARINER TOOLS**

Click ![hiding](image) to temporarily remove Mariner Tools from the chart. Click ![restoring](image) again to restore them.

**TO ADD A VARIABLE RANGE MARKER (VRM)**

- Click ![VRM](image).
- A menu will appear to allow you to:
  - **Add ship-centred VRM** if there is a valid ship's position. Selecting this option places the VRM centre point on the ship.
  - **Add free-movable VRM**: select this option and left click at the required centre point of the VRM.
- Move the cursor to create the required size of the VRM and click when finished.
The dialog above is displayed to enable you to manually enter a range and concentric radius if you wish. Click OK when finished.

After a VRM has been created, left click to select it and then right click to:

- Deselect:
- Show Annotation: to display radius (always displayed when selected).
- Ship Centred: to make the VRM ship centred or if deselected, free moveable.
- Show Concentric Rings: to display concentric rings as per the parameter entered in the dialog above.
- Delete: to delete the selected VRM.
- Properties: to display the selected VRM.

To resize a VRM either:

1. Enter a new radius in the Properties dialog.
2. Left click on one of the outside selection boxes and drag to the required size.

To move a VRM, click and hold the centre selection box and drag to the new location.

**TO ADD AN ELECTRONIC BEARING LINE (EBL)**

You can create three types of EBL:

- Free-movable EBL
- Ship-centred EBL: (if there is a valid ship’s position). Selecting this option places the EBL start point on own vessel.
- Fixed End Position: (if ship-centred EBL selected) to provide a range and bearing from the vessel to a fixed point on the chart.
To create a Free-movable EBL:

- Click 
- Click **Add free-movable EBL**
- Left click at the origin of the EBL, move the cursor to the end of the EBL and left click again.

To create a ship-centred EBL:

- Click 
- Click **Add ship-centred EBL**
- Move the cursor to the end of the EBL and left click.

A dialog is displayed to enable you to manually enter a range and bearing if you wish. Click OK when finished.

To create a fixed point EBL:

- Create a ship-centred EBL as described above.
- Click **Add ship-centred EBL**
- Move the cursor to the point you wish to fix the EBL, right click and select **Fixed end position** from the menu that appears.

After an EBL has been created, left click to select it and then right click to:

- **Deselect:**
- **Show Annotation:** to display range and bearing.
- **Ship Centred:** to make the EBL ship centred or if deselected, free moveable.
- **Extend to Edge:** to extend the end point of the EBL to the edge of the chart window.
- **Fixed End position:** to fix the end point of a ship centred EBL.
- **Rotate:** to pivot the EBL around the centre point (not available if the EBL is ship centred). Click and hold the left mouse button on one of the end selection boxes and drag the cursor to the new position and release.
- **Delete**: the selected EBL.
- **Properties**: to display the EBL properties dialog.

To move an EBL click and hold the centre selection box and drag to the new location.

To move an EBL end point, click and hold an end point selection box and drag to the new location.

**ADD PARALLEL INDEX LINES (PI)**

A valid own vessel position is required to add parallel index lines.

**To create a PI:**

- Click.
- Click **Add PI**, move the cursor to the point where you want to add the PI and click. To adjust the position of the PI, click the centre selection box and drag to the new location.
- The dialog above will appear to enable you to adjust the distance of the PI from the ship and to enter an angular offset. At 0 degrees the PI remains parallel to the vessel’s heading.
- After a PI has been created, left click to select it and then right click to:
  - **Deselect**:
  - **Show Annotation**: to display the range from own vessel.
  - **Rotate**: to rotate the PI via the screen cursor.
  - **Extend To Edge**: to extend the PI to the edge of the chart window.
- **Delete**: to delete the currently selected PI.
- **Properties**: to display the properties dialog.

To move a PI end point, click and hold an end point selection box and drag to the new location.

To adjust the range of the PI from the vessel, click and drag the centre selection box to the required position.

To **Rotate** the PI, select it, right click to display the Properties menu and select **Rotate**. Drag the rotate “handle” (drawn from the conning position) to orientate the PI to the required angle.

**TO ADD LINES OF POSITION (LOP)**

The LOP tool is provided to enable visual bearings, radar ranges and transferred position lines to be used to plot DR, EP and other position fixes and / or to verify the accuracy of electronic position fixing systems.

**To add a LOP:**

- Click ![Add LOP](image)
- Click **Add LOP**, move the cursor to the point where you want to add the LOP and click. A dialog will appear where you can enter a Name (optional), range and bearing to the object. If range is left at 0, the position line is drawn to the edge of the chart window. If a range is entered the position line is drawn for the length specified. You can change the time stamp for the LOP and adjust its origin, now but not after you click OK.
To add a range mark:

- Click \[ \text{Add LOP} \].

- Click Add LOP, move the cursor to the point where you want to add the range and click. A dialog will appear where you can enter a Name (optional), distance and bearing to the object. If distance is entered and bearing is left blank, a range ring is drawn. You can also change the time stamp for the LOP and adjust its origin now, but not after you click OK.

To calculate a position fix:

Provided that you have created two or more position lines, click the LOP button and select Calc Position Fix. This will calculate and display the fix as shown. Before accepting the fix, select the Type of Position Fix from the drop down list and adjust the time stamp and position if necessary in the Confirm Position Fix dialog. Once you accept the fix, the symbol will change to show the type and time of fix and, if you are connected to a position fixing device, or running a DR plot, the position will be saved in the log. You can, at this point, delete the position lines if they are no longer required.
**To transfer a position line:**

Click on the position line you wish to transfer and select Transfer. Enter course and speed (over the ground) and the time stamp for the transferred position line.

**To add a man overboard event (MOB)**

The MOB button, due to its importance, is always enabled if a vessel position is available, even when Mariner Tools are not active. It is also available from the Chart Toolbar or by pressing <F2>.

To add a man overboard event:

- Click on the Mariner Tools or Chart toolbar.
- An event marker is placed at the current vessel position and the MOB properties dialog is opened.
- A line is drawn and constantly updated from the vessel's position to the MOB event with range, bearing and reciprocal bearing to the MOB event.
The dialog above appears to allow you to:

- **Adjust Position**: the default is the position at which the MOB event was triggered.
- **Change Annotation Text**: click in this field to change the text.
- **Change Event Time**: click in this field to change the time (you cannot change the date).
- **Change Event Name**: click in this field to enter text.

After a MOB event has been created, left click to select it and then right click to:

- **Deselect**: 
- **Show Annotation**: to display the annotation text.
- **Show Overlay Tool Time**: to display the event time and date.
- **Delete**: to delete the MOB event.
- **Properties**: to display the MOB Properties dialog.

**Note**: You can only select a MOB event or change its properties if Mariner Tools are active.

To move a MOB event, left click to select it and drag to the new position.

The MOB event is a subset of the Event tool, so to delete all MOB events in one operation select **Delete ALL Events** from the Add Event button.

**TO ADD AN EVENT**

- **Click**.
- Left click at the position you want the event placed.
• The **Properties** dialog will appear to allow you to:
  
  • Adjust **Position**.
  
  • Change **Annotation Text**: click in this field to change the text.
  
  • Change **Event Time**: click in this field to change the time (you cannot change the date).
  
  • Change **Event Name**: click in this field to enter text.

After an Event has been created, left click to select it and then right click to:

• **Deselect**:

• **Show Annotation**: to display the annotation text.

• **Show Overlay Tool Time**: to display the event time and date.

• **Delete**: to deletes this Event.

• **Properties**: to display the Event Properties dialog.

To move an event, left click to select it and drag to the new position.

**TO ADD A POSITION MARK**

• Click ![Image](image1.png).

• Click **Add DR Position** or **Estimated Position** or **Position Fix** depending on your requirement (the only difference between them is the position mark that is placed by default).

• Left click at the position you want the position mark placed.

• The dialog above will appear to allow you to:
• Change **Mark type** by selecting a different type from the drop down list. Each mark is annotated to identify its type and is time stamped. For example a radar fix is shown thus.

• Change **Position Time**: click in this field to change the time (you cannot change the date).

• Change **Position**

After a Position Mark has been created, left click to select it and then right click to:

• **Deselect**

• **Add Log Entry**: to record the position fix in the logbook

• **Delete**: to delete the current mark

• **Properties**: to display the Position Mark Properties dialog.

To move a position mark, left click to select it and drag to the new position.

**TO ADD A POSITION LINE**

• Click 

• Click **Add Position Line** or **Transferred Position Line** (the difference between them is that the transferred position line is annotated with **TPL**).

• Left click at the origin point, move the cursor to the end of the line and left click again.
A dialog is displayed to enable you to manually enter a range and bearing and adjust position time. Click OK when finished.

After a Position Line has been created, left click to select it and then right click to:

- **Deselect.**
- **Show Bearing and Reciprocal:** to display these values against the line.
- **Rotate:** to pivot the position line around its centre point. Click and hold the left mouse button on one of the end selection boxes and drag the cursor to the new position and release.
- **Extend To Edge:** to extend the position line to the edge of the chart window.
- **Delete:** to delete the current position line.
- **Properties:** to display the Position Mark Properties dialog.

The **Position Time** text field is always displayed on the chart.

To move a position line, click and hold the middle selection box and drag to the new location.

To move a position line end point, click and hold an end point selection box and drag to the new location.

**TO ADD A TIDAL STREAM VECTOR**

- Click .
- Click **Add Predicted Tidal Vector** or **Add Actual Tidal Vector**.
- Left click at the position where you want the tidal vector to be placed.
The Properties dialog appears to allow you to:

- Enter tidal rate and direction
- Change Position Time: click in this field to change the time (you cannot change the date).
- Change Position

A predicted tidal vector is annotated with the character P and its vector line is dashed. An actual tidal vector is annotated with the character A and its vector line is solid.

After a Tidal Vector has been created, left click to select it (on the tidal vector, not the annotation box) and then right click to:

- Deselect
- Delete: to delete the selected tidal vector.
- Properties: to display the Tidal Vectors dialog.

To move a tidal vector, left click to select it and drag to the new position.
Datum Transformations

Choose **Launch Geotrans** from the **Tools** menu to run Geotrans, a datum transformation utility provided by the US Army Topographic Engineering Centre.

Refer to Geotrans’ Help system for instructions on how to use the program.

**Calculator**

Choose **Launch Calculator** from the **Tools** menu to run the Windows™ calculator.
On Screen Keyboard

Choose Launch On Screen Keyboard from the Tools menu to run the Windows™ keyboard.

Magnetic Variation Calculator

This function calculates Magnetic Variation for the current PC system time at any position on the chart. The calculation is provided for dates between 2005 and 2014 and should be accurate to within half a degree except in high latitudes. The calculation is independent of the charts you have installed.

Magnetic anomalies are often reported for specific regions of the world and these are usually printed on charts. This model cannot take into account the possibility or presence of magnetic anomalies.

For information on the limitations of this model please refer to http://www.ngdc.noaa.gov/IAGA/vmod/igrfhw.html

An upgrade, which will be valid for a further five years, will be required for calculations beyond the end of 2014.

To calculate magnetic variation for a position

1. Right click anywhere on a chart.
2. Magnetic Variation for that position is displayed in the menu. Press <ESC> or click the mouse outside the menu area to remove the menu from the screen.

Note: Always check magnetic variation calculations against other sources of data, such as official charts, before using them in passage making.
Own Ship Symbols

To comply with IEC 62288, *Presentation of navigation-related information on shipborne navigational displays*, the following symbols are used.

<table>
<thead>
<tr>
<th>Symbol name and description</th>
<th>Symbol graphic(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1.1 a</strong> Own ship – true scaled outline</td>
<td><img src="SN243" alt="Symbol Graphic" /></td>
</tr>
<tr>
<td>The user may select to present own ship as a true scaled outline oriented in the direction of heading relative to CCRP and drawn using a thick solid line style with the same basic colour used for own ship symbols.</td>
<td></td>
</tr>
<tr>
<td>Automatic selection of the true scaled outline is permitted (see 5.1.1).</td>
<td></td>
</tr>
<tr>
<td>The true scaled outline shall not be used when heading is unknown in a gyro/THD-stabilised mode, or when the beam of the outline is less than 6 mm.</td>
<td></td>
</tr>
<tr>
<td>In the radar mode, the true scale outline shall be used together with own ship minimised symbol.</td>
<td></td>
</tr>
<tr>
<td><strong>NOTE</strong> A loss of heading will force the radar into head-up mode (see IEC 62288); in this case, the true scaled outline is still permitted.</td>
<td></td>
</tr>
</tbody>
</table>

<p>| <strong>1.1 b</strong> Own ship – simplified symbol | <img src="SN243" alt="Symbol Graphic" /> |
| If a navigation display presents the chart mode (with or without the radar image), a simplified symbol may be used for own ship. The simplified symbol may be combined with the minimised symbol (see 1.1c). |
| A simplified symbol shall be used when a chart is displayed in north-up presentation, without a radar image and in the absence of heading information. |
| The outer circle shall be 6 mm in diameter. The inner circle shall be 3 mm in diameter. The circles shall be drawn using a thick solid line style, with the same basic colour used for own ship symbols. |
| <strong>NOTE</strong> For a radar mode, the simplified symbol should not be used as the symbol does not permit the minimum range requirements in IEC 62288. |</p>
<table>
<thead>
<tr>
<th></th>
<th>Symbol name and description</th>
<th>Symbol graphic(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.2</td>
<td><strong>Radar antenna position</strong>&lt;br&gt;If a radar image is displayed and own ship is displayed as a true scaled outline, the user may select to present the radar antenna position as crossed lines centred at the physical location of the radar antenna (the source of the displayed radar image). The total extent of the crossed lines shall be at least 1 mm but not more than 2 mm in length. They shall be drawn using a thin solid line style with the same basic colour used for own ship symbols.</td>
<td><img src="SN243" alt="Symbol graphic" /></td>
</tr>
</tbody>
</table>
| 1.3 | **Own ship heading line**<br>The heading line shall always be indicated (except when temporarily suppressed by the user), originating at CCRP and extending in the direction of own ship heading to the bearing scale. The line shall be drawn using a thin solid line style with the same basic colour used for own ship symbols. | ![Symbol graphic](SN243)  
The heading line shall always be shown together with the beam line (see 1.4). |
| 1.4 | **Beam line**<br>The beam line forms part of the own ship minimised symbol. Own ship beam line shall be presented as a single line, perpendicular to the heading line, passing through the CCRP and extending a minimum of 5 mm each side of the CCRP. The line shall be drawn as a thin solid line style with the same basic colour used for own ship symbols. | ![Symbol graphic](SN243)  
(SN243) |
<p>| 1.5 a | <strong>Velocity vector</strong>  Bravely, the user may also select to present a velocity vector originating at CCRP and extending in the direction of CGG or CTW, as appropriate, for a length representing the distance own ship will travel in a user-selected time interval. The vector shall be drawn using a thick short-dashed line style with the same basic colour used for own ship symbols. | <img src="SN243" alt="Velocity vector" /> |
| 1.5 b | <strong>Velocity vector – time increments</strong>  Optionally, the user may also select to present time increments along the velocity vector perpendicular to the vector with their midpoint on it and extending not more than 1.5 mm on either side. They shall be spaced along the vector to represent the distance own ship will travel in a user-selected increment of the time interval used for the velocity vector. The increments shall be drawn using a thick solid line style with the same basic colour used for own ship symbols. | <img src="SN243" alt="Velocity vector increments" /> |
| 1.5 c | <strong>Velocity vector – Stabilisation indicator</strong>  Optionally, the user may select to present a stabilisation indicator, positioned at the end of the velocity vector.  The ground stabilisation indicator shall be presented as a double arrowhead. The water stabilisation indicator shall be presented as a single arrowhead. The arrowheads shall extend at least 1 mm but not more than 1.5 mm on either side of the vector (i.e., measured perpendicular to it).  The arrowhead(s) shall be drawn using a thick solid line style with the same basic colour used for own ship symbols. | <img src="SN243" alt="Velocity vector stabilisation" /> |</p>
<table>
<thead>
<tr>
<th>1.7 a</th>
<th>Symbol name and description</th>
<th>Symbol graphic(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Past track</td>
<td>The user may select to present a past track for the primary and/or secondary positioning sources. The past track shall be presented as a line connecting own ship current and past positions. The primary past track shall be drawn using a thick solid line style with the same basic colour used for own ship symbol. The secondary past track shall be drawn using a thin solid line style with the same basic colour used for own ship symbols.</td>
<td>(SN243)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>1.7 b</th>
<th>Past track – time increments</th>
<th>(SN243)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optionally, time increments along the past track may be shown. The time increments shall be presented as single lines perpendicular to the past track with their midpoint on it and extending at least 1 mm but not more than 1.5 mm on either side. They shall be spaced along the past track to represent the distance own ship travelled in the user-selected increment of the time interval used for the velocity vector. The time increments for the primary past track shall be drawn using a solid line style.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| 1.7 c | Past track – past positions | |
|-------|-----------------------------| |
| Alternatively, the user may select to present past positions along the past track in place of time increments. Past positions shall be drawn as small filled circular symbols with a diameter of not more than 1.5 mm, with the same basic colour used for own ship symbols. | |
Vessel Options

Overlays

Choose Options from the Vessel menu and select the Overlays tab to set:

- Vessel Shape select:
  - Symbol to always draw vessel position as two concentric circles.
  - Automatic for vessel to be drawn as a scaled outline or two concentric symbols, depending on the scale of the chart.

- Vessel fill
  Use the drop down list to set colour fill for the scaled vessel outline to hollow or 75% transparent.

- Speed and Direction vector
  This tick box turns on or off a course and speed vector (based on COG & SOG received from GPS) for own ship and all newly acquired vessels.
  This vector setting applies to own vessel and all targets (AIS and ARPA).

  - Click the spin boxes to change the length of the vector in minutes.
  - Tick 1 and / or 6 to display Interval Marks on the vector in minutes.
• Click **Stabilisation** to display a double arrowhead at the end of the vector if it is ground stabilised or a single arrowhead if sea stabilised. The display of these arrowheads is conditional on the NMEA data being received so if you set the stabilisation to sea and appropriate data is not available, the vector is turned off.

• **Heading Marker** to draw a heading line (requires compass or gyro heading) from the conning position. Enter a value up to a maximum of 999 mm to set the *length* of the line. This setting is overridden if a ship centred VRM is active in which case the heading line is drawn to the edge of the VRM (in accordance with *IEC 62288, Presentation of navigation-related information on shipborne navigational displays*).

• **Beam bearing line** to draw a line, at right angles to heading, through the conning position in millimetres.

• **Speed to make good** to display the speed to make good to meet the planned time of arrival at the next waypoint in a box alongside the vessel symbol. Speed to make good is calculated using the times set in the [ETD](#) tab in the monitor side panel and the planned speeds for each leg as set for the route.

**Track**

![Track Options](image)

Choose **Options** from the **Vessel** menu and select the **Track** tab. Select **Primary** or **Secondary** from the drop down list, depending on the type of track you wish to change. The following options are available to either type of track.

• **Past Track** tick or clear to turn on or off the display of the track.

• **Position markers** tick or clear to turn on or off the display of position markers at the interval set under Navigator \ Options \ Position Logging.
- **Fix time and source** tick or clear to turn on or off the display of fix time and source against each position marker.

- **Time marks** tick or clear to turn on or off the display of time marks at the interval specified.

- **Limit to previous** tick or clear to limit the display of track to the time specified, e.g. the past 4 hours.

- **Automatic drawing filter** tick to apply a filter that removes overlapping track points to reduce screen clutter. If not ticked all track points are drawn regardless of whether they can be individually seen, which can increase the drawing time.

- **Optimise track drawing** tick to minimise the number of position points used to draw the track by removing those that would otherwise be on a straight line. Having this option on greatly reduces track drawing time, especially for long voyage records. We recommend that you uncheck it only if you need to see every position marker, such as during an investigation.

**Warnings**

In accordance with IMO Resolution MSC.232(82) - Performance Standards for ECDIS:

- An alarm is given if the vessel, within a specified time set by the mariner, is going to cross a safety contour (ENC, CM-ENC or CM93/3 charts).

- An alarm or indication, as selected by the mariner, is given if the vessel within a specified time set by the mariner is going to cross the boundary of a prohibited area or of a geographic area for which special conditions exist (ENC or CM93/3 charts).

- An option is provided to activate an alarm when the ship crosses a point or line or is within the boundary of a mariner-entered feature (Mariner Overlay) within a specified time or distance (ARCS, Seafarer, ENC or CM93/3 charts).
Use the spin buttons to set the **Distance** and **Time** parameters used to trigger alarms (applies to types of position monitoring alarms).

Select **Alarm** or **Indication** (default is alarm) for prohibited areas or geographic areas for which special conditions exist.

Tick **Mariner Overlay Alarms** to generate alarms when approaching or crossing **Mariner Overlays** (see page 256) and **Critical Points** and select either **Distance** or **Time** depending on your preference.

**GUARD ZONE**

The trigger points for alarms and warnings are defined by a guard zone projected from the stern of the vessel, that is $x$ times the beam of the vessel at its limit. Choose **Guard Zone Size** and click the spin buttons to set the size between 1 and 100 times beam (default 5).

Two Guard Zones are used: one for Safety Contour, Prohibited Area, and Special Condition areas which is always time based, and one for Mariner Overlay (including **Critical Points**) generated alarms which may be time or distance based.
Guard Zones may be displayed by ticking the appropriate boxes.

**Vessel Setup**

See [Entering vessel data](#).
Configuration Setup

Log into Setup Mode and choose Setup from the Tools menu to set the following options.

**Workspace**

![Configuration Setup Screenshot]

**DECIMAL PLACES**

Click the spin buttons to increase or decrease the number of decimal places for position display and for data entry in the range 0 to 4. *Note: if you wish to enter positions to high precision, such as when entering Chartpoints or Manual Updates, you must select a high number of decimal places here.*

**SPEED UNITS**

The choices are knots (default) or metres per second.

**MEASUREMENTS**

The choices are feet or metres for small distances and nautical miles or kilometers for large distances.
**WORKSPACE SETTINGS**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reload documents when opening workspace</td>
<td>Check this box for Chartpoint, Route and Log databases to be loaded when you open a workspace.</td>
</tr>
<tr>
<td>Reload last workspace at startup</td>
<td>Check this box for the last used workspace to be loaded at startup.</td>
</tr>
<tr>
<td>Auto save workspace</td>
<td>Check this box for your workspace to be updated when you exit Navmaster. If left unchecked your workspace is only updated when you choose <strong>Workspace</strong> from the <strong>File</strong> menu and select <strong>Save</strong>, which allows you to keep control of your workspace.</td>
</tr>
<tr>
<td>Confirm exit</td>
<td>Check this box to get a confirm message when you exit Navmaster.</td>
</tr>
<tr>
<td>Display low memory warning, low disk space warning &amp; system slow warning</td>
<td>Tick if required.</td>
</tr>
</tbody>
</table>

**PORT SETTINGS**

This tab allows you to change COM port settings if you need to.

Under some circumstances, you may need to **Use Windows settings** in which case tick this box, choose **Workspace** from the **File** menu, select **Save**, and reboot your computer.
System

AUDIO

Click Wave Test to test that speaker and sound levels are working.

Use the slide bars to adjust the volume for Master (alarm sounds) and wave (voice sounds – not applicable in ECDIS). The brackets indicate the minimum level to which volume can be set.

SCREEN SIZE

Set the exact size of your computer screen here for symbols to be drawn accurately and for chart related calculations to be carried out accurately (such as Look Ahead). See Setting Screen Size for more information.

PALETTE

This control allows the light intensity of text in dusk and night palettes to be increased or reduced. Light intensity has been tested in dark room conditions and default values (slider set to 0) applied.

1. In the Palette section, select Dusk or Night, depending on which palette you wish to adjust.

2. Set the display to Dusk or Night palette (you can change palettes with this dialog open).

3. Move the slider to the right to increase and to the left to reduce and click Apply to see the effect of the change. Click OK when you are satisfied with the result.

MESSAGES

Tick this box to open the message window whenever a new message is generated.
Monitor

This tab only appears when a calibrated ECDIS monitor is attached. See ECDIS Monitor Calibration on page 18 for more information.
When using Navmaster at sea it can be difficult to work with a mouse or track ball. This appendix lists Navmaster keyboard shortcuts.

## Shortcut Keys

### File Operations

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the New dialog</td>
<td>&lt;CTRL&gt; + &lt;N&gt;</td>
</tr>
<tr>
<td>Open the Open dialog</td>
<td>&lt;CTRL&gt; + &lt;O&gt;</td>
</tr>
<tr>
<td>Open the Print dialog</td>
<td>&lt;CTRL&gt; + &lt;P&gt;</td>
</tr>
<tr>
<td>Open the Save as dialog</td>
<td>&lt;CTRL&gt; + &lt;S&gt;</td>
</tr>
</tbody>
</table>

### View operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look ahead On/Off</td>
<td>F3</td>
</tr>
<tr>
<td>Look ahead Up</td>
<td>F4</td>
</tr>
<tr>
<td>Look ahead Down</td>
<td>F5</td>
</tr>
<tr>
<td>Centre Vessel</td>
<td>F6</td>
</tr>
<tr>
<td>Toggle between Relative Motion and Directional Relative Motion in Position Monitoring window</td>
<td>F7</td>
</tr>
<tr>
<td>Toggle between True and Relative motion display in Position Monitoring window</td>
<td>F8</td>
</tr>
<tr>
<td>Select Position Monitoring mode and display Position Monitoring window</td>
<td>F9</td>
</tr>
<tr>
<td>Toggle between North up, COG up and Heading up display (vector charts only)</td>
<td>F10</td>
</tr>
<tr>
<td>Not used</td>
<td>F11</td>
</tr>
</tbody>
</table>
Switch between Side Panels (Chart Information, Position Monitoring, Chartpoint, Route, Route Management, Target Tracking) | F12
---|---
Toggle between chart and side panel | <SHFT> +F6
View files in use | <CTRL> + <ALT> + <SHFT> + V

**Chart operations**

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day palette</td>
<td>&lt;CTRL&gt; + &lt;B&gt;</td>
</tr>
<tr>
<td>Dusk palette</td>
<td>&lt;CTRL&gt; + &lt;D&gt;</td>
</tr>
<tr>
<td>Night palette</td>
<td>&lt;CTRL&gt; + &lt;M&gt;</td>
</tr>
<tr>
<td>Display world chart</td>
<td>&lt;CTRL&gt; + &lt;6&gt;</td>
</tr>
<tr>
<td>Zoom in</td>
<td>PgDn or &lt;+&gt;</td>
</tr>
<tr>
<td>Zoom out</td>
<td>PgUp or &lt;-&gt;</td>
</tr>
<tr>
<td>Pan up or down large steps</td>
<td>&lt;CTRL&gt; + &lt;SHIFT&gt; + UP or DOWN Arrow Key.</td>
</tr>
<tr>
<td>Pan left &amp; right, large steps</td>
<td>&lt;CTRL&gt; + &lt;SHIFT&gt; + Left or Right Arrow keys.</td>
</tr>
<tr>
<td>Pan left, right, up &amp; down, small steps</td>
<td>&lt;SHIFT&gt; + Arrow keys</td>
</tr>
<tr>
<td>Turn ARCS chart update tile outlines on/off</td>
<td>&lt;CTRL&gt; + &lt;ALT&gt; + &lt;U&gt;</td>
</tr>
</tbody>
</table>

**Navigator operations**

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to vessel position</td>
<td>&lt;CTRL&gt; + &lt;ALT&gt; + &lt;G&gt;</td>
</tr>
<tr>
<td>Start new log</td>
<td>&lt;CTRL&gt; + &lt;SHFT&gt; + &lt;L&gt;</td>
</tr>
<tr>
<td>Display logbook</td>
<td>&lt;CTRL&gt; + &lt;L&gt;</td>
</tr>
</tbody>
</table>

**Chartpoint operations**

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Chartpoint</td>
<td>&lt;CTRL&gt; + &lt;G&gt;</td>
</tr>
<tr>
<td>Display Chartpoint list on toolbar</td>
<td>&lt;CTRL&gt; + &lt;ALT&gt; + &lt;C&gt;</td>
</tr>
</tbody>
</table>
### Route operations

| Display route list on toolbar | <CTRL> + <ALT> + <R> |
| Display route waypoint list on toolbar | <CTRL> + <ALT> + <W> |

### Tools

| Man Overboard | <F2> |
| Display Tidal Atlas | <CTRL> + <ALT> + <T> |
| Refresh | <CTRL> + <R> |

### Help

| Load User Guide in Adobe Acrobat | F1 |

### Standard Windows Shortcuts

| Carry out the corresponding command on the menu | <ALT> + underlined letter in menu |
| Close the current window | <CTRL> + F4 |
| Switch to the next window | <CTRL> + F6 |
| Delete | <Del> |

### Shortcut keys in dialog boxes

| Cancel the current task | <Esc> |
| Click a button if the current control is a button | <Spacebar> |
| Click the selected button | <ENTER> |
| Move backward through options | <SHFT> + <TAB> |
| Move backward through tabs | <CTRL> + <SHFT> + <TAB> |
| Move forward through options | <TAB> |
| Move forward through tabs | <CTRL> + <TAB> |
ARCS and Seafarer charts, like the equivalent paper charts, are based on a variety of chart datums. Within the catalogue are charts of undetermined datum, fathoms and feet charts and more recent metric charts.

Navmaster includes chart datum management that automatically applies the official horizontal datum shift provided by an ARCS or Seafarer chart if available. If there is a mismatch between chart and GPS datums the navigator is warned. Where possible, the datum shift is applied to GPS positions and all stored routes and waypoints, so that routes, which may have been planned on one chart datum, are correctly transferred onto charts of different datums.

**Background to Geodetic Datums**

Over the centuries mapmakers have devised local models of the earth’s shape. Because the earth is not a regular shape the accuracy of each datum will vary as you get further from the origin for which it was defined. Hundreds of different datums exist to define positions; examples are OSGB36, European 1950, Indian, etc.
Satellite systems require a global datum and GPS positions use the World Geodetic System 1984 (WGS84), which is a model of the entire earth.

Problems arise when you are receiving positions based on one datum and plotting them on a chart based on a different datum.

For example, if you plot a position on an OSGB36 chart and then move to a European 1950 chart covering the same position without accounting for the shift you will introduce an error. The difference between WGS84 and the local datum can be quite significant as shown below.

This is not a new issue. It has affected paper charts for as long as satellite navigation has been in use. The solution in the paper world is to maintain positions in WGS84 and apply the shift every time you change chart.

**GPS Errors and Datum Considerations**

GPS positions are made less accurate by being plotted on charts of different datum.

Most GPS's have built-in datum transformations so that you can set the GPS to output positions in a local datum. But there are problems with this:

1. There is no standard applied to transformation formulae; two different GPS's may use different formulae and output different results. They provide a solution that is averaged over a wide area. Any error in the transformation can range from say 25m to much more at the fringes of
the area covered by the datum. The resultant errors can be large compared to the accuracy of DGPS.

2. It is hard to ensure that the GPS is switched to the correct datum each time a chart is changed.

3. GPS positions may be simultaneously fed to other instruments, eg ARPA, autopilot, expecting to receive the data in WGS84 co-ordinates.

4. Some GPS manufacturers apply the datum transformation to all waypoint positions held in memory when a datum other than WGS84 is selected for the display of positions. The point here is that you must be aware of the actions taken by your equipment.

**Datum Management**

The recommended strategy is to maintain the output of GPS in WGS84. In the case of Admiralty paper charts, a shift from WGS84 to the local datum is printed on the chart. If the Admiralty has published a figure it means that they have reconciled the original survey to WGS84 and that the shifts can be used with confidence. There are a number of Admiralty charts where it has not been possible to reconcile the original survey data against WGS84. In this case no shift values are published. Under these circumstances you are at least aware that plotted positions are to be treated with caution.

One of the benefits of software is that the management of datum shifts can be automated. ARCS has shift data built in and with this Navmaster can keep track of the datums of positions of all types, including vessel position and track, waypoints and any other overlaid point on the chart, and adjust them to the local geodetic datum as required.

For this to work it is important that the GPS is always set to output WGS84 positions. Ideally the GPS should identify the datum it is set to within the NMEA sentence output to the chart plotter. Unfortunately few GPS manufacturers output this vital information although there are calls for the mandatory inclusion of a geodetic datum code with every position location message. Equipment receiving such a message can then automatically check that datums are correctly matched.
Summary

Situations where navigation is affected by datum mismatches (equally applicable to paper and electronic charts).

1. Plotting of positions from GPS or other EPFS on non-WGS84 charts.

2. Moving overlaid information between charts of different datum (e.g., waypoints or routes).

3. Taking waypoint or other positions off non-WGS84 charts and transmitting them to GPS.

4. Calculation of waypoints from, for example, great circle algorithms.

Of course this emphasises the need for the standard navigation practice of not relying on positional information from just one source. Every opportunity should be taken to crosscheck against all other available sources, visual, radar, etc.
Alarms

An audible alarm is accompanied by a window that will describe the cause of the alarm. Click **Acknowledge** to stop the alarm and record the message in **System Messages**.

The following alarms are provided:

<table>
<thead>
<tr>
<th>ECDIS Performance</th>
<th>Information</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESOLUTION A.817</td>
<td>Exceeding off track limits</td>
<td>Alarm and permanent indication “Vessel deviating from planned course”</td>
</tr>
<tr>
<td>(19) ref:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.4.6, 10.5.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCDS - H 10.4.6, H</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.5.5, H.17.6.3 f) .3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCDS H 10.4.7, H</td>
<td>Approach to mariner entered</td>
<td>Approaching Polygon Danger</td>
</tr>
<tr>
<td>10.5.15, H.17.6.2 a)</td>
<td>point, line or area within a</td>
<td>Area – Danger Area entered –</td>
</tr>
<tr>
<td>– 1), 2) &amp; 3)</td>
<td>specified time or distance</td>
<td>Exiting Danger Area</td>
</tr>
<tr>
<td>H.17.6.3 a)5 - 7</td>
<td></td>
<td>Approaching Clearing Line –</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clearing Line Crossed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Point – “Approaching Danger</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Area” – no alarm</td>
</tr>
<tr>
<td>10.5.3</td>
<td>Where vessel, within a time</td>
<td>Alarm “ENC Vessel will cross</td>
</tr>
<tr>
<td>10.5.4</td>
<td>specified by the operator, will</td>
<td>safety contour in HH:MM”</td>
</tr>
<tr>
<td>4.10.5.7, H 10.5.7</td>
<td>Positioning system failure</td>
<td>Alarm “Position System Failure”</td>
</tr>
</tbody>
</table>
| 10.5.8, H 10.5.8 H.17.6.3 f) .4 | Approach to and arrival at critical point | Alarm “Approaching Critical Point Lat / Long”
| | | Alarm “Critical Point reached Lat / Long”
| 10.5.9, H10.5.9 | Different geodetic datum (GPS not outputting DTM message confirming positions in WGS84) | Alarm and permanent indication “Primary Positioning System datum missing”
| H.17.5.6 e) | Different geodetic datum (GPS outputting DTM message confirming positions in WGS84 but RNC chart datum unknown) | Alarm “RNC [Chart No] datum unknown or no shift available”
| 13.2, H13.2 | Malfunction of ECDIS | PC Maritime Alarms
| Sensor input | Loss of speed input | Speed system failure
| | | + speed field on monitor side panel is blanked red
| Sensor input | Loss of heading input | Heading system failure
| | | + heading field on monitor side panel is blanked red
| Primary / Secondary alarm | Primary \ Secondary difference exceeded (if active) | Position update not received for over 60 seconds, and has switched to DR mode. This message also appears after manually switching to DR.
| | | Position lost, DR activated
| | | + permanent indication “DR” at top right hand corner of position monitoring chart window

**Indications**

Warnings are provided in message windows to indicate the state of various aspects of the system (these windows cannot be closed while the state applies). In some cases the warning is overlaid on the chart.

**Warnings provided in permanent windows**

1. A window is allocated to messages relating to the overall system (eg RCDS Mode or Safety Contour setting). Some messages can be cleared by right clicking on them and selecting **Clear Message** (such as this one).

2. A window is allocated to a visible chart window to display warnings that must be permanently displayed.
The following lists the warnings that are provided:

<table>
<thead>
<tr>
<th>ECDIS Performance Standard RESOLUTION A.817 (19) ref:</th>
<th>Information</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>H 3.11</td>
<td>ECDIS operating in RCDS mode</td>
<td>RCDS Mode</td>
</tr>
<tr>
<td>4.5.1, H 3.4</td>
<td>Larger scale ENC \ RNC available for the displayed area.</td>
<td>Larger scale ENC \ RNC available</td>
</tr>
<tr>
<td>4.5.2, H5.2, H17.5.2 c)</td>
<td>Vessel position is covered by an ENC \ RNC at a larger scale than that provided by the display</td>
<td>Larger scale ENC / RNC available for vessel position</td>
</tr>
<tr>
<td>6.2, H6.2, H.17.2.2 c)</td>
<td>Different reference system – a number of messages provide information if a common reference system is not in use</td>
<td>Primary Position system datum missing – the GPS is not outputting the DTM sentence. EPFS datum not WGS84 - if Navmaster cannot determine that the GPS is set to WGS84 or if the operator confirms that the GPS is not set to WGS84. No datum shift available – when an RNC has no datum shift available One or more Chartpoints \ Waypoints cannot be referenced to this chart - either where: a) the Chartpoint, Route waypoint or other object was created on a chart of undetermined datum and therefore no shift data can be applied to it when it is displayed on a chart with a known datum and supplied shift to WGS84 or b) the Chartpoint, Route waypoint or other object is displayed on a chart of undetermined datum</td>
</tr>
<tr>
<td>g) .2 H.17.6.3 f) .2</td>
<td>Display regeneration time is expected to take more than 5s.</td>
<td>Redraw will take &gt; 5s</td>
</tr>
<tr>
<td>10.5.7</td>
<td>Positioning system failure</td>
<td>Position system failure</td>
</tr>
<tr>
<td>13.1, H13.1</td>
<td>System test failure – automatic or manual on board</td>
<td></td>
</tr>
<tr>
<td>Tests</td>
<td>Headings not received</td>
<td>Heading not received Cannot draw vessel outline</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>H.17.2.2 a)</td>
<td>Indication of geodetic datum of cursor position</td>
<td>Datum shown at the end of cursor position display</td>
</tr>
<tr>
<td>6.8.12 f), H.17.5.6 f)</td>
<td>Position offset applied</td>
<td>Vessel position offset by x.xm, x.xº</td>
</tr>
<tr>
<td>RCDS H.17.6.2 a) – 1), 2) &amp; 3)</td>
<td>Approach to mariner entered point, line or area within a specified time or distance</td>
<td>The monitored / alternate route has crossed x mariner entered [points \ lines \ areas]</td>
</tr>
<tr>
<td>H.17.6.3 a)8)</td>
<td>RNC displayed in area where ENC data is available.</td>
<td>ENC data available</td>
</tr>
<tr>
<td>H.17.6.3 f) 8)</td>
<td></td>
<td>Safety contour value</td>
</tr>
<tr>
<td>Annex A, Display Base</td>
<td>Own ship’s safety contour and visible safety contour</td>
<td>Visible safety contour value (not applicable if safety contour not visible in the part of the SENC currently displayed)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Safety Contour" /></td>
</tr>
<tr>
<td>Vessel position not in view</td>
<td>Vessel position not visible</td>
<td></td>
</tr>
<tr>
<td>HCRF</td>
<td>HCRF (ARCS &amp; Seafarer) messages relating to the correctness of an RNC or licence</td>
<td></td>
</tr>
<tr>
<td>PC Maritime Warnings</td>
<td>ECDIS in DR mode of operation</td>
<td>DR displayed at top right hand corner of Position Monitoring window</td>
</tr>
<tr>
<td></td>
<td>Workspace \ screen dimensions not saved (Tools \ Options \ System)</td>
<td>Warning, workspace unsaved (screen size may not be set)</td>
</tr>
<tr>
<td></td>
<td>For evaluation and time limited systems (right click on message and select Clear Message to remove)</td>
<td>Dongle expires in x days</td>
</tr>
<tr>
<td></td>
<td>When system is replaying recorded data</td>
<td>S displayed at top right hand corner of Position Monitoring window</td>
</tr>
</tbody>
</table>
Route

When route change cannot be transmitted automatically to second ECDIS

ROUTE MODIFIED – PLEASE TRANSFER TO MAIN DATABASE

Warnings provided on the chart

| 5.1 H17.5.2 a) & b) | Information overscale / underscale
When an ENC is displayed at a larger scale than its compilation scale or when an ARCS chart is not displayed in high resolution. | OVERSCALE \ UNDERSCALE : X <overscale factor>
at the bottom left of the chart. |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>IHO SP 52 App 2 Edt 4.2 2.3.1c (ii) &amp; (iii)</td>
<td>No official data available. refer to official RNC or paper chart</td>
<td></td>
</tr>
<tr>
<td>IHO SP 52 App 2 Edt 4.2 2.3.1c (ii) &amp; (iv)</td>
<td>Unofficial data present. Refer to official RNC or paper chart</td>
<td></td>
</tr>
</tbody>
</table>

System Messages

On start-up, automatic checks are made to confirm the status of the system. The checks include: disk and memory availability, time zone, operating system, component drivers, availability of com ports etc.

A check is also made that each module in Navmaster has initialised correctly.

The tests can be run whilst Navmaster is operational from Help \ Diagnostics.

Test results are recorded in files located in C:\Program Files \ Navmaster \ System. One file is maintained for each group with the suffix evt (eg system.evt).

System message history is grouped between the items listed in the left hand panel below.
In addition to system checks, the following alarms are recorded.

<table>
<thead>
<tr>
<th>ECDIS Performance Standard RESOLUTION A.817 (19) ref:</th>
<th>Information</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart section</td>
<td>ENC charts not updated for X days</td>
<td>Your ENC charts may be out of date. The last update was DD MMM YYYY</td>
</tr>
<tr>
<td>4.10.4.4</td>
<td>Route planning across safety contour</td>
<td>The monitored / alternate route &lt;name&gt; has crossed &lt;x&gt; safety contour(s) See <a href="#">Route Warnings</a> for more information</td>
</tr>
<tr>
<td>4.10.4.5</td>
<td>Route planning across prohibited areas or areas for which special conditions exist</td>
<td>The monitored / alternate route &lt;name&gt; has encountered &lt;x&gt; warnings crossing specified areas See <a href="#">Route Warnings</a> for more information</td>
</tr>
</tbody>
</table>

### Navigation

<table>
<thead>
<tr>
<th>H.17.5.6 d)</th>
<th>Repeat of error condition generated by positioning device</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.5.7</td>
<td>Alarms or indications passed from a position-fixing system</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss of NMEA sentence</td>
<td>Primary \ Secondary Positioning system. NMEA Sentence [sentence name] not receiving fresh data</td>
</tr>
<tr>
<td>Invalid sentence</td>
<td>[NMEA sentence] Quality indicator, changed to invalid</td>
</tr>
</tbody>
</table>

### IHO S-63 Data Protection Scheme Error Messages

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error/Warning Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSE 01</td>
<td>“Self Signed Key is invalid”</td>
</tr>
<tr>
<td>SSE 02</td>
<td>“Format of Self Signed Key file is incorrect”</td>
</tr>
<tr>
<td>SSE 03</td>
<td>“SA Signed Data Server Certificate is invalid”</td>
</tr>
<tr>
<td>SSE 04</td>
<td>“Format of SA Signed DS Certificate is incorrect”</td>
</tr>
<tr>
<td>SSE 05</td>
<td>“SA Digital Certificate (X509) file is not available. A valid certificate can be obtained from the IHO website or your data supplier”</td>
</tr>
<tr>
<td>SSE 06</td>
<td>“The SA Signed Data Server Certificate is invalid. The SA may have issued a new public key or the ENC may originate from another service. A new SA public key can be obtained from the IHO website or from your data supplier”</td>
</tr>
<tr>
<td>SSE 07</td>
<td>“SA signed DS Certificate file is not available. A valid certificate can be obtained from the IHO website or your data supplier”</td>
</tr>
<tr>
<td>SSE 08</td>
<td>SA Digital Certificate (X509) file incorrect format. A valid certificate can be obtained from the IHO website or your data supplier</td>
</tr>
<tr>
<td>SSE 09</td>
<td>ENC Signature is invalid</td>
</tr>
<tr>
<td>SSE 10</td>
<td>Permits not available for this Data Server. Contact your data supplier to obtain the correct permits.</td>
</tr>
<tr>
<td>SSE 11</td>
<td>Cell Permit file not found. Load the permit file provided by the data supplier.</td>
</tr>
<tr>
<td>SSE 12</td>
<td>Cell Permit format is incorrect. Contact your data supplier and obtain a new permit file.</td>
</tr>
<tr>
<td>SSE 13</td>
<td>Cell Permit is invalid (checksum is incorrect). Contact your data supplier and obtain a new permit file.</td>
</tr>
<tr>
<td>SSE 14</td>
<td>Incorrect system date, check that the computer clock (if accessible) is set correctly or contact your system supplier.</td>
</tr>
<tr>
<td>SSE 15</td>
<td>Subscription service has expired. Please contact your data supplier to renew the subscription licence</td>
</tr>
<tr>
<td>SSE 16</td>
<td>ENC CRC value is incorrect. Contact your data supplier as ENC(s) may be corrupted or missing data.</td>
</tr>
<tr>
<td>SSE 17</td>
<td>Userpermit is invalid (checksum is incorrect). Check that the correct hardware device (dongle) is connected or contact your system supplier to obtain a valid userpermit.</td>
</tr>
<tr>
<td>SSE 18</td>
<td>HW_ID is incorrect format</td>
</tr>
<tr>
<td>SSE 19</td>
<td>Permits are not valid for this system. Contact your data supplier to obtain the correct permits</td>
</tr>
<tr>
<td>SSE 20</td>
<td>Subscription service will expire in less than 30 days. Please contact your data supplier to renew the subscription licence</td>
</tr>
<tr>
<td>SSE 21</td>
<td>Decryption failed no valid cell permit found. Permits may be for another system or new permits may be required, please contact your supplier to obtain a new licence</td>
</tr>
<tr>
<td>SSE 22</td>
<td>SA Digital Certificate (X509) has expired. A new SA public key can be obtained from the IHO website or from your data supplier.</td>
</tr>
<tr>
<td>SSE 23</td>
<td>Non-sequential update, previous update(s) missing try reloading from the base media. If the problem persists contact your data supplier.</td>
</tr>
<tr>
<td>SSE 24</td>
<td>ENC Signature format incorrect, contact your data supplier</td>
</tr>
<tr>
<td>SSE 25</td>
<td>Viewer – “The permit for ENC&lt;cell name&gt; has expired. This cell may be out of date and MUST NOT be used for Primary NAVIGATION”.</td>
</tr>
<tr>
<td>SSE 26</td>
<td>This ENC is not authenticated by the IHO acting as the Scheme Administrator</td>
</tr>
<tr>
<td>SSE 27</td>
<td>Viewer – “ENC&lt;cell name&gt; is not up to date. A New Edition, Re-issue or Update for this cell is missing and therefore MUST NOT be used for Primary NAVIGATION”.</td>
</tr>
</tbody>
</table>

**HCRF (ARCS & Seafarer) Error and Warning Messages**

The following messages are recorded in the Chart group if they occur.

**HCRF 01** The contents of the GB.LCN file have been altered. You may be in breach of the licensing arrangements that relate to the use of the charts. Licence is invalid. Please contact your ARCS agent/distributor to correct this error

**HCRF 02** Chart#. Chart Permit corrupted. Please re-load from the original media.

**HCRF 03** Chart#. Update information relates to a newer version of the chart. Please load the chart CD that contains Chart# with an issue date of RCID.

**HCRF 04** Chart#. The chart data already incorporates this update information. Please load the latest update CD.
HCRF 05 Chart#. Licence expired - updating is not permitted. Please contact your agent to re-new licence.

HCRF 06 Chart#. Corrections have been loaded to NtoM UNM#. Licence is valid to NtoM PNM#. Corrections are missing. Please insert the update CD that contains corrections for NtoM PNM#.

HCRF 07 Chart#. Licence not valid for this update. Please contact your ARCS distributor if you wish to use this data.

HCRF 08 Warning - Licence expires in less than one month. Please contact your ARCS agent for a licence renewal.

HCRF 09 Chart#. Warning - Licence expired. The displayed chart may not be up to date. Contact your agent to arrange for a licence renewal.

HCRF 10 Chart#. Licence expired. ARCS charts can not be displayed. Contact your ARCS agent for a licence renewal.

HCRF 11 Chart#. The loaded version of this chart is too old to be used with the licence. Please load a more recent version of the chart. Chart version is ENC#, Permit version is Penc#.

HCRF 12 Chart#. The licence is too old to be used with this version of the chart. Please contact your agent to obtain a new licence.

HCRF 13 Chart#. The licence is not valid for this version of the chart. Either load the version with an issue number of Pseq# or contact your distributor to update your licence.

HCRF 14 Chart#. The loaded version of the chart is older than the one for which the licence is valid. Please load the more recent version with an issue number of Pseq#.

HCRF 15 Chart#. The licence is not valid for this version of the chart. Please contact your distributor to update your licence.

HCRF 16 Chart#. Warning - Licence does not allow access to latest correctional information. Licence is valid to NtoM correction PNM#. Updates are available for NtoM correction UNM#. Please contact your ARCS distributor to update licence.

HCRF 17 Chart#. Warning - Licence is valid to NtoM correction PNM#. Corrections are loaded to NtoM correction UNM#. Corrections
are missing. Please load update CD that contains NtoM correction PNM#.

HCRF 18 Chart#. Warning - Licence is valid to NtoM correction PNM#. The chart is correct to NtoM correction NM#. Corrections are missing. Please load update CD that contains NtoM correction PNM#.
Glossary of Terms and Systems

ARCS  | **Admiralty Raster Chart Service** - the UK HO proprietary RNC.

ECDIS | **Electronic Chart Display and Information System**
The performance standard for ECDIS approved by the IMO assembly in November 1995 and updated in 2006. The standards are defined in documents of the IHO and IEC: IHO Special Publication S-52 Provisional Specifications for Chart Content and Display of ECDIS; IHO Special Publication S-57 IHO Digital Data Transfer Standard IEC 61174 ECDIS Performance Standards.

ECS  | **Electronic Chart System** - a chart system that does not meet the requirements of SOLAS V/20 and is not defined by official standards.

ENC  | **Electronic Navigational Chart.** The database standardized as to content, structure and format according to relevant IHO standards and issued by, or on the authority of, a Government.

EPFS | **Electronic Position Fixing System** GPS, Loran etc

HCRF | **Hydrographic Chart Raster Format.** This is the format developed by UK HO and used by the UK HO for its Admiralty Raster Chart Service (ARCS) and the Australian HO for its Seafarer Chart Service.

IEC  | **International Electrotechnical Commission**

IHO  | **International Hydrographic Organisation**

IMO  | **International Maritime Organisation**
<table>
<thead>
<tr>
<th><strong>NMEA</strong></th>
<th><strong>National Marine Electronics Association</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>NMEA 0183 (latest version 3.01- January 2002) is the standard defined to permit the ready data communication between electronic marine instruments, navigation equipment and communications equipment when interconnected via an appropriate system.</td>
<td></td>
</tr>
</tbody>
</table>

| **RCDS** | **Raster Chart Display System (RCDS)** In December 1998 the IMO approved an amendment to the ECDIS performance standard which permits a RCDS mode of operation within ECDIS, provided certain conditions are met. |

| **RNC** | **Raster Navigational Chart** means a facsimile of a paper chart. Both the paper chart and the RNC are originated by, or distributed on the authority of, a government authorised hydrographic office. |

| **S-52** | IHO standard which defines the presentation of chart data on an ECDIS display |
| **S-57** | IHO standard which defines the chart data format (DX90) and encoding for ECDIS |

| **SOLAS** | The International Convention for the **Safety of Life at Sea**. Chapter V Safety of Navigation, Regulation 20, Nautical Publications requires that: “All ships shall carry adequate and up-to-date charts, sailing directions, lists of lights, notices to mariners, tide tables and all other nautical publications necessary for the intended voyage” |

<p>| <strong>Activated</strong> | A target representing the automatic or manual activation of a sleeping target for the display of additional graphically presented information. |
| <strong>AIS target</strong> | A target generated from an AIS message. |
| <strong>CCRP</strong> | The Consistent Common Reference Point is a location on own ship, to which all horizontal measurements such as target range, bearing, relative course, relative speed, closest point of approach (CPA) or time to closest point of approach (TCPA) are referenced, typically the conning position of the bridge. |
| <strong>Dangerous</strong> | A target with a predicted CPA and TCPA that violates values preset by the operator. The respective target is marked by a .dangerous target. |</p>
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>s target</td>
<td>Symbol</td>
</tr>
<tr>
<td>Display</td>
<td>The level of information which cannot be removed from the ECDIS display, consisting of information which is required at all times in all geographic areas and all circumstances. It is not intended to be sufficient for safe navigation.</td>
</tr>
<tr>
<td>base</td>
<td>For more information, please refer to the source.</td>
</tr>
<tr>
<td>Heading</td>
<td>Direction in which the bow of a ship is pointing expressed as an angular displacement from north.</td>
</tr>
<tr>
<td>Important</td>
<td>A marking of an operational status of displayed information which needs special attention, e.g. information with low integrity or invalid information.</td>
</tr>
<tr>
<td>indication</td>
<td>For more information, please refer to the source.</td>
</tr>
<tr>
<td>Lost</td>
<td>A target representing the last valid position of a target before its data was lost. The target is displayed by a .lost target. symbol.</td>
</tr>
<tr>
<td>target</td>
<td>For more information, please refer to the source.</td>
</tr>
<tr>
<td>Operation</td>
<td>Area of the display used to graphically present chart and radar information, excluding the user dialogue area. On the chart display this is the area of the chart presentation. On the radar display this is the area encompassing the radar image.</td>
</tr>
<tr>
<td>al display</td>
<td>For more information, please refer to the source.</td>
</tr>
<tr>
<td>area</td>
<td>For more information, please refer to the source.</td>
</tr>
<tr>
<td>Past</td>
<td>Equally time-spaced past position marks of a tracked or reported target and own ship. The co-ordinates used to display past positions may be either relative or true.</td>
</tr>
<tr>
<td>positions</td>
<td>For more information, please refer to the source.</td>
</tr>
<tr>
<td>Sleeping</td>
<td>A target indicating the presence and orientation of a vessel equipped with AIS in a certain location. The target is displayed by a .sleeping target. symbol. No additional information is presented until activated.</td>
</tr>
<tr>
<td>AIS</td>
<td>For more information, please refer to the source.</td>
</tr>
<tr>
<td>target</td>
<td>For more information, please refer to the source.</td>
</tr>
<tr>
<td>Selected</td>
<td>A target selected manually for the display of detailed alphanumeric information in a separate data display area. The target is displayed by a “selected target” symbol.</td>
</tr>
<tr>
<td>target</td>
<td>For more information, please refer to the source.</td>
</tr>
<tr>
<td>Standard</td>
<td>The level of information that should be shown when a chart is first displayed on ECDIS. The level of the information it provides for route planning or route monitoring may be modified by the mariner according to the mariner’s needs.</td>
</tr>
<tr>
<td>display</td>
<td>For more information, please refer to the source.</td>
</tr>
<tr>
<td>User</td>
<td>An area of the display consisting of data fields and/or menus that is allocated to the interactive presentation and entry or selection of operational parameters, data and commands mainly in alphanumeric form.</td>
</tr>
<tr>
<td>dialogue</td>
<td>For more information, please refer to the source.</td>
</tr>
<tr>
<td>area</td>
<td>For more information, please refer to the source.</td>
</tr>
</tbody>
</table>
An auxiliary presentation configured by the user for a specific task at hand. The presentation may include radar and/or chart information, in combination with other navigation or ship related data.

**Navigation System Types**

**(ECDIS) - Electronic Chart Display and Information System**

The International Maritime Organisation approved the performance standard for ECDIS in November 1995.

The chart data used in an ECDIS must conform to the Electronic Nautical Chart (ENC) specification. An ENC must be issued for use on the authority of a government authorised hydrographic office.

**(RCDS) - Raster Chart Display System**

Recognising the delays in implementing ECDIS, various hydrographic offices identified a need for alternative official chart data to connect the areas of ENC coverage expected over the next few years.

This led to the development of the Admiralty ARCS raster chart and NOAA’s BSB raster chart. Both formats come from the same production process used for paper charts and are in every respect identical to the paper versions.

In December 1998, the IMO approved an amendment to the ECDIS performance standard that recognises a raster chart display (RCDS) mode of operation within ECDIS provided certain conditions are met. This will include a backup folio of up-to-date paper charts.

This allows ECDIS to operate “Dual Fuel” with ARCS providing official chart coverage for areas not covered by ENCs.

**(ECS) - Electronic Chart Systems**

An ECS is a system that does not conform to the ECDIS performance standard. There are, as yet, no official performance standards applicable to this type of system. A system is an ECS if:

- It is using chart data (of any type) that is not issued under the authority of a government authorised hydrographic office.
- The system does not meet the ECDIS performance standard.
The following flow charts are provided to assist in troubleshooting.

**Interfacing with equipment**

1. No position received.
2. No heading received
3. No heading received – OSD sentence from ARPA available
4. No speed received
5. No speed received – OSD sentence from ARPA available

**Chart installation**

1. ENC chart installation.
2. CM-ENC chart installation
3. CM-93/3 chart installation
Pilots typically run Navmaster on a laptop interfaced to the AIS Pilot Plug via a Bluetooth, Wireless or USB to Serial interface.

Please refer to Navmaster Pilot Setup below for initial setup instructions.

**Interfacing to the AIS Pilot Plug**

1. When you are connected to the Pilot Port, select **Position Source** from the **Navigator** menu, click the **AIS** radio button and click **Apply**.

2. Click the **Activate AIS** button on the AIS toolbar, or choose **AIS** from the **Target** toolbar and click **Activate \ Deactivate**.

3. From here, follow the procedure set out in the **Position Plotting and Monitoring** chapter above.

If you have elected to download ship dimensions from AIS, it may be up to 6 minutes before the data comes through. You can see when the data has been received in the **Target** side panel, by selecting **Own Ship** at the top of the **Target list** and selecting the **Static** bar. Also choose **Setup** from the **Vessel** menu and check that the dimensions of the vessel and the AIS antenna position are correct. To ensure that ship’s scaled outline (requires ship’s heading from the AIS) and range & bearing measurements are accurate you should enter **conning position** offsets. See Setting a Consistent Common Reference Point (CCRP) on page 2 above for further information. Finally, zoom in on the vessel position on the chart to check that the display of the ship’s outline is correct.

**Navmaster Pilot Setup**

*To Set the AIS COM port*

1. Log into Setup Mode.
2. Determine the COM port number used by the instrument.  
*Note: Navmaster checks for COM ports on startup and when Bluetooth is turned on or off. Open System Messages and select System to see a list of available COM ports. If you are in doubt about which COM port is applicable try each one in turn by following this setup procedure in full.*

3. Choose Setup from the Target menu, select AIS and then the Configuration tab. Set the COM port used by the instrument in the Receive box and click OK.

5. Choose Setup from the Tools menu and select the COM port used to interface with the AIS Pilot Plug from the drop down list.

6. Change the baud rate to 38400.

7. Click OK.

8. Save your settings - see Workspace.

*To verify data input*

Once an instrument is connected, the COM port allocated, and the baud rate set, choose NMEA Window from the Navigator menu, select the COM port you wish to view, and click Receive.

Valid data received from AIS will be similar to this.
To Activate Automatic Download of Ship’s Dimensions from AIS

The VDO message transmitted from the ship’s AIS contains own ship’s dimensions. To activate automatic download of this information so that a scaled outline of the vessel can be displayed at appropriate scales:

1. Log into Setup Mode.
2. Choose Setup from the Target menu and select the AIS tab followed by the Configuration tab. Tick Update Own Vessel Parameters from VDO message and click OK to exit the dialog.
3. Save your settings - see Workspace.

Setting up a Secondary Position input

A useful option is to use a Bluetooth or handheld GPS as a secondary position input for backup. This means that if the connection to AIS fails, Navmaster’s position monitoring will automatically switch to the secondary GPS.

1. Log into Setup Mode.
2. Determine the COM port number used by the instrument.

Note: Navmaster checks for COM ports on startup and when Bluetooth is turned on or off. Open System Messages and select System to see
a list of available COM ports. If you are in doubt about which COM port is applicable try each one in turn by following this setup procedure in full.

3. Choose **Setup** from the **Navigator** menu, select the **Position** tab followed by the **Configuration** tab. Set the COM port used by the instrument in the **Receive** box and click **Apply**.

4. Choose the **General** tab and, if you want it active, tick the checkbox for a Primary \ Secondary position difference alarm and set the distance level.

5. Save your settings - see **Workspace**.

**To verify data input**

Once an instrument is connected, the COM port allocated, and the baud rate set, choose **NMEA Window** from the **Navigator** menu, select the COM port you wish to view, and click **Receive**. This will show any data that is being received by the port.